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For how to use this manual, see "Using the User Guide".
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Using the User Guide

Read this manual carefully before you use this product and keep it handy for future reference. For safe and correct use,
please be sure to read the Safety Information before using the machine.

This section describes the items that appear in the User Guide.

Click to display the standard version of the User Guide.

Ve

Standard

Click to display the screen-reader version of the User Guide.

IR

For screen reader

Click to display the [Settings] page. On this page, you can select the display color and whether or not to
hide illustrations for procedures.

| 8 Settings |

Enter a word you want to search for.

| Search

If you point to a character string, it turns blue and is underlined. Click the string to jump to the linked
page.

(] TTammg and Eemowing the TTzer Ghnde 53
[ Printing 5
(% Printer Driver =
Click to display the contents.
| ﬁ Contents |
Click to display the previous topic.
| 4 Presvious -
Click to display the next topic.
- Hext |
Click to return to the top of the displayed page.

[+] Top |

If a description contains a hyperlink, the hyperlink appears at the bottom of each page.
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Using the User Guide

This User Guide describes procedures using Windows 2000 as an example. Procedures under other operating systems
may differ. Screens vary according to the operating environment.

pf Important |

o Contents of this manual are subject to change without prior notice. In no event will the company be liable for direct, indirect, special,

incidental, or consequential damages as a result of handling or operating the machine.

o Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

o Some illustrations in this manual might be slightly different from the machine.

o Certain options might not be available in some countries. For details, please contact your local dealer.

E' Top | 4 Previous - Next fi |
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Removing the User Guide

Follow the procedure below to remove the User Guide installed on your computer.

Removing the User Guide using its [Uninstall] function

[1] Click [Start], and then point to [Programs].
E] Point to the installed [Product name], and then click [Uninstall].
E] Follow the instructions that appear to remove the User Guide.

Removing the User Guide using [Add/Remove Programs]

[1] Open [My Computer], and then open [Control Panel].
[2] Double-click [Add/Remove Programs].
E] Select the installed [Product name User Guide], and then click [Change/Remove].

E] Follow the instructions that appear to remove the User Guide.

o As well as removing the entire User Guide, you can also remove selected manuals from the guide.

|| Top | 4 Previous - Next f |
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Printing on Various Paper Types

The print method differs depending on the type of paper used for printing. Use a print method appropriate for each
paper type.

Related topics

Printing on Plain Paper 73

Printing on Thick Paper 7

Printing on Inkjet Plain Paper 74

Printing on Inkjet Transparency =3

Printing on Semi-gloss Photo Paper 7d

Printing on Envelopes a1

|| Top | 4 Previous - Next f |
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Printing on Plain Paper

Follow the procedure below to print on plain paper. Plain paper are fed from tray 1 or tray 2 (optional).
E] Load plain paper into tray 1 or tray 2 (optional).
E] Open the printer properties dialog box from the application.
E] On the [Setup] tab, click [Plain] in the [Paper type:] list.

[4] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[5] Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application 74

e Paper Handling Precautions 5 |

o Loading Paper ad

|| Top | 4 Previous - Next o |
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Printing on Thick Paper

Follow the procedure below to print on thick paper and label paper. Thick paper and label paper are fed from the
bypass tray.

o Paper heavier than 105 g/m2 (198.5 Ib.) is inserted into the bypass tray one sheet at a time. Paper lighter than that can be loaded into tray 1 or

tray 2 (optional).

o To use Paper lighter than 105 g/m? (198.5 Ib.), click [Plain] in the [Paper type:] list.

E] Open the printer properties dialog box from the application.
On the [Setup] tab, click [Thick] in the [Paper type:] list.

[3] Make the necessary settings, and then click [OK].

A confirmation message appears.
[4] Check the message, and then click [OK].

[E] Make print settings, and then click [OK].

o The [Resume] key lights.

[6] Slide the envelope selector to the rear position &,

AGKIIE

(7] Slide the bypass tray guides into position according to the paper size.
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Printing on Thick Paper

AGKI25S

Insert a sheet of paper into the bypass tray with the print side face up.

AGKORES
Printing starts when you push in the paper.
Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when cleaning
finishes.

y o |mportant

e When using the bypass tray, make sure sheet of paper is between the top and bottom of the bypass tray guides.

AGKDEAS
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Printing on Thick Paper

o Paper can only be inserted one sheet at a time.

o Support the sheet with your hands to keep it from sliding out and dropping.

o Insert the sheet straight into the bypass tray.

= B Feferen=s

e Opening from an Application i |

e Paper Handling Precautions g

|| Top | 4 Previous - Next o |
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Printing on Inkjet Plain Paper

Follow the procedure below to print on Inkjet Plain Paper. Inkjet Plain Paper are fed from tray 1 or tray 2 (optional).
[1] Load Inkjet Plain Paper into tray 1 or tray 2 (optional).
E] Open the printer properties dialog box from the application.

[3] On the [Setup] tab, click [Inkjet Plain Paper] in the [Paper type:] list.

o Only one-sided printing is possible when [Inkjet Plain Paper] is selected. For duplex printing, click [Plain].

(4] Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

[5] Make print settings, and then click [OK].

= Reference

e Opening from an Application |

o Paper Handling Precautions ad

o Loading Paper 3 |

|| Top | 4 Previous - Next ¢ |
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Printing on Inkjet Transparency

Follow the procedure below to print on inkjet transparency.

Load inkjet transparency in tray 1.

o Printed inkjet transparencies take some time to dry. We recommend that you remove a printed inkjet transparency from the output tray before

the next inkjet transparency is delivered.
o The print delivery time interval can be set longer to avoid printed inkjet transparency from sticking together due to print wetness.
o Load A4/Letter size inkjet transparencies here.

o Load A4/Letter size paper in I (portrait) orientation.

[1] Lift the output tray.

AGKDOSS

(2] Pull out tray 1.
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Printing on Inkjet Transparency

AGKD105

o Pull tray 1 completely out. Take care not to drop it.

E] Squeeze the paper guides on both sides, and then adjust them according to the paper size.

ACKINS

o Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

[4] Load inkjet transparency into tray 1 with the notched corner in the right front corner of the tray. Do
not load transparencies over the limit mark.

AGKD125
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Printing on Inkjet Transparency

o Curled inkjet transparency may jam. Straighten any curls before loading.
o If other paper is loaded, remove it, and then load inkjet transparency.

o To prevent the leading edge of transparencies from being scratched, place transparencies one at a time.

[5] Squeeze the front end paper guide, and then slide it to meet the edge of the inkjet transparency.

AGKDES

[6] Push tray 1 gently in until it stops.

AGKDES

[7] Lower the output tray.
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Printing on Inkjet Transparency

AGKDEIS

E] Open the printer properties dialog box from the application.
On the [Setup] tab, click [Inkjet Transparency] in the [Paper type:] list.

[11] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[12] Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application ad

o For details about [Sheet-dry Print Delay...], see the printer driver Help.

e Paper Handling Precautions |
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Printing on Semi-gloss Photo Paper
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Printing > Printing on Various Paper Types > Printing on Semi-gloss Photo Paper

Printing on Semi-gloss Photo Paper

Follow the procedure below to print on semi-gloss photo paper. Load semi-gloss photo paper in tray 1.

o Ad4/Letter size paper is loaded here.

o Load A4/Letter size paper in D (portrait) orientation.

(1] Lift the output tray.

AGKD105

o Pull tray 1 completely out. Take care not to drop it.

[3] Squeeze the paper guides on both sides, and then adjust them according to the paper size.
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Printing on Semi-gloss Photo Paper

AGKING

o Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

E] Load semi-gloss photo paper with the print side face down but not over the limit mark.

AGKD125

o The print side is rough and white-coated.

o Curled paper may jam. Straighten any curls before loading.

[E] Squeeze the front end paper guide, and then slide it to meet the edge of the paper.
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Printing on Semi-gloss Photo Paper

AGKD13S

AGKD145

AGKD155

Slide the envelope selector to the forward position D
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Printing on Semi-gloss Photo Paper

E] Open the printer properties dialog box from the application.
On the [Setup] tab, click [Semi-gloss Photo Paper] in the [Paper type:] list.

[11] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

@ Make print settings, and then click [OK].

o The output tray can hold up to 20 sheets of semi-gloss photo paper at a time.

= B Feferen=s

e Opening from an Application 74

e Paper Handling Precautions g
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Printing > Printing on Various Paper Types > Printing on Envelopes

Printing on Envelopes

Follow the procedure below to print on envelopes. The envelopes are fed from tray 1.

(1] Lift the output tray.

AGKD10S

o Pull tray 1 completely out. Take care not to drop it.

[3] When printing on an envelope that has the flap on the long edge, fold the flap, and then load the
envelope with the flap to the right of the paper feed direction, print side down.
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Printing on Envelopes

ARCO0NS

o When printing on an envelope that has the flap on the short edge, leave the flap unfolded, and then load the envelope bottom-first, print

side down.

AGKD2IS

e You can load up to 30 envelopes.
o Before loading envelopes, make sure their edges are sharply creased by rubbing the edges with a pen or similar object.

o Load envelopes carefully because the printable area depends on the orientation.

[4] Squeeze the paper guide release, and then slide the paper guides into position according to the paper
size.
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Printing on Envelopes

AMCDORS
[5] Push tray 1 gently in until it stops.
(6] Lower the output tray.

[7] Slide the envelope selector to the rear position .

AGKDE1S
Open the printer properties dialog box from the application.
[9] On the [Setup] tab, click [Envelope] in the [Paper type:] list.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[11] Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application i |

e Paper Handling Precautions g

e Printable Area 7

hod I mportart |

o To print in reverse orientation in the printer driver settings, select the [Rotate by 180 degrees] check box on the [Page Settings] tab.
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Printing > Canceling Printing

Canceling Printing

Print jobs can be canceled from either a printer or computer. How to cancel print jobs differs according to their job
status. Check the job status first.

Canceling a print job being printed
Cancel the print job from the Printer Status monitor or by pressing the [Cancel] key of the printer.
Canceling a print job in queue

Cancel the print job from the taskbar of the computer.

Related topics

Canceling Printing from the Printer Status Monitor a1

Canceling Printing Using the [Cancel] Key of the Printer ad

Canceling Printing from the Taskbar 73
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Canceling Printing from the Printer Status Monitor
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Printing > Canceling Printing > Canceling Printing from the Printer Status Monitor

Canceling Printing from the Printer Status Monitor

Follow the procedure below to cancel a print job being printed.
[1] Check that printing and the Printer Status monitor have started.

[2] Click [Stop Printing].

=101 x|

File name:
Repaot. bap
Sending data: 2727 / TI23 KB

Progress: ﬁ

7% Stop Printing |
Dperational =]
Ready

E [zer Giade... I

[ ok | Hew |

o It will take a few moments for printing to stop.

=l Reference

o Displaying the Printer Status 7
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Canceling Printing Using the [Cancel] Key of the Printer
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Printing > Canceling Printing > Canceling Printing Using the [Cancel] Key of the Printer

Canceling Printing Using the [Cancel] Key of the Printer

Follow the procedure below to cancel a print job being printed.

[1] Check that printing has started.

o Not only the print job being printed but also the print jobs in queue will be canceled.

o If you press the [Cancel] key while the printer is receiving print data for a print job (the [Power] key is blinking), that print job is also

canceled.

Press the [Cancel] key.

o It will take a few moments for printing to stop.
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Canceling Printing from the Taskbar
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Printing > Canceling Printing > Canceling Printing from the Taskbar

Canceling Printing from the Taskbar

Follow the procedure below to cancel a print job in queue.
[1] Double-click the icon of the printer on the taskbar.

E] Select the print job you want to cancel, and then click Cancel (Windows 98/Me: Cancel Printing) on the
Document menu.

|| Top | 4 Previous « Next fp |
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Adjusting Print Quality
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Printing > Adjusting Print Quality

Adjusting Print Quality

Print quality and color tone can be adjusted to suit the print data.

Related topics

Printing Using Preset Print Quality Settings 7

Printing in Black and White 7l

Saving Color Ink When Printing a3

Printing with Print Quality Settings You Want 71

Emphasizing Bold Type According to the Font Size 7

Changing the Method of Extracting TrueType Fonts ad

Printing Images Vividly 73
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Printing Using Preset Print Quality Settings
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Printing > Adjusting Print Quality > Printing Using Preset Print Quality Settings

Printing Using Preset Print Quality Settings

With preset print quality settings, you do not have to make print quality settings every time you print. Follow the
procedure below to print using a preset print quality setting.

E] Open the file you want to print from the application, and then open the printer properties dialog box.
[2] On the [Setup] tab, select a print quality setting in the [Print Quality] area.

[3] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[E] Make print settings, and then click [OK].

= N Reference

e Opening from an Application =i |

o For details about [Print Quality], see the printer driver Help.
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Printing in Black and White
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Printing > Adjusting Print Quality > Printing in Black and White

Printing in Black and White

Follow the procedure below to print using only black.

Since black and white printing is faster than color printing, it is efficient for printing color documents that do not need
to be printed in color. Also, the black produced by black and white printing is a more distinct black than that produced
by color printing.

o Be sure to select black and white printing if you specified black and white printing in an application.

E] Open the file you want to print from the application, and then open the printer properties dialog box.
On the [Setup] tab, click [Black and White] in the [Color/Black and White] area.

[3] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
E] Make print settings, and then click [OK].

=l Reference

e Opening from an Application =
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Saving Color Ink When Printing
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Saving Color Ink When Printing

Follow the procedure below to save color ink by printing graphics and images with less than the usual amount of ink.
Text is printed as usual so that it can remain clear and easy to read.

E] Open the file you want to print from the application, and then open the printer properties dialog box.
[1] On the [Setup] tab, click [Color] in the [Color/Black and White] area.
[3] Select the [Level color] check box.

[4] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

[5] Make print settings, and then click [OK].

o Overall color, except for text, will be lighter.

o The color of text may be printed lighter depending on the application used.

= Reference

o Opening from an Application ad
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Printing with Print Quality Settings You Want
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want

Printing with Print Quality Settings You Want

For screen reader

| Search

You can make print quality settings more in details.

Related topics

Changing Image Printing Method 73

Correcting the Hue of Digital Photos 7

Printing Low Resolution Images Smoothly 73

Changing the Dither Pattern 73

Using Error Diffusion 7

Changing the Color Profiling Pattern a3

Printing Grayscale Images Using Black or CMYK 7

Printing Text in Black 73

Using ICM 73

Adjusting Brightness, Contrast, and Saturation 7

Adjusting Color Balance 23

Printing a Whole Page as an Image 73

Changing the Image Data Process a1

Printing with Particular CMYK Colors ad
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Changing Image Printing Method
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Changing Image Printing Method

When printing images, the higher the resolution of images, the longer the time required for printing. Follow the
procedure below to print with priority on print quality or print speed.

E] Open the file you want to print from the application, and then open the printer properties dialog box.
[2] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

(4] On the [Image Adjustments] tab, select an image printing method in the [Image processing priority]
list.

[5] Click [OK].
The [Change User Settings] dialog box closes.

(6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[7] Make print settings, and then click [OK].

= Reference

e Opening from an Application |

o For details about [Image processing priority], see the printer driver Help.
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Correcting the Hue of Digital Photos
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Correcting the Hue of Digital Photos

Correct the hue of digital photos. This is effective especially for overexposed or underexposed images.

o Exposure is affected by the levels of light in which the photo was taken. If there are extreme light and shade differences between object and

background, the object may be underexposed (too dark) or overexposed (too light).

E] Open the file you want to print from the application, and then open the printer properties dialog box.
E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

[4] On the [Image Adjustments] tab, select the [Adjust photos and images] check box.
!

o If the [Adjust photos and images] check box is selected, the [Use ICM] check box is unavailable.
[5] Click [OK].
The [Change User Settings] dialog box closes.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[7] Make print settings, and then click [OK].

= N Reference

o Opening from an Application ad
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Printing Low Resolution Images Smoothly

User Guide ' St andard

For screen reader

| # Contents | § Previous - Next - | I | | Settings | | 2]

Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing Low Resolution Images Smoothly

Printing Low Resolution Images Smoothly

Follow the procedure below to print outlines of low resolution images, which often appear on Web pages, smoothly.
E] Open the file you want to print from the application, and then open the printer properties dialog box.
E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

E] On the [Image Adjustments] tab, select the [Smooth low resolution images] check box.

[5] Click [OK].
The [Change User Settings] dialog box closes.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[E] Make print settings, and then click [OK].

= N Reference

e Opening from an Application b |
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Changing the Dither Pattern

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | | Settings | | 2]

Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Changing the Dither Pattern

Changing the Dither Pattern

A dither pattern is a pattern of dots used to simulate a color or shade of an image. If the pattern is changed, the
characteristics of the image will also change. Follow the procedure below to select a pattern suitable for the image to
be printed.

o Dithering is a technique where tiny dots are printed in patterns in order to create the illusion of tones and colors that cannot be physically

reproduced.

E] Open the file you want to print from the application, and then open the printer properties dialog box.
E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

E] On the [Image Adjustments] tab, select a dither pattern in the [Dithering] list.

o Thin lines may break depending on the pattern used. If this happens, select another pattern.
[5] Click [OK].
The [Change User Settings] dialog box closes.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[7] Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application 74

o For details about [Dithering], see the printer driver Help.
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Using Error Diffusion

Error Diffusion is a type of dithering that produces halftones by printing dots densely for dark colors and diffusely for
light colors. Select the appropriate pattern for the image you want print.

!
o Depending on the operating system or application, error diffusion may not be printed correctly.
[1] Open the file you want to print from the application, and then open the printer properties dialog box.

E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

E] On the [Image Adjustments] tab, select the [Use error diffusion] check box.
[5] Select the error diffusion target from the drop-down menu.

[6] Click [OK].
The [Change User Settings] dialog box closes.

E] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
Make print settings, and then click [OK].

= Reference

e Opening from an Application ad

o For details about [Dithering], see the printer driver Help.
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Changing the Color Profiling Pattern
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Changing the Color Profiling Pattern

Changing the Color Profiling Pattern

Follow the procedure below to select a color profiling pattern to adjust the tone of colors for prints according to the
colors displayed on the computer screen.

Colors on the computer screen are expressed using the three RGB colors, but colors used for printing are composed of
the four CMYK colors. When printing, RGB colors are converted to CMYK colors.
[1] Open the file you want to print from the application, and then open the printer properties dialog box.

E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

[4] On the [Image Adjustments] tab, select a color profiling pattern in the [Color profile:] list.

[5] Click [OK].
The [Change User Settings] dialog box closes.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[7] Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application 74

o For details about [Color profile:], see the printer driver Help.

o Color Guide 7
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Printing Grayscale Images Using Black or CMYK
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Printing Grayscale Images Using Black or CMYK

Follow the procedure below to print black or gray parts of an image using black or CMYK.
E] Open the file you want to print from the application, and then open the printer properties dialog box.
E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

E] On the [Image Adjustments] tab, select a gray reproduction method in the [Gray reproduction (Text/
Line Art):] list.

[5] Click [OK].
The [Change User Settings] dialog box closes.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
E] Make print settings, and then click [OK].

=l Reference

e Opening from an Application =

o For details about [Gray reproduction (Text/Line Art):], see the printer driver Help.
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Printing Text in Black
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Printing Text in Black

Follow the procedure below to print text other than black in black. This is useful when text other than black looks
lighter when printed.

E] Open the file you want to print from the application, and then open the printer properties dialog box.
[2] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

[E] On the [Image Adjustments] tab, select the [Print all texts in black] check box.

[5] Click [OK].
The [Change User Settings] dialog box closes.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
E] Make print settings, and then click [OK].

=l Reference

e Opening from an Application =

|| Top | 4 Previous « Next fp |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0026.htm2005/10/05 12:03:12


javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();

Using ICM

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | | Settings | | 2]

Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Using ICM

Using ICM

Follow the procedure below to correct colors using the Windows ICM (Image Color Matching) function.

o ICM is a color management system that adjusts colors between 1/O devices. Use this function to produce print results with colors as close as

possible to those displayed on the computer screen. To use this function, the color profile must be added to the printer.

e You can find the color profile in the ICM folder stored on the CD-ROM provided. For information about adding a color profile, search for

the words "color profile" in Windows Help, and then see the appropriate topic.

e This function is unavailable under Windows 95 or Windows NT 4.0.

[I] Open the file you want to print from the application, and then open the printer properties dialog box.
On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

[4] On the [Image Adjustments] tab, select the [Use ICM] check box.
!

o If the [Use ICM] check box is selected, the [Color profile:] list on the [Image Adjustments] tab is unavailable. Windows performs color

correction using the profile specified on the [Color Management] tab.

o If the [Use ICM] check box is selected, the [Adjust photos and images] check box is unavailable.

E] In the [ICM method:] and [ICM intent:] lists, select a color correction process.

[6] Click [OK].
The [Change User Settings] dialog box closes.

[7] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
Make print settings, and then click [OK].

= N Reference

e Opening from an Application b |

o For details about [ICM method:] and [ICM intent:], see the printer driver Help.
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Adjusting Brightness, Contrast, and Saturation

Follow the procedure below to adjust brightness, contrast, and saturation for printing.
E] Open the file you want to print from the application, and then open the printer properties dialog box.
E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

(4] Click the [Balance Adjustments] tab.

[5] Adjust the brightness, contrast, and saturation.

o Make adjustments by moving the slider or clicking [-] or [+].
() Click [OK].
The [Change User Settings] dialog box closes.

[7] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
Make print settings, and then click [OK].

= N Reference

e Opening from an Application ad

o For details about [Brightness:], [Contrast:], and [Saturation:], see the printer driver Help.
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Adjusting Color Balance

Follow the procedure below to adjust color balance by changing the mixture of red (R), green (G), and blue (B).
E] Open the file you want to print from the application, and then open the printer properties dialog box.
E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

(4] Click the [Balance Adjustments] tab.

[5] Adjust color balances.

e Make adjustments by moving the slider or clicking [-] or [+]. Click [+] and [®] to move all sliders at the same time.
e Cyan (C) and red (R), magenta (M) and green (G), and yellow (Y) and blue (B) are pairs of complementary colors.

6] Click [OK].
The [Change User Settings] dialog box closes.

[7] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Make print settings, and then click [OK].

Q Complementary Colors

It is helpful to understand the concept of complementary colors when adjusting color balance. When two
primary colors of the primary colors of light (RGB) or primary colors of pigment (CMY) are mixed, the
resulting color is the complimentary color of the remaining primary color. Red and cyan, green and magenta,
and blue and yellow are pairs of complementary colors.

Q Hints for Adjusting Color Balance

The following methods are available to make a specific color stronger: decreasing the color's complementary
color or decreasing the other colors (that is, decreasing complementary colors relatively). A combination of
both methods can be used.

For example, to make red more vivid, make red stronger (by decreasing cyan) or decrease green and blue
(making magenta and yellow stronger). The more red is used, the brighter the image looks. This is useful to
adjust the color of a dark image. On the contrary, the less green and blue are used, the duller the image looks.
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Adjusting Color Balance

Use this method to make a bright image dull.

= N Reference

e Opening from an Application =i |

o For details about [Color balance:], see the printer driver Help.

|| Top | 4 Previous - Next f |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0029.htm (2 of 2)2005/10/05 12:03:16



Printing a Whole Page as an Image

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | | Settings | | 2]

Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want > Printing a Whole Page as an Image

Printing a Whole Page as an Image

This section explains how to convert a print job to image data using a Windows application, and then print the image
using the printer driver. Follow the procedure below to print a whole page as an image. This will allow you to get print
results that resemble the display image more closely. Since more data has to be processed, printing will take much
longer. Use this function if the printed image differs from the display image.

o Black or gray parts will be printed with the four CMYK colors regardless of the settings made in the [Gray reproduction (Text/Line Art):] list

on the [Image Adjustments] tab in the [Change User Settings] dialog box.

o This setting overrides the watermark setting.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

[4] Click the [Misc.] tab.
[5] Select the [Print as bitmap] check box.

(8] Click [OK].
The [Change User Settings] dialog box closes.

[7] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
Make print settings, and then click [OK].

= N Reference

o Opening from an Application ad

e Printing Images or Text Superimposed on Prints #d
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# Printing on Thick Paper
# Printing on Inkjet Plain Paper
# Printing on Inkjet Transparency
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* Printing on Envelopes
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Changing the Image Data Process

Depending on the application, there may be cases where printing takes a long time or colors are not printed correctly.
Follow the procedure below to change the image data process to solve the problem.

o Since changing the image data processing method may cause printing not to be performed correctly with some applications, you should

normally leave this option unselected.
[I] Open the file you want to print from the application, and then open the printer properties dialog box.

On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

[4] Click the [Misc.] tab.
[5] Select the [Change data processing] check box.

[6] Click [OK].
The [Change User Settings] dialog box closes.

[7] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application i |
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Printing with Particular CMYK Colors

Normally full color (CMYK) is used for color printing. Follow the procedure below to print using particular CMYK
colors.

o These settings are unavailable when black and white printing is specified.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

[4] Click the [Misc.] tab.

E] In the [Separate into CMYK, then print in designated color only] area, select colors.

e Select colors you want to use.
[6] Click [OK].
The [Change User Settings] dialog box closes.

(7] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
Make print settings, and then click [OK].

=l Reference

o Opening from an Application =5
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Emphasizing Bold Type According to the Font Size

You can emphasize bold type according to the font size.
!
o This function is not available under Windows 95/98/Me.
[1] Open the file you want to print from the application, and then open the printer properties dialog box.

E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

[4] Click the [Misc.] tab.
[5] Select the [Increase bold with font size] check box.

(8] Click [OK].
The [Change User Settings] dialog box closes.

[7] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
Make print settings, and then click [OK].

= N Reference

e Opening from an Application ad
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Changing the Method of Extracting TrueType Fonts

This is useful for correcting garbled or incorrectly printed characters.

s o |mportarnt

o If you perform [Reduce/Enlarge] together with this function, printed text may be of reduced quality.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
E] On the [Setup] tab, click [User settings] in the [Print Quality] area.

[3] Click [Change...].
The [Change User Settings] dialog box appears.

[4] Click the [Misc.] tab.
E] Select the [Change methods to extract TrueType fonts] check box.

(8] Click [OK].
The [Change User Settings] dialog box closes.

[7] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
Make print settings, and then click [OK].

= N Reference

e Opening from an Application ad
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Printing Images Vividly

By changing the printer properties settings or using special paper, vivid images can be printed.

Changing the printer properties settings
Prints can be made with priority on print quality. Change print quality settings in the printer properties dialog
box.

Using special paper
Printing on special paper will look more vivid compared to printing on plain paper. Use inkjet plain paper or

semi-gloss photo paper.

= Reference

e Printing Using Preset Print Quality Settings =

o Recommended Consumables ad
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Printing > Various Print Functions

Various Print Functions

By using various print functions, you can make prints appropriate for your purposes.

= B Feferen=s

e Printing on Various Paper Types #d

Related topics

Printing Multiple Document Sets &4

Collating 3
Printing Web Pages 5

Reducing and Enlarging to Fit the Paper Size (Fit to paper size) ad

Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification) 4

Reducing to A4/Letter Automatically 71

Reducing to A3/11" x 17" Automatically a3

Rotating the Image by 180 Degrees ad

Printing on Registered Custom Size Paper 23

Printing on Unregistered Custom Size Paper 53

Printing on Both Sides of Paper 7

Printing Multiple Document Pages per Sheet (Layout) ad

Splitting the Document Image across Multiple Sheets (Poster) 7d

Printing from the Last Page 73

Creating a Binding Margin 73

Printing Documents with a Header and Footer 73

Printing with a Layout Suitable for Making Booklets 7

Printing Images or Text Superimposed on Prints 73

Printing Documents with an Overlay Image Superimposed (Overlay) 23
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Printing Multiple Document Sets

Follow the procedure below to print multiple sets of the same document.

i Limitation |

o Depending on the application, this setting may not be available.

o If you do not use the Collate function, prints will be delivered in page batches (P1, P1, P2, P2 ...). If you use the Collate function, prints will
be delivered in document batches (P1, P2, P1, P2 ...).

E] Open the file you want to print from the application, and then open the printer properties dialog box.

[2] Click the [Page Settings] tab.

[3] In the [Copies] box, enter the number of sets you want to print between 1 and 999.

[4] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[5] Make print settings, and then click [OK].

= B Feferen=s

o Collating 7

e Opening from an Application =i |
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Collating

Follow the procedure below to print complete sets of prints one set at a time when printing multiple sets such as for
presentation materials.

i Limitation |

e Depending on the application, this setting may not be usable.

o Even when using the Collate function with Layout, Poster, or Duplex, document boundaries are correctly recognized so problems like the
first page and last page being printed on the same sheet do not occur.

E] Open the file you want to print from the application, and then open the printer properties dialog box.

[2] Click the [Page Settings] tab.

E] In the [Copies] box, enter the number of sets you want to print between 1 and 999.

(4] Select the [Collate] check box.

[5] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[6] Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application 4
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Printing Web Pages

Use the procedures described below to make settings for printing Web pages.

When a Web page is printed, it may not fit on the paper used or it may not be printed as it looks on the screen. Use the
information below to print Web pages correctly.

Printing low resolution images smoothly

Images displayed on Web sites tend to be low resolution images to reduce data size. Before printing, be sure to
make the setting to print low resolution images smoothly.

Fitting a whole Web page to the paper size

If a whole Web page cannot be printed on the paper size used, reduce it using [Fit to paper size] or [Scale] under
the [Reduce/Enlarge] function.

If [A3 (297 x 420 mm)] or [B4 JIS (257 x 364 mm)] is selected for [Original size:] and [Reduce automatically
to fit A4 (210 x 297 mm )] in the [Auto reduce] list is selected, print image is automatically reduced to fit A4

size paper.

If [11" x 17"] or [Legal (8 1/," x 14")] is selected for [Original size:] and [Reduce automatically to fit Letter (8

1/," x 11")] in the [Auto reduce] list is selected, print image is automatically reduced to fit Letter size paper.

e When a Web page is printed over multiple sheets, images or text where any two sheets are connected may not be printed.

Printing the background color of a Web page

The background color of a Web page may not be printed. Make the settings to print the background color using
a Web browser.

Internet Explorer
E] On the [View] or [Tools] menu of the browser, click [Internet Options...].
Click the [Advanced] tab.
[E] In the [Settings] list, select the [Print background colors and images] check box under [Printing].
(4] Click [OK].
Netscape Navigator
E] On the [File] menu of the browser, click [Page Setup].

E] On the [Format & Options] tab, select the [Print Background (colors & images)] check box in the
[Options] area.

[3) Click [OK].

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0039.htm (1 of 2)2005/10/05 12:03:28


javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();

Printing Web Pages
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e Reducing and Enlarging to Fit the Paper Size (Fit to paper size) i |

e Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification) =i |

o Reducing to A4/Letter Automatically |
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Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Follow the procedure below to print document pages reduced or enlarged to fit the paper size. By specifying a
document and paper size, an appropriate reduction or enlargement ratio is selected automatically. This is useful when
reducing or enlarging from or to standard paper sizes such as when reducing an A3/11" x 17" document to A5/5 1/," x

8 1/," paper.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Page Settings] tab.

[E] Check that the document orientation and size are the same as those selected in the application.

o Usually the settings made in the application are reflected here; however, it depends on the application used. If they are not reflected,

make the correct settings.

E] Select the [Reduce/Enlarge] check box, and then click [Fit to paper size] in the list.

[5] In the [Printout paper size:] list, select a paper size.
Select the size of paper loaded in the paper tray.

o An automatically selected ratio appears in the [Scaling(%):] box.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[7] Make print settings, and then click [OK].

= Reference

e Opening from an Application |
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Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Follow the procedure below to print with a reduction or enlargement ratio in the range of 20-300% adjustable in 1%
increments. Use this to reduce the size of the print image slightly to insert a margin, for example.

Two methods are available: scale and directional magnification. Scale is used to specify the same ratio in both
horizontal and vertical directions while directional magnification is used to specify a different ratio for each direction.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
[2] Click the [Page Settings] tab.
E] Select the [Reduce/Enlarge] check box, and then click [Scale] or [Directional magnification...] in the list.

(4] If [Scale] is selected, enter a ratio in the [Scaling(%):] box.

o Enter a number between 20 and 300.

o In the [Printout paper size:] list, you can change the paper size.

If [Directional magnification...] is selected, enter ratios in the [Vertical:] and [Horizontal:] boxes, and
then click [OK].

E] Select the [Centering] check box to center an image.

o If [Scale] or [Directional magnification...] is selected, a wide margin may be created on the right or bottom of the paper. If this happens,

select the [Centering] check box to center an image and create margins of the same width.

o If the [Centering] check box is not selected, the reduced or enlarged image is positioned in the upper left of the paper.

(7] Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

Make print settings, and then click [OK].

=l Reference

e Opening from an Application =
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Reducing to A4/Letter Automatically

Follow the procedure below to print a document larger than A4/Letter onto A4/Letter size paper by reducing it. For
example, if a document is A3/11" x 17" size, it can be automatically reduced to A4/Letter and printed.

E] Open the file you want to print from the application it was created in, and then open the printer
properties dialog box.

Click the [Page Settings] tab.

[3] Check the document orientation and size are the same as those selected in the application.

o Normally, settings made in the application are reflected here; however, this may not be the case depending on the application used. If

necessary, make the correct settings.

In the [Printout paper size:] list, [Reduce to fit A4]/[Reduce to fit Letter] appears.

o If [Reduce to fit A4]/[Reduce to fit Letter] does not appear, select the [Auto reduce] check box, and then select [Reduce automatically

to fit A4 (210 x 297 mm )]/[Reduce automatically to fit Letter (8 1/2" x 11")] in the [Auto reduce] list.

[@) Click [OK].

[5] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

[6] Make print settings, and then click [OK].

o If you do not want to reduce images from documents larger than A4/Letter, clear the [Auto reduce] check box in the [Printer Configuration]

dialog box. This is useful if you want to print document images at full size even if they run off the paper.

= Reference

o Opening from an Application |

o For details about [Auto reduce], see the printer driver Help.
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Printing > Various Print Functions > Reducing to A3/11" x 17" Automatically

Reducing to A3/11" x 17" Automatically

Follow the procedure below to print a document larger than A3/11" x 17" onto A3/11" x 17" size paper by reducing it.
For example, if a document is A2/17" x 22" size, it can be automatically reduced to A3/11" x 17" and printed.

E] Open the file you want to print from the application it was created in, and then open the printer
properties dialog box.

Click the [Page Settings] tab.

[3] Check t the document orientation and size are the same as those selected in the application.

o Normally, settings made in the application are reflected here; however, this may not be the case depending on the application used. If

necessary, make the correct settings.

In the [Printout paper size:] list, [Reduce to fit A3]/[Reduce to fit 11" x 17"] appears.

o If [Reduce to fit A3]/[Reduce to fit 11" x 17"] does not appear, select is [Auto reduce] check box, and then select [Reduce automatically

to fit A3 (297 x 420 mm )]/[Reduce automatically to fit 11" x 17"] in the [Auto reduce] list.

[@) Click [OK].

[5] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

[6] Make print settings, and then click [OK].

o If you do not want to reduce images from documents larger than A3/11" x 17", clear the [Auto reduce] check box in the [Printer

Configuration] dialog box. This is useful if you want to print document images at full size even if they run off the paper.

=l Reference

e Opening from an Application =

o For details about [Auto reduce], see the printer driver Help.
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Printing > Various Print Functions > Rotating the Image by 180 Degrees

Rotating the Image by 180 Degrees

Follow the procedure below to print images rotated by 180 degrees. Use this function if paper loaded in the paper tray
has a distinct top and bottom and printing with the paper in that orientation would otherwise make the image upside-
down.

E] Open the file you want to print from the application, and then open the printer properties dialog box.
[2] Click the [Page Settings] tab.
[3] Select the [Rotate by 180 degrees] check box.

[4] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
E] Make print settings, and then click [OK].

= B Feferens

e Opening from an Application i |
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Printing > Various Print Functions > Printing on Registered Custom Size Paper

Printing on Registered Custom Size Paper

Follow the procedure below to print on registered custom size paper.

i B P reparation

o Register the size of the custom size paper loaded in the paper tray in the [Printer Configuration] dialog box.

[1] Open the [Page Setup] dialog box from the application.

The [Page Setup] dialog box is usually opened by clicking [Page Setup...] on the [File] menu, but the method to
open it may differ in some applications. Open the dialog box according to the application being used.

[1] Open the printer properties dialog box from the [Page Setup] dialog box.
[3] Click the [Page Settings] tab.

[4] In the [Original size:] list, select a custom paper size.

Select from the sizes already registered.

[5] Click [Portrait] or [Landscape].

Select the orientation that matches the document orientation and feeding direction.
[E] Click the [Setup] tab.
[7] Check that the tray with the paper you want to print on is selected in the [Paper source tray:] list.

Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

[9] Check that the orientation selected in the [Setup] dialog box of the application is the same as that
selected in step 5] .

If it is not, make the correct setting.
Close the [Page Setup] dialog box of the application.
[11] Create a file in the application.

@ In the printer properties dialog box, make the print settings for the printer selected in step E] ,and
then click [OK].

= N Reference

o Opening from an Application ad

o For details about [Custom Paper Sizes], see the printer driver Help.
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Printing > Various Print Functions > Printing on Unregistered Custom Size Paper

Printing on Unregistered Custom Size Paper

Follow the procedure below to print on unregistered custom size paper.

[1] Open the [Page Setup] dialog box from the application.

The [Page Setup] dialog box is usually opened by clicking [Page Setup...] on the [File] menu, but the method to
open it may differ in some applications. Open the dialog box according to the application being used.

E] Open the printer properties dialog box from the [Page Setup] dialog box.
[3] Click the [Page Settings] tab.

(@] In the [Original size:] list, click [Custom paper size...].
The [Custom Paper Size] dialog box appears.

E] In the [Long edge:] and [Short edge:] boxes, enter values.

o To change the measurement unit, click [Measurement Unit...].

E] In the [Paper source tray:] list, select a paper tray.

E] In the [Paper Position in Tray] area, select a paper orientation.

Click [OK].

o To register the paper size as a custom paper size, click [Open [Custom Paper Sizes]...].

[9] Click the [Setup] tab.
Check that the tray with the paper you want to print on is selected in the [Paper source tray:] list.
[11] Click the [Page Settings] tab.

[E] Click [Portrait] or [Landscape].

Select the orientation that matches the document orientation and feeding direction.

[13] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

[14] Check that the orientation selected in the [Page Setup] dialog box of the application is the same as that
selected in step [12] .

If it is not, make the correct setting.
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[15] Close the [Page Setup] dialog box of the application.

Create a file in the application.

@ In the printer properties dialog box, make the print settings for the printer selected in step E] , and
then click [OK].

= Reference

e Opening from an Application |

o For details about [Custom Paper Sizes], see the printer driver Help.
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Printing > Various Print Functions > Printing on Both Sides of Paper

Printing on Both Sides of Paper

Follow the procedure below to print on both sides of paper.
H

o Only plain paper can be printed on both sides.

o If the page size varies within a document, a page break will occur before the page where the size changes.
e We recommend one-sided printing for documents containing areas of heavy, solid color image.

o If two-sided prints fail to dry fully, set a print-dry delay using the printer driver.

o If two-sided prints stick or jam, use single-sided printing.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Edit] tab.

[3] Select the [Duplex/Booklet] check box.

o If you select the [Create margin] check box when printing on plain paper, the machine automatically reduces the size of the page images

and centers them on the paper.

[4] Click the icon representing the binding method you want to use.

o The icons are displayed in either landscape or portrait depending on the document orientation.

[5] Select the [Header/Footer/Adjust image position/Binding margins] check box to create a binding
margin.

Click [Details...] to specify a margin in the [Binding Margins for Duplex Printing] area.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[7] Make print settings, and then click [OK].

= N Reference

o Opening from an Application ad
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Printing > Various Print Functions > Printing Multiple Document Pages per Sheet (Layout)

Printing Multiple Document Pages per Sheet (Layout)

Follow the procedure below to print multiple document pages per sheet.

e When using Layout, a suitable reduction or enlargement ratio is selected automatically based on the paper size and the number of pages you

want to fit on each sheet.
o If the page orientation varies within a document, a page break will occur before a page where the orientation changes.

o If an equivalent function is available from your application, do not use it. Use the function that can be set in the printer properties.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
[2] Click the [Edit] tab.

[3] Select the [Layout/Poster] check box, and then select the number of document pages you want to fit on
each sheet in the list.

e Do not click [Poster] since it is a different function.

[E] Click the icon that matches the page flow you want to use.

o The icons show the available page flows for the number of pages selected.

o The icons are displayed in either landscape or portrait depending on the document orientation.

[5] Select the [Draw border] check box to print borders.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[7] Make print settings, and then click [OK].

= B Feferens

e Opening from an Application i |
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Splitting the Document Image across Multiple Sheets (Poster)

Follow the procedure below to print a single document page over multiple sheets to make a poster size print.

o The enlargement ratio used is based on the specified paper size and the number of sheets you want to split the image over.

o Prints are made with a 15 mm (0.6 inches) overlap margin. When pasting sheets together, overlap them to hide this margin.

E] Open the file you want to print from the application, and then open the printer properties dialog box.
[2] Click the [Edit] tab.
E] Select the [Layout/Poster] check box, and then click [Poster] in the list.

[4] Click the icon representing the number of sheets you want to split the image over.

o The icons are displayed in either landscape or portrait depending on the document orientation.

[5] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
E] Make print settings, and then click [OK].

=l Reference

e Opening from an Application =
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Printing > Various Print Functions > Printing from the Last Page

Printing from the Last Page

Follow the procedure below to start printing from the last page of a document. Use this function when prints come out
face up in the output tray. This allows a printed document to be assembled in page order.

o If an equivalent function is available from your application, do not use it. Use the function that can be set in the printer properties.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
[2] Click the [Page Settings] tab.
[3] Select the [Reverse order printing] check box.

(4] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[5] Make print settings, and then click [OK].

= N Reference

o Opening from an Application ad
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Creating a Binding Margin

Follow the procedure below to print with a binding margin. If you create a binding margin, it is offset from the
document margin set from the application.

o Since the margin opposite the binding margin will be shifted toward the paper edge, be sure to make this margin wide enough when making

the document.

o If a binding margin is set in an application, do not make this setting in the printer properties. This would result in a binding margin twice as

wide as expected.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
[2] Click the [Edit] tab.
E] Select the [Header/Footer/Adjust image position/Binding margins] check box.

(4] Click [Details...].
The [Header/Footer/Adjust image position/Binding margins] dialog box appears.

E] In the [Adjust Image Position] area, select the direction in which you want to shift the print area in the
[Direction:] list.

e Margins (top, bottom, left, right) change according to the selected direction.

[6] Enter a binding margin width, and then click [OK].

o To change the measurement unit, click [Measurement Unit...].

[7] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
Make print settings, and then click [OK].

= N Reference

o Opening from an Application ad
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Printing Documents with a Header and Footer

Follow the procedure below to print documents with character strings in the top and bottom margins.

o Besides date, page number, and file name, text of up to 32 characters can be inserted into these areas.
o If you print a document using the Reduce/Enlarge function, the header and footer will also be reduced or enlarged.

o A header and footer will be printed on every page. For example, if you print several document pages on a sheet of paper (Layout), a header

and footer will appear for every page.

o If a header and footer are set in an application, do not make this setting in the printer properties.

E] Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Edit] tab.
E] Select the [Header/Footer/Adjust image position/Binding margins] check box.

[4] Click [Details...].
The [Header/Footer/Adjust image position/Binding margins] dialog box appears.

E] In the [Header/Footer] area, make the necessary settings, and then click [OK].

o If the same position is selected for the date and time, page number, or text, the printing order is as follows: date and time, text, page

number.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[7] Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application 74
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Printing with a Layout Suitable for Making Booklets

Follow the procedure below to print on both sides of paper using a layout suitable for making booklets.

e There are two kinds of booklet layout: [Booklet 1] and [Booklet 2]. With [Booklet 1], each sheet is folded in half separately, then the folded
sheets are stacked and bound. With [Booklet 2], the whole stack is folded in half in a similar way to a magazine.

E] Open the file you want to print from the application, and then open the printer properties dialog box.

[2] Click the [Edit] tab.

[3] Select the [Duplex/Booklet] check box.

[4] Click the icon representing the booklet format you want to use.

o The icons are displayed in either landscape or portrait depending on the document orientation.

[5] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
E] Make print settings, and then click [OK].

= B Feferens

e Opening from an Application i |

e Printing on Both Sides of Paper 5 |
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Printing Images or Text Superimposed on Prints

Follow the procedure below to print an image or text superimposed on prints. The image or text is referred to as a
watermark.

o A watermark made up of a bitmap file (extension .bmp) is referred to as an image watermark. A watermark made up of text data is referred to

as a text watermark. You cannot use both together.

e Various predefined watermarks are provided. You can also create your own watermarks.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Edit] tab.

[E] Select the [Watermarks/Overlay] check box, and then select a watermark in the list.

o To edit the watermark, click [Edit...].

e To create a new watermark, click [Add Bitmap...] or [Add Text...].

(4] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
E] Make print settings, and then click [OK].

=l Reference

e Opening from an Application =

Related topics

Creating a New Watermark =3
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Creating a New Watermark

Follow the procedure below to create a new watermark.

o There are two kinds of watermarks: image watermarks made up of a bitmap file (extension .bmp) and text watermarks made up of text data.

[1] Open the printer properties dialog box.

[2] Click the [Edit] tab.

E] Select the [Watermarks/Overlay] check box.

E] Click [Add Bitmap...] to create an image watermark, or click [Add Text...] to create a text watermark.

[E] Make the necessary settings in the [Add Bitmap Watermark] or [Add Text Watermark] dialog box,
and then click [OK].

The watermark is registered and added to the list.

= N Reference

e Opening from the Start Menu |

e Opening from an Application ad

e Printing Images or Text Superimposed on Prints 3 |
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay)

Printing Documents with an Overlay Image Superimposed (Overlay)

Follow the procedure below to print a document with an overlay image superimposed.

o Before printing using the Overlay function, an overlay image file and overlay set must be created.

o A superimposing image will be aligned with the document page at the upper left corner. If the document to be printed and superimposing

image differ in size and orientation, the superimposing image may be cut or run off.

e Depending on the application, you may not get the expected result.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.
[2] Click the [Edit] tab.

[3] Select the [Watermarks/Overlay] check box, and then select an overlay set in the list.

o To edit the overlay set, click [Edit...].

o To create a new overlay set, click [Add Overlay....].

[4] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

[5] Make print settings, and then click [OK].

ﬁ Overlay image file:

Data saved in a format allowing it to be used as a superimposing image.

Q Overlay set:

An overlay image file and setting details (such as how and which page an overlay image is superimposed on) are
combined, named, and registered as a set. Each set registered is called an overlay set.

When printing, select an overlay set.

= B Feferens

e Opening from an Application i |

Related topics
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Creating a New Overlay Image File

Follow the procedure below to create an overlay image file.

e You can create an overlay image file with any application.
e When an overlay image file is created using a multiple-page document, only the first page will be saved as an overlay image.

E] Open the file with which you want to create an overlay image file, and then open the printer properties
dialog box.

(2] On the [Setup] tab, click [Save as Overlay Data...] in the [Job type:] list.
The [Job Type Details] dialog box appears.

(3] In the [File name:] box, enter a file name.

o Enter a name using up to 32 characters.

o Under Windows 95/98/Me, enter a name using up to eight characters.

[@) Click [OK].

[5] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

e When creating an overlay image file (when [Save as Overlay Data...] is selected in the [Job type:] list), only print quality settings are

available.
[6] Click [OK] in the [Print] dialog box.
The overlay image file is created.

= Reference

e Opening from an Application =
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Deleting an Overlay Image File

Follow the procedure below to delete an overlay image file.
E] Open the printer properties dialog box.
E] On the [Setup] tab, click [Save as Overlay Data...] in the [Job type:] list.
[3] Select the overlay image file you want to delete.

[4] Click [Delete].

A confirmation message appears.

[5] Click [OK].

The overlay image file is deleted.

e You can also delete overlay image files (extension .rpo) using Windows Explorer.

= Reference

o Opening from the Start Menu |

o Opening from an Application ad
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Creating a New Overlay Set

Follow the procedure below to combine an overlay image file and setting details (such as how and which page an
overlay image is superimposed on), name it, and register it as a set. Each set registered is called an overlay set.

o For printing the same overlay image with different setting details, set different combinations of setting details for the same overlay image

file, and then register each set as a different overlay set.

[I] Open the printer properties dialog box.

[2] Click the [Edit] tab.

E] Select the [Watermarks/Overlay] check box.
[4] Click [Add Overlay....].

E] In the [Add Overlay] dialog box, make the necessary settings, and then click [OK].

The overlay set is registered and added to the list.

= Reference

o Opening from the Start Menu a4

e Opening from an Application i |
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Custom Settings
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Printing > Custom Settings

Custom Settings

In [Custom Settings:], frequently used printer properties settings can be registered as a custom setting.

Since custom settings can be saved in a file and recalled from that file, multiple users can share that file to print with
the same printer properties settings.

Related topics

Printing 73

Registering 71
Changing the Name 71

Deleting =3

Updating Custom Settings According to the Current Printer Configuration #d

Changing the Custom Settings Display Order 71

Saving a Registered Custom Setting in a File 73

Registering a Custom Setting Using a Custom Setting File 73
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Printing
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Printing > Custom Settings > Printing

Printing

Follow the procedure below to print with the registered custom settings.

i B P reparation

o The printer configuration settings must be made beforehand.

[1] Open the file you want to print from the application, and then open the printer properties dialog box.

E] On the [Setup] tab, select a setting in the [Custom Settings:] list.
Click [No setting] to print with the standard settings.

[3] On the [Page Settings] tab, check that the document orientation and size are the same as those selected
in the application.

o Usually the settings made in the application are reflected here; however, it depends on the application used. If they are not reflected,

make the correct settings.

[4] To print multiple sets, enter the number of sets in the [Copies] box.

[5] On the [Setup] tab, click [Normal Print] in the [Job type:] list.

o A paper tray and paper type are included in a registered custom setting. If you want to print on paper that is different from the one in the

selected custom setting, you can select the paper tray and paper type you want to use on the [Setup] tab.

[6] Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
[E] Make print settings, and then click [OK].

= N Reference

o For details about specifying the installed options, see the printer driver Help.

e Opening from an Application ad
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Printing > Custom Settings > Registering

Registering

Follow the procedure below to register a new custom setting.

o Up to 16 custom settings can be registered.

[1] Open the printer properties dialog box.
[2] Click the [Setup], [Page Settings], or [Edit] tab.

E] In the [Custom Settings:] list, select the custom setting on which you want to base the new custom
setting.

o To base the new setting on the default settings, click [No setting].

e When creating a new custom setting based on an existing custom setting, select the custom setting from which you can make the new

setting with the least changes.

[4] Make the settings on the [Setup], [Page Settings], and [Edit] tabs.
[
o Settings not included in a custom setting are as follows: [Job type:] on the [Setup] tab, [Original orientation:], [Original size:], [Printout

paper size:], and [Copies] on the [Page Settings] tab, and all settings in the [Printer Configuration] dialog box.

E] Click [Save...].
The [Save New Custom Setting] dialog box appears.

E] In the [Custom Setting name:] box, enter a custom setting name.

o Up to 36 characters can be entered.

[7) Click [OK].

The custom setting is registered and added to the list.

Click [OK].

The printer properties dialog box closes.

= Reference

o Opening from the Start Menu |
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Printing > Custom Settings > Changing the Name

Changing the Name

Follow the procedure below to change a name of a registered custom setting.
[1] Open the printer properties dialog box.
[2] Click the [Setup], [Page Settings], or [Edit] tab.

[3] Click [Manage...].
The [Manage Custom Settings] dialog box appears.

E] Select the custom setting whose name you want to change.

o [No setting] cannot be changed.

[5] In the [Custom Setting name:] box, enter a new name.

o Up to 36 characters can be entered.

(6] Click [Close].

The custom setting name is changed.

[@) Click [OK].

The printer properties dialog box closes.

= Reference

o Opening from the Start Menu |

o Opening from an Application ad
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Deleting

User Guide

| g Contents | 4 Previous . Next f |

Printing > Custom Settings > Deleting

Deleting

For screen reader

|

Follow the procedure below to delete a registered custom setting.

Standard

| Settings | | 2]

o If you delete the custom settings that were registered automatically during installation of the printer driver, they will reappear when the

custom settings display is updated.

[1] Open the printer properties dialog box.

[2] Click the [Setup], [Page Settings], or [Edit] tab.

[3] Click [Manage...].

The [Manage Custom Settings] dialog box appears.

[4] Select the custom setting you want to delete.

o [No setting] cannot be deleted.

[5] Click [Delete Custom Setting].

A confirmation message appears.
[6] Click [OK].

E] Click [Close].

Click [OK].

The printer properties dialog box closes.

= Reference

o Opening from the Start Menu |

o Opening from an Application ad
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Printing > Custom Settings > Updating Custom Settings According to the Current Printer Configuration

Updating Custom Settings According to the Current Printer Configuration

There are two kinds of custom settings displayed in the printer properties dialog box: those registered automatically
during installation of the printer driver and custom settings added later by the user. Since these custom settings are not
deleted automatically, depending on the installed options, some custom settings that cannot be used to print may
remain.

To keep only custom settings that can be used with the options installed, follow the procedure below to update custom
settings after you install or uninstall options. The following is how each kind of custom settings will be updated:

o Custom settings registered automatically during printer driver installation
Custom settings that can still be used remain registered. Custom settings that cannot be used are deleted.

o Custom settings registered by user

Custom settings that cannot be used are deleted. Deleted custom settings cannot be recovered.

o If bidirectional communication is not working, you must configure installed options in the [Printer Configuration] dialog box before

performing this procedure.

[1] Open the printer properties dialog box.
[2] Click the [Setup], [Page Settings], or [Edit] tab.

[3] Click [Manage...].
The [Manage Custom Settings] dialog box appears.

[4] Click [Refresh Printer Information].

o If bidirectional communication is working, printer configuration settings in the [Accessories] area and custom settings in the [Custom

Settings:] list are updated.

o If bidirectional communication is not working, custom settings in the [Custom Settings:] list are updated according to the current printer

configuration settings in the [Accessories] area.

[E] Click [Close].

(&) Click [OK].

The printer properties dialog box closes.

=l Reference

o Checking Whether Bidirectional Communication is Working or Not |

o For details about [Printer Configuration], see the printer driver Help.
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Updating Custom Settings According to the Current Printer Configuration

e Opening from the Start Menu i |

o Opening from an Application 5 |
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Printing > Custom Settings > Changing the Custom Settings Display Order

Changing the Custom Settings Display Order

Follow the procedure below to change the display order in the [Custom Settings:] list. For optimal ease-of-use, change
the order according to the setting type and how often you use them.

[1] Open the printer properties dialog box.
[2] Click the [Setup], [Page Settings], or [Edit] tab.

[3] Click [Manage...].
The [Manage Custom Settings] dialog box appears.

(@] Select the custom setting you want to move.

o [No setting] cannot be moved.

[5] Click [Move Up] or [Move Down].
(6] Click [Close].

[7) Click [OK].

The printer properties dialog box closes.

= N Reference

o Opening from the Start Menu |

e Opening from an Application ad
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Saving a Registered Custom Setting in a File
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Printing > Custom Settings > Saving a Registered Custom Setting in a File

Saving a Registered Custom Setting in a File

Follow the procedure below to save a registered custom setting in a custom setting file.

i Limitation |

o Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, this function is unavailable.

[1] Open the printer properties dialog box.
[2] Click the [Setup], [Page Settings], or [Edit] tab.

[3] Click [Manage...].
The [Manage Custom Settings] dialog box appears.

[4] Select the custom setting you want to save.

[5] Click [Save Custom Setting...].
The [Save Custom Setting] dialog box appears.

(6] In the [File name:] box, enter a file name.

o Up to eight characters can be entered.
o The extension is .rst.

[7) Click [OK].

The [Save Custom Setting] dialog box closes. The custom setting is saved in a custom setting file.

= B Feferen=s

e Opening from the Start Menu a4

e Opening from an Application i |
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Printing > Custom Settings > Registering a Custom Setting Using a Custom Setting File

Registering a Custom Setting Using a Custom Setting File

Follow the procedure below to register a custom setting from a custom setting file. This file would be provided by an
administrator, for example.

o The custom settings file name can be up to eight characters.

[1] Open the printer properties dialog box.
[2] Click the [Setup], [Page Settings], or [Edit] tab.

[3] Click [Manage...].
The [Manage Custom Settings] dialog box appears.

[4] Click [Load Custom Setting].
The [Load Custom Setting...] dialog box appears.

[5] Select the file containing the custom setting you want to register.

(&) Click [OK].

The custom setting is imported and registered.

[7] Click [Close].

Click [OK].

The printer properties dialog box closes.

= B Feferens

e Opening from the Start Menu =i |

e Opening from an Application =
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Printer Driver > Opening the Printer Properties Dialog Box

Opening the Printer Properties Dialog Box

The printer properties dialog box can be opened from an application or from the [Start] menu of Windows. Depending
on how you open it, the available tabs vary.

Related topics

Opening from the Start Menu 3

Opening from an Application a3
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Opening from the Start Menu

All printer properties settings can be changed if the printer properties dialog box is opened from the [Printers] folder
(Windows XP, Windows Server 2003: the [Printers and Faxes] folder).

o The printer properties settings made here are displayed as the default when the printer properties dialog box is opened from an application.

Related topics
For Windows 95/98/Me ad

For Windows 2000, Windows NT 4.0 73

For Windows XP, Windows Server 2003 73
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu > For Windows 95/98/Me

For Windows 95/98/Me

Follow the procedure below to open the printer properties dialog box from the [Start] menu.
[1] On the [Start] menu, point to [Settings], and then click [Printers].

E] Click the icon of the printer, and then click [Properties] on the [File] menu.
The printer properties dialog box appears.
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For Windows 2000, Windows NT 4.0

Follow the procedure below to open the printer properties dialog box (Windows NT 4.0: the [Default] dialog box)
from the [Start] menu.

[1] On the [Start] menu, point to [Settings], and then click [Printers].

[1] Click the icon of the printer, and then click [Printing Preferences...] on the [File] menu.

o Under Windows NT 4.0, click [Document Defaults...] on the [File] menu.

o To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box (Windows NT 4.0: the [Default] dialog box) appears.
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For Windows XP, Windows Server 2003

Follow the procedure below to open the printer properties dialog box from the [Start] menu.

e Depending on the operating system settings, the actual procedure may differ.

Windows XP Home Edition
[1] On the [Start] menu, click [Control Panel].

Click [Printers and Other Hardware].

[3] Click [Printers and Faxes].
o To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box appears.

Windows XP Professional, Windows Server 2003
E] On the [Start] menu, click [Printers and Faxes].

o To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box appears.
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Opening from an Application
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Opening from an Application

Follow the procedure below to open the printer properties dialog box from an application. The default properties
settings are displayed when opened from an application. Change the settings as necessary.

o Changes made here are only applicable with that application and only as long as that application stays open.
o Some applications may automatically change the printer properties settings.
e The procedure below is an example for Paint (included in the standard Windows package).

o How to open the printer properties dialog box differs depending on the application. From most applications, the printer properties dialog box
can be opened by clicking [Print...] or [Page Setup...] on the [File] menu, and then clicking [Properties] (Windows XP, Windows Server

2003: [Preferences]). For details, see Help of the application.

[1] On the [File] menu, click [Print...].

E] In the Name list, select the name of this printer, and then click Properties (Windows XP, Windows
Server 2003: Preferences).

The printer properties dialog box (Windows XP, Windows Server 2003: the [Printing Preferences] dialog box)
appears.
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Printer Driver > Displaying the Printer Status

Displaying the Printer Status

Using the Printer Status monitor, printer conditions such as the print jobs can be checked from the computer. Also,
when errors occur, the status of the printer and the solution to the problem can be checked quickly.

Related topics

Opening the Printer Status Monitor 73
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Opening the Printer Status Monitor
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Printer Driver > Displaying the Printer Status > Opening the Printer Status Monitor

Opening the Printer Status Monitor

The Printer Status monitor automatically opens when printing starts. It can also be opened when not printing. Follow
the procedure below to open the Printer Status monitor.

[1] Open the printer properties dialog box.
[1] Click the [Maintenance] tab.

[3] Click [Display Status Monitor].

The Printer Status monitor dialog box appears.

=l Reference

o Opening from the Start Menu =5

o Opening from an Application ad
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Printer Driver > Using Help / Checking Bidirectional Communication

Using Help / Checking Bidirectional Communication

This section describes how to use the printer driver Help and how to check whether bidirectional communication is
working or not.

Related topics

Using Help 73

Checking Whether Bidirectional Communication is Working or Not a1
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Using Help

For information about setting items and how to make settings, see Help.

Two types of the printer driver Help are available: context Help and content Help.

Related topics

Displaying an Explanation for Each Setting Item (Context Help) 7

Displaying Help in a Help Window (Content Help) 73
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Printer Driver > Using Help / Checking Bidirectional Communication > Using Help > Displaying an Explanation for Each Setting Item (Context Help)

Displaying an Explanation for Each Setting ltem (Context Help)

Follow the procedure below to display Help for each setting item.

[1] Click the [?] button found at the upper right of each dialog box.

A question mark appears beside the pointer.

E] Move the pointer over the setting item for which you want to read Help.

e You can also display Help for the setting item by right-clicking the setting item, and then clicking [Help] on the shortcut menu that

appears.
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Displaying Help in a Help Window (Content Help)

Follow the procedure below to display Help.

[1] Click [Help] found at the lower right in each dialog box.
Help for the open dialog box appears.

[2] To display the contents, click [Help Topics].
(3] In the [Help Topic] dialog box, select a topic.
(4] Click [Display].

o To print the currently displayed Help topic, click [Print] at the top.
o To print from the [Help Topics] dialog box, select a topic, and then click [Print].
o In the [Help Topics] dialog box, selecting a book and printing it will print all topics in that book.

= N Reference

o Opening from the Start Menu 5 |

e Opening from an Application |

o For details about using [Help], see the manual provided with Windows.
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Checking Whether Bidirectional Communication is Working or Not

Follow the procedure below to check if bidirectional communication is working by obtaining the printer version
information.

[1] Open the printer properties dialog box.
[1] Click the [Maintenance] tab.

[3] Click [About].
The [About] dialog box appears.

[E] Check that the printer version is displayed.
When bidirectional communication is working, the printer version is displayed.
[5] Click [OK].

o The printer version appears under [System Version:].

Q Requirements for Bidirectional Communication

If bidirectional communication is working between the printer and computer, information about the paper loaded
in the printer is sent to the computer and is applied automatically to the printer properties settings. In addition to
that, the printer status can be checked from the computer.

o The computer must support bidirectional communication.
o The bidirectional communication settings must be enabled in the printer properties.

o The printer and computer must be connected using a USB cable.

= N Reference

e Opening from the Start Menu =i |

e Opening from an Application =

|| Top | 4 Previous « Next fp |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0081.htm2005/10/05 12:04:14


javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();

Maintaining the Printer Using Utilities

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | | Settings | | 2]

Printer Driver > Maintaining the Printer Using Ultilities

Maintaining the Printer Using Utilities

If you repeatedly print, the inside of the printer will get dirty and print quality may degrade. Perform printer
maintenance from the [Maintenance] tab in the printer properties dialog box.

Related topics
Nozzle Check 73

Clean Print-heads (Normal) 4

Clean Print-heads (Full) 73

Adjust Print-head Positions 74

Registration a3
Adjust Paper Feed a3

Restore Defaults/Other Settings ad
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Nozzle Check

User Guide

For screen reader Standard
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Printer Driver > Maintaining the Printer Using Utilities > Nozzle Check

Nozzle Check

Follow the procedure below to check whether the print-head nozzles are clogged up or not by printing a nozzle check
test pattern.

e To check the printed test pattern, proceed to step E] .

E] Open the printer properties dialog box.

E] Click the [Maintenance] tab.

[3] Click [Nozzle Check].

[4] Click [Next >].

[5] Check that Ad/Letter size paper is loaded in the paper tray.
[6] Click [Next >].

[7] Check the printed test pattern.
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When print-heads are clogged

Click [Finish].

o If the printed test pattern is not clear, select the [Clean Print-heads (Normal)] check box, and then click [Next >].

= N Reference
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Nozzle Check

o Opening from the Start Menu =5

o Opening from an Application |

o Clean Print-heads (Normal) ad
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Printer Driver > Maintaining the Printer Using Utilities > Clean Print-heads (Normal)

Clean Print-heads (Normal)

Follow the procedure below to perform a normal print-head cleaning. Perform a head cleaning when a particular color
cannot be printed or print images are blurred. Head cleaning consumes ink.

e When the Print cartridge is empty, replace it instead of performing a print-head cleaning. After a Print cartridge is replaced, a print-head

cleaning will be automatically performed.

(1] Slide the envelope selector [J to the forward position.

[2] Open the printer properties dialog box.

[3] Click the [Maintenance] tab.

E] Click [Clean Print-heads (Normal)].

[E] In the [Select print-head(s)] area, select a color.
[6] Click [Next >].

[7] Click [Next >].

o Do not perform another operation before cleaning is complete.

Click [Finish].

o To check the condition of print-heads after cleaning, select the [Print nozzle check test pattern] check box, and then click [Next >].
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Clean Print-heads (Normal)
Nozzle check starts.

o If the condition of the print-heads is not satisfactory, perform head cleaning again. However, the heads may remain clogged and the
printer may not print properly even if you clean the heads multiple times. If this happens, perform a full print head cleaning. If there is

still no improvement, turn the printer off, and then leave it turned off for at least 8 hours. This may solve the problem.

= Reference

o Opening from the Start Menu a4

e Opening from an Application i |

o Nozzle Check 7d

e Clean Print-heads (Full) 7
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Printer Driver > Maintaining the Printer Using Utilities > Clean Print-heads (Full)

Clean Print-heads (Full)

Follow the procedure below to perform a thorough print-head cleaning. Since this consumes more ink than a normal
head cleaning does, perform this when the problem persists after performing a normal head cleaning.

e When the Print cartridge is empty, replace it instead of performing a print-head cleaning. After a Print cartridge is replaced, a print-head

cleaning will be automatically performed.

(1] Slide the envelope selector [J to the forward position.

[2] Open the printer properties dialog box.

[3] Click the [Maintenance] tab.

E] Click [Clean Print-heads (Full)].

[E] In the [Select print-head(s)] area, select a color.
[6] Click [Next >].

E] Select the [Clean Print-heads (Full)] check box.

Click [Next >].

Head cleaning starts.

o Do not perform another operation before cleaning is complete.

(8] Click [Finish].
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Clean Print-heads (Full)

o To check the condition of print-heads after cleaning, select the [Print nozzle check test pattern] check box, and then click [Next >]. The

nozzle check starts.

o A full print-head cleaning consumes a lot of ink. Perform it only when necessary.
o A full print-head cleaning may deplete the ink before the Print cartridge is expected to need to be changed.

= B Feferens

e Opening from the Start Menu i |

e Opening from an Application =i |

o Nozzle Check ad
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Adjust Print-head Positions

Follow the procedure below to print a test pattern and adjust the print-head positions if vertical lines are printed
unaligned or printed colors look blurred.

e To check the printed test pattern, proceed to step .

o When the envelope selector is not at the correct position, the colors may be printed unaligned.

[1] Open the printer properties dialog box.
[2] Click the [Maintenance] tab.
[3] Click [Adjust Print-head Positions].

E] In the [Select a test pattern:] list, select a test pattern.

o Select a resolution. To adjust print-head positions for all resolutions, repeat this procedure selecting the other resolution.

[High speed/ Standard (speed priority)] is selected here as an example.
[5] Click [Next >].
[6] Check that Ad/Letter size paper is loaded in the paper tray.

[7] Click [Next >].

A test pattern to adjust print-head positions is printed.

o Do not perform other operations during printing.

o The "High quality" test pattern differs from the "Standard" test pattern.

Check the optimal adjustment values on the printed test pattern.

o The optimal adjustment value is the column number that appears above the lightest gray square with straight vertical lines on both sides.

‘When the column number is "+2" for the "A" line, the optimal adjustment value is "+2" for "A".
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Adjust Print-head Positions

/[ +1 +2 +3

[9] Enter the optimal adjustment values.

Click [Finish].

o Repeat steps E] to to print the "High quality" or "Standard" test pattern and enter the optimal adjustment values.
= j| Reference

e Opening from the Start Menu i |

e Opening from an Application 74
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Registration

Follow the procedure below to adjust where to start printing on paper loaded in each paper tray after checking the test
pattern printed.

e To check the printed test pattern, proceed to step .

E] Open the printer properties dialog box.

E] Click the [Maintenance] tab.

[3] Click [Registration].

E] In the [Unit type:] list, select a paper tray. In the [Paper type:] list, select a paper type.
[5] Click [Next >].

E] Check that Ad/Letter size paper is loaded in the paper tray.

E] Click [Next >].

A test pattern to adjust the print start position is printed.

o Do not perform other operations during printing.

Check the optimal adjustment values on the printed test pattern.

o Fold the test pattern sheet in half lengthwise.

+

I
-

o The optimal adjustment value is the difference between the single vertical line and the cross's vertical line that you can see when the
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Registration

folded paper is held up to light. When the difference is one calibration mark in the "+" direction, the optimal adjustment value for the

[Printing direction:] is "+1.0".

o Fold the test pattern sheet in half widthwise, and then check the adjustment value for the [Paper feed direction:].

o Adjustment values are in 0.1 increments.

E] In the [Printing direction:] and [Paper feed direction:] boxes, enter the adjustment values (-4.0 to +4.0)
from step .
Click [Finish].

o If a test pattern does not print or the image is not clear, select the [Print a test pattern and return to this screen] check box, and then click

[Next >]. A registration test pattern is printed and the dialog box displayed in step E] .

=l Reference

e Opening from the Start Menu a4

e Opening from an Application |
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Adjust Paper Feed

If horizontal lines are printed unaligned or print images are patchy, print a test pattern, and then adjust the paper feed
setting.

e To check the printed test pattern, proceed to step E] .

E] Open the printer properties dialog box.

E] Click the [Maintenance] tab.

[3] Click [Adjust Paper Feed].

[4] Click [Next >].

[5] Check that Ad/Letter size paper is loaded in the paper tray.

[6] Click [Next >].
A test pattern to adjust paper feed is printed.

o Do not perform other operations during printing.

E] Check the optimal adjustment values on the printed test pattern.

o The optimal adjustment value is the number that appears on the left of the lightest gray square with straight horizontal lines on both

sides. When this number is "+2", the optimal adjustment value is "+2".

+6

o When horizontal lines beside the lightest gray square are broken, select the optimal adjustment value by referring to the lines broken in
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Adjust Paper Feed

the opposite direction. When the "+2" square is the lightest gray square and the "+6" horizontal lines are broken in the opposite

direction, the optimal adjustment value is between "+3" and "+5". After adjustment, check the adjustment result.

In the [Paper feed value:] box, enter the adjustment value (-14 to +14) from step [7] .

[9] Click [Finish].

o If a test pattern is not printed or the image is not clear, select the [Print a test pattern and return to this screen] check box, and then click

[Next >].

= N Reference

o Opening from the Start Menu |

e Opening from an Application ad
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Printer Driver > Maintaining the Printer Using Utilities > Restore Defaults/Other Settings

Restore Defaults/Other Settings

Follow the procedure below to restore the settings to their defaults or specify the amount of time the printer will wait
for more information from the computer sending the print data before it times out (I/O timeout).

[1] Open the printer properties dialog box.
[1] Click the [Maintenance] tab.

[3] Click [Restore Defaults/Other Settings].
The [Restore Defaults/Other Settings] dialog box appears.

=l Reference

o Opening from the Start Menu =5

o Opening from an Application ad

Related topics
Restoring the Settings to Their Defaults 73

Specifying an I/O Timeout 74
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Restoring the Settings to Their Defaults

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | | Settings | | 2]

Printer Driver > Maintaining the Printer Using Utilities > Restore Defaults/Other Settings > Restoring the Settings to Their Defaults

Restoring the Settings to Their Defaults

Follow the procedure below to restore the settings for [Adjust Print-head Positions], [Registration], [Adjust Paper
Feed], and [I/O Timeout:] to their defaults.

[1] Open the printer properties dialog box.
[1] Click the [Maintenance] tab.
[3] Click [Restore Defaults/Other Settings].

[4] Click [Restore Defaults]

A confirmation message appears.

[5] Click [OK].

o The settings currently made for [Adjust Print-head Positions], [Registration], [Adjust Paper Feed], and [I/O Timeout:] will be lost. These

settings cannot be restored.

= Reference

o Opening from the Start Menu |

o Opening from an Application ad

e Adjust Print-head Positions ad

o Registration 7d

o Adjust Paper Feed i |

o Specifying an I/O Timeout =
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Specifying an I/0 Timeout
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Printer Driver > Maintaining the Printer Using Utilities > Restore Defaults/Other Settings > Specifying an I/O Timeout

Specifying an I/0 Timeout

Follow the procedure below to specify the amount of time the printer will wait for more information from the
computer sending the print data before it times out.

[1] Open the printer properties dialog box.
[1] Click the [Maintenance] tab.

[3] Click [Restore Defaults/Other Settings].
The [Restore Defaults/Other Settings] dialog box appears.

(@] In the [Select a time period] area, select the amount of time in the [I/O Timeout:] list.

[5] Click [OK].
Even if you change the [I/O Timeout:] setting, the displayed setting remains unchanged.

=l Reference

o Opening from the Start Menu =5

e Opening from an Application ad
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Checking the Current Printer Driver Version
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Printer Driver > Checking the Current Printer Driver Version

Checking the Current Printer Driver Version

Follow the procedure below to check the version of the printer driver currently installed.
[1] Open the printer properties dialog box.
[2] Click the [Maintenance] tab.

[3] Click [About].
The [About] dialog box appears.

E] Check the version.

= B Feferens

e Opening from the Start Menu i |

e Opening from an Application b |
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Uninstalling the Printer Driver
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Printer Driver > Uninstalling the Printer Driver

Uninstalling the Printer Driver

Follow the procedure below to uninstall the current printer driver before installing the new version of the printer driver.

o The Printer Status monitor installed with the current printer driver will be uninstalled when the current printer driver is uninstalled.

o Custom settings registered are also deleted. To continue using the registered custom settings, save them as custom setting files before
uninstalling.

[1] On the [Start] menu, point to [Settings], and then click [Printers].

E] Click the icon of the printer, and then click [Delete] on the [File] menu.

[3] A confirmation message appears. Click [Yes].

The printer driver is uninstalled.
(4] After uninstalling the printer driver, restart Windows.

=l Reference

e Saving a Registered Custom Setting in a File |
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Chapter contents - - User Guide

User Guide _
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| ¢ Contents | I | Search | |

E' Printer Driver

Opening the Printer Properties Dialog Box
* Opening from the Start Menu
* For Windows 95/98/Me
* For Windows 2000, Windows NT 4.0
* For Windows XP, Windows Server 2003
* Opening from an Application
Displaying the Printer Status

# Opening the Printer Status Monitor
Using Help / Checking Bidirectional Communication
* Using Help
* Displaying an Explanation for Each Setting Item (Context Help)
* Displaying Help in a Help Window (Content Help)
# Checking Whether Bidirectional Communication is Working or Not
Maintaining the Printer Using Utilities
# Nozzle Check
# Clean Print-heads (Normal)
* Clean Print-heads (Full)
# Adjust Print-head Positions
# Registration
# Adjust Paper Feed
# Restore Defaults/Other Settings
* Restoring the Settings to Their Defaults
* Specifying an I/O Timeout
Checking the Current Printer Driver Version

Uninstalling the Printer Driver

E' T0p|
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Loading Paper
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Paper > Loading Paper

Loading Paper

Load paper into the paper tray.
Normally, load paper into tray 1. Tray 2 (optional) can be used if installed.

o Load paper with the paper grain parallel to the feed direction.

= N Reference

e Printing on Thick Paper ad

Related topics

Loading Paper into Tray 1 73

Loading Paper into Tray 2 (optional) 5
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Loading Paper into Tray 1
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| # Contents | § Previous - Next - | I | | Settings | | 2]

Paper > Loading Paper > Loading Paper into Tray 1

Loading Paper into Tray 1

Follow the procedure below to load paper into tray 1.

o Ad4/Letter size paper is loaded here.

o Load A4/Letter size paper in D (portrait) orientation.

(1] Lift the output tray.

AGKD105

o Pull tray 1 completely out. Take care not to drop it.

[3] Squeeze the paper guides on both sides, and then adjust them according to the paper size.
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Loading Paper into Tray 1

AGKING

o Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

E] Load paper with the print side face down but not over the limit mark.

AGKD125

[E] Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

AGKD13S

(6] Push tray 1 gently in until it stops.
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Loading Paper into Tray 1

[7] Lower the output tray.

Related topics
Loading Paper Larger than A4/Letter (Trayl) ad

E' Top | 4 Previous - Next f |

AGKD145

AGKD155

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0095.htm (3 of 3)2005/10/05 12:04:32



Loading Paper Larger than A4/Letter (Trayl)
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Paper > Loading Paper > Loading Paper into Tray | > Loading Paper Larger than A4/Letter (Trayl)

Loading Paper Larger than A4/Letter (Tray1)

Follow the procedure below to use the paper tray extension for paper larger than A4/Letter size, such as A3/11" x 17"
size paper.

e A3/11" x 17" size paper is loaded here.

e Load A3/11" x 17" size paper in L (portrait) orientation.

(1] Lift the output tray.

AGKD10S

o Pull tray 1 completely out. Take care not to drop it.
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Loading Paper Larger than A4/Letter (Trayl)

[3] Slide the tabs on both sides of the tray's interior to the unlocked position.

AGKD18S

E] Pull out the paper tray extension.

AGKDITS

E] Slide the tabs back into place to lock the paper tray extension into position.

AGKD185

E] Squeeze the paper guide release, and then slide the paper guides into position according to the paper
size.
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Loading Paper Larger than A4/Letter (Trayl)

AGKD195

o Do not use the paper tray extension for A4 (Letter) size paper or smaller paper. Use it only for long paper.

E] Load paper with the print side face down but not over the limit mark.

AGKI21S

(9] Push tray 1 gently in until it stops.
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Loading Paper Larger than A4/Letter (Trayl)

AGKIZ2S

AGKN2IS

[11] Pull out the output tray extension.
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Paper > Loading Paper > Loading Paper into Tray 2 (optional)

Loading Paper into Tray 2 (optional)

Follow the procedure below to load paper into tray 2 (optional).

e You can load plain paper and inkjet plain paper in tray 2 (optional).
o Ad/Letter size paper is loaded here.

o Load A4/Letter size paper in L (portrait) orientation.

[1] Hold the grip on tray 2 (optional), lift the tray slightly, and then pull it out.

AGKOTZE

o Pull tray 2 (optional) completely out. Take care not to drop it.

[1] Lift off the cover.

ACHOTEE
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Loading Paper into Tray 2 (optional)

E] Load paper print side down, and then adjust the paper guide to the paper size.

AGKITSS

e To load 250 or more sheets of paper, first load about 200 sheets, and then load the remaining sheets, making sure the paper does not

exceed the limit mark.

[E] Re-attach the cover.

AGKOTES
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Loading Paper into Tray 2 (optional)

[6] Push tray 2 (optional) gently in until it stops.

AGHRITTS

Related topics
Loading Paper Larger than A4/Letter (Tray2) ad
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Loading Paper Larger than A4/Letter (Tray2)
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Paper > Loading Paper > Loading Paper into Tray 2 (optional) > Loading Paper Larger than A4/Letter (Tray?2)

Loading Paper Larger than A4/Letter (Tray2)

Follow the procedure below to use the paper tray extension for paper larger than Ad/Letter size, such as Legal/8 1/," x

14" size paper.

[1] Hold the grip on tray 2 (optional), lift the tray slightly, and then pull it out.

AGKOTZE

o Pull tray 2 (optional) completely out. Take care not to drop it.

Lift off the cover.

ACHATEE

[3] Slide the tabs on both sides of the tray's interior to the unlocked position.
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Loading Paper Larger than A4/Letter (Tray2)

AGKDTES

AGKOTES

[5] Slide the tabs back into place to lock the paper tray extension into position.

AGHOBIS

[6] Load paper print side down, and then adjust the paper guide to the paper size.
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Loading Paper Larger than A4/Letter (Tray2)

o Do not use the paper tray extension for A4 (Letter) size paper or smaller paper. Use it only for long paper.

e To load 250 or more sheets of paper, first load about 200 sheets, and then load the remaining sheets, making sure that the paper does not

exceed the limit mark.

E] Re-attach the cover.

Push tray 2 (optional) gently in until it stops.

AGHRITTS
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Paper > Compatible Paper

Compatible Paper

Before printing, check the paper types compatible with this printer.

Related topics
Compatible Paper Types 73

Compatible Paper Sizes 7

Paper Handling Precautions 73

Printable Area 7
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Compatible Paper Types

You can use various types of paper.
o Plain paper

This paper is normally used for copying and printing. Unlike inkjet plain paper or semi-gloss photo paper, it is
uncoated.

o Inkjet plain paper

This extra-white plain paper makes the printed colors appear more vivid. Since it does not have an ink-
absorbent coating, you can write on it and use it for photocopying, just like regular plain paper.

o Semi-gloss photo paper
This machine prints best on reduced-reflection glossy photo paper.

Paper for dye inks is not recommended because the machine's pigmented inks may not take properly to it or
may smear or rub off. Glossy photo paper can be used in this machine provided it is compatible with pigmented
inks.

o Inkjet transparency

Transparency film for equipment such as overhead projectors is designed for the pigmented inks used by the
machine. Film for plain paper copiers cannot be used because it does not absorb ink. Film for dye inks is not
recommended because the machine's pigmented inks may not take properly to it or may smear or rub off.
Transparency film can be used in this machine provided it is compatible with pigmented inks.

o Envelopes

For details about the types of envelope that can be used, see Paper Handling Precautions. Paper Handling
Precautions a1

o Thick paper
For details about the types of thick paper that can be used, see Paper Handling Precautions. Paper Handling
Precautions a1

o All types of paper besides thick paper can be loaded in tray 1.

e You can load plain paper and inkjet plain paper in tray 2 (optional).

= B Feferen=s

e Printing on Various Paper Types i |

e Paper Handling Precautions i |

Q Maximum Paper Feed and Output Capacity for Different Paper Types

Maximum paper feed and output capacity depends on paper type. This section lists the maximum paper feed and
output capacities for different paper types.

Plain Paper
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Compatible Paper Types

e Maximum paper capacity
250 sheets

e Maximum paper output capacity
150 sheets

Semi-gloss photo paper
e Maximum paper capacity
20 sheets

e Maximum paper output capacity
20 sheets

Inkjet Transparencies
e Maximum paper capacity
1 sheet

e Maximum paper output capacity
3 sheets

Envelopes
e Maximum paper capacity
30 sheets

e Maximum paper output capacity
30 sheets
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Compatible Paper Sizes

You can use various sizes of paper.
Tray 1
Standard Sizes

o A3[J (portrait)

o A4l (portrait)

o AS[Y (landscape)

o A6D (portrait)

o B4l) (portrait)

e B3[ (portrait)

o ExecutivelJ (portrait) (184.2 x 266.7 mm (7.3 x 10.5 inches))
o FLJ (portrait) (203.2 x 330.2 mm (8.0 x 13.0 inches))

o Foolscap (F4) D(portrait) (215.9 x 330.2 mm (8.5 x 13.0 inches))
¢ Foliol/ (portrait) (209.5 x 330.2 mm (8.3 x 13.0 inches))

o 11" x 17" (portrait)

o Letter) (portrait)

e Legalld (portrait)

e 51/2" x 8 1/2"[F (landscape)

o 16K[J (portrait) (195 x 267mm (7.7 x 10.6 inches))

Custom paper sizes
o Custom paper sizes: 139.7-431.8mm (length) x 90-305mm (width), (5.5-17.0 inches (length) x 3.6-
12.0 inches (width))
Envelopes

e ComlO (104.8 x 241.3 mm (4.2 x 9.5 inches))
e Monarch (98.4 x 190.5 mm (3.9 x 7.5 inches))
e C6 (114 x 162 mm (4.5 x 6.4 inches))

e C5(162 x 229 mm (6.4 x 9.1 inches))

e DL Env (110 x 220 mm (4.4 x 8.7 inches))

Tray 2(optional)
Standard Sizes

o A4 (portrait)

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0101.htm (1 of 3)2005/10/05 12:04:40


javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();

Compatible Paper Sizes

o B5[/ (portrait)

o ExecutivelJ (portrait) (184.2 x 266.7 mm (7.3 x 10.5 inches))

o F[J (portrait) (203.2 x 330.2 mm (8.0 x 13.0 inches))

e Foolscap (F4HD (portrait) (215.9 x 330.2 mm (8.5 x 13.0 inches))
e FoliolJ (portrait) (209.5 x 330.2 mm (8.3 x 13.0 inches))

o Letterl) (portrait)

e Legall} (portrait)

o 16K[J (portrait) (195 x 267mm(7.7 x 10.6 inches))

Custom paper sizes
o Custom paper sizes: 210-356mm (length) x 148-216mm (width), (8.3-14.0 inches (length) x 5.9-
8.5 inches (width))

Bypass tray
Standard Sizes

o 12" x 18"L) (Portrait)

o A3D) (Portrait)

o A4 (portrait)

e A5 (landscape)

o AGL (portrait)

o B4l (portrait)

e B5D (portrait)

o ExecutivelJ (portrait) (184.2 x 266.7 mm (7.3 x 10.5 inches))
o FL) (portrait) (203.2 x 330.2 mm (8.0 x 13.0 inches))

e Foolscap (F4)[J (portrait) (215.9 x 330.2 mm (8.5 x 13.0 inches))
o FoliolJ (portrait) (209.5 x 330.2 mm (8.3 x 13.0 inches))

o 11" x 17"l (portrait)

o Letter) (portrait)

e Legalld (portrait)

e 51/," x 8 1/,"[3 (landscape)

o 16K[J (portrait) (195 x 267mm (7.7 x 10.6 inches))

Custom paper sizes

o Custom paper sizes: 139.7-1295.4mm (Iength) x 90-305mm (width), (5.5-51.0 inches (lengths) x
3.6-12.0 inches (width))

Envelopes

e ComlO (104.8 x 241.3 mm (4.2 x 9.5 inches))
e Monarch (98.4 x 190.5 mm (3.9 x 7.5 inches))
e C6 (114 x 162 mm (4.5 x 6.4 inches))
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Compatible Paper Sizes

o C5(162 x229 mm (6.4 x 9.1 inches))
e DL Env (110 x 220 mm (4.4 x 8.7 inches))
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Paper Handling Precautions

To ensure optimum print results, take care when handling paper before and after printing.

Loading precautions

o Use compatible paper.

o Load paper with the print side face down in the paper trays.

o Load paper with the paper grain parallel to the feed direction.

e Do not load paper of different types at the same time.

o To load a different type of paper than that already loaded, first remove all currently loaded paper.

e Do not stack paper over the limit mark.

AGKD2S

o Curled paper may jam. Straighten any curls before loading.

-

o Before loading envelopes, make sure their edges are sharply creased by rubbing the edges with a pen or
similar object.
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Paper Handling Precautions

.. WA N
’_’z 72

o When using the bypass tray, make sure the envelope or sheet of paper is between the top and bottom of
the bypass tray guides.

AGHKDEAS

Paper storage precautions

e Do not store paper in humid places.
e Do not store paper in direct sunlight.
e Store paper flat.

o Store unused paper in the original package.

Paper type precautions
Plain paper

o Use the bypass tray to print on paper heavier than 105 g/m2 (198.5 1b.).

o The only type of A6 (105 x 148 mm(4.2 x 5.9 inches)) paper that can be loaded in tray 1 is that of
105 g/m?2 (198.5 Ib.).

o After printing, some types of paper take longer than others to dry. With duplex printing, the ink
may smear or rub off. Using the printer driver, specify how long to wait for the prints to dry
between printing each side of a duplex sheet. For details, see the printer driver Help. Opening the
Printer Properties Dialog Box =3

Inkjet plain paper
e When printing on inkjet plain paper, in the printer properties dialog box, click [Inkjet Plain Paper].
This allows printing at higher quality.

o In the printer properties dialog box, when [Inkjet Plain Paper] is selected, only one-sided printing
is possible. To print on both sides of a sheet, click [Plain].

o The ink may smear depending on the type of image. If this happens, set the envelope selector to
the rear position .

o Use as soon as possible after opening the package.

Semi-gloss photo paper
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Paper Handling Precautions

o The glossy side (or the pearl side) of the paper is the printing surface.

o Handle paper by the edges so as not to dirty or leave fingerprints on the print side.

o Make sure that sheets are not badly bent or scratched, and the print side is not damaged.
e Only one-sided printing is possible.

o Before handling, make sure printed sheets have fully dried.

o If you want to stack prints soon after they are printed, we recommend inserting a moisture-
absorbent sheet, like copy paper, between prints.

e Make sure that the output tray has no more than twenty sheets stacked on it.

o Semi-gloss photo paper is designed for photograph printing. For graphics, we recommend plain or
inkjet plain paper.

o When using these sheets, see the instructions supplied with them.

Inkjet transparency
o Identify the print side by orientating the sheet vertically, so that the notched corner is at the bottom
left. The side facing you is the print side.

o Load one sheet at a time. If multiple sheets are loaded, the leading edge of transparencies may get
scratched.

o Handle sheets by the edges so as not to dirty or leave fingerprints on the print side.

e Make sure that sheets are not badly bent or scratched, and the print side is not damaged.
o Only one-sided printing is possible.

e Remove sheets from the output tray individually, as they come out.

o Before handling, make sure printed sheets have fully dried.

o If you want to stack prints soon after they are printed, we recommend inserting a moisture-
absorbent sheet, like copy paper, between prints.

o Ink takes time to dry. To prevent sheets from sticking together, remove them from the output tray
individually, as they come out.

o If printing comes out streaked, adjust the paper feed level. See Adjust Paper Feed 7.
o Use at 15-25°C (59-77°F) and 30-70% humidity.

o Use as soon as possible after opening the package.

o When using these sheets, see the instructions supplied with them.

Envelopes

o Up to 30 envelopes can be loaded in tray 1.
o If the envelopes bulge, flatten them.

o Load envelopes carefully, because the printable area depends on the orientation. See Printable Area
Al
Thick paper

e Use tray 1 to load paper lighter than 105 g/m2 (198.5 Ib.).
e You can insert paper with weights up to 163 g/m?2 (308.7 1b.) into the bypass tray.
o Insert paper with the print side face up into the bypass tray.

Cautions to Observe After Printing

Depending on the paper type, the ink may take a while to dry. Before handling, make sure printed sheets have
fully dried. otherwise, the ink may smudge.
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Paper Handling Precautions

= Reference

e Printing on Various Paper Types ad
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Printable Area

Printable and unprintable areas

1. Feed Direction
2. Printable Area

3. 3 mm (0.12 inches)

o Do not attempt to print beyond the guaranteed printable area. Paper feed precision is reduced around the printable area limits, resulting in
lower print quality.

e When printing on envelopes, the following print area limitations apply.

' ;
f L, S +° 1’
f
2 2 : 2
' ! .
! e 4 i 4
ot f T

1. Feed Direction

2. Printable Area

3. 8 mm (0.4 inches)
4. 38 mm (1.5 inches)

5. 5 mm (0.2 inches)
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Printable Area
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Paper > Non-compatible Paper

Non-compatible Paper

Check if the paper is compatible.
Do not use paper that is:
o wrinkled, folded, or damaged
e wavy at the ends
o curled
o absorbent
e dry and conducive to static buildup
o already printed on (such as the back of preprinted paper)
o preprinted (unless specified)
o heat sensitive/non-carbon
o too thick or thin
o pre-stitched
o glued or tacked
o stapled or clipped together
o dark in places

o irregular in length and proportion

o Even if compatible paper types are used, print quality may be lower than usual or paper jams may occur if the paper was improperly stored.
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_ I Paper

Loading Paper
* Loading Paper into Tray 1
* Loading Paper Larger than A4/Letter (Tray1)
# Loading Paper into Tray 2 (optional)
* Loading Paper Larger than A4/Letter (Tray2)
Compatible Paper
# Compatible Paper Types
# Compatible Paper Sizes
# Paper Handling Precautions
# Printable Area

Non-compatible Paper
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Printing Will Not Start

User Guide
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Troubleshooting > Printing Will Not Start

Printing Will Not Start

If printing will not start, check whether the power of the printer is on or whether the power can be turned on or not.

If an error occurs when you try printing, change the computer or printer driver settings.

Related topics

Power Cannot Be Turned On 73

Paper Will Not Feed Even When the Power Is On 73

An Error Occurs 7
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Power Cannot Be Turned On

User Guide
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Troubleshooting > Printing Will Not Start > Power Cannot Be Turned On

Power Cannot Be Turned On

If the [Power] key does not light or does not blink when it is pressed, check if there is something wrong with the
power cord or wall outlet.

Check the following:
o Make sure that the power plug is firmly inserted into the wall outlet.

o Check if there is something wrong with the wall outlet. Do this by connecting another electronic product whose
operation you are familiar with.

If the above steps do not solve the problem, turn the power off, pull out the power cable, and contact your sales or
service representative. See Where to Inquire 73
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Paper Will Not Feed Even When the Power Is On

User Guide
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Paper Will Not Feed Even When the Power Is On

If printing will not start even when the power is on, check if an error has occurred using the indicators or Printer Status
monitor.

I An indicator is lit or blinking

Only the [Power] key is blinking.

The printer may be receiving data or replenishing its ink. Wait momentarily for the blinking [Power] key to stop

and stay lit.

The [Resume] key or a cartridge replacement indicator is blinking or lit.

An error has occurred. See Error Indicator Summary 74.

I An error message is displayed on the Printer Status monitor.

Click [User Guide...] to display the page corresponding to the error where you can check how to solve the problem in

more detail. See Printer Status Monitor Errors &d.

i ]

A print sample can be printed using keys on the control panel to check that the printer is not out of order.

When the power is off, while holding down the [Cancel] key and the [Resume] key, press and hold down the
[Power] key for over three seconds. The cartridge replacement indicators will light once and a print sample will be
delivered.
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Troubleshooting > Printing Will Not Start > An Error Occurs

An Error Occurs

If an error occurs when you try printing, change the computer or printer properties settings.
Do the following:
o Check the printer icon name does not exceed 32 alphanumeric characters.
(If it does, shorten it.)
o Check whether other applications are operating.

Close all other applications because these could be interfering with the installation. Be sure to close all resident
programs also.

o Check the printer properties settings.
In the [Change User Settings] dialog box, on the [Misc.] tab, select the [Change data processing] check box.
For details, see Changing the Image Data Process ad.

o Check whether the latest printer driver is being used.

If the printer driver being used is not the latest one, update it with the latest version.
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Paper Is Not Fed or Delivered Normally
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Troubleshooting > Paper Is Not Fed or Delivered Normally

Paper Is Not Fed or Delivered Normally

If the printer is operating but paper will not feed or paper jams multiple times, check the condition of the printer and
paper.
I Paper does not feed smoothly.

Paper guides are not adjusted properly.

o The paper guides of the paper tray do not match the paper loaded. Adjust the paper guides and load the paper

again. See Loading Paper 7.

Paper is not loaded properly.

o The paper is not loaded properly. Load the paper correctly. See Loading Paper a1,

Paper is curled.

o Remove the loaded paper and check if it is curled. If it is, straighten the curl.

Paper that is not compatible is loaded.

o Remove the loaded paper and replace it with compatible paper. See Non-compatible Paper 7.

I Paper jams multiple times.
The guide board is not closed.

o Make sure that the guide board is closed. Remove the duplex unit and press both sides of the guide board until

it clicks closed.

Multiple sheets are inserted in the bypass tray.

o When using the bypass tray, insert paper one sheet at a time. See Printing on Thick Paper 7.

The tray 2(optional) rear cover is not closed.

e Make sure that the tray 2(optional) rear cover is closed. Press both sides of the cover until it clicks closed.
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Paper Is Not Fed or Delivered Normally

Printing densely colored images on both sides.

e When printing images containing areas of solid color that consume a lot of ink, we recommend single-sided

printing.

The paper feed roller may be misaligned.
o Take the following steps:
1. Remove jammed paper.
2. Press the [Resume] key.
3. Load paper.

4. Press the [Resume] key.

I Multiple sheets of paper are fed at one time.

Load the paper again. Remove the paper from the paper tray, fan it well, and tap it on a flat surface such as a desk to
even the edges. Check the position of the paper guides of the paper tray, and then load the paper again.

I Though a paper jam is cleared, paper does not feed.

When a paper jam occurs, clear the paper jam, and then press the [Resume] key. See Paper Jam 71,

e If an error is displayed on the Printer Status monitor, follow the instructions to solve the problem.Printer Status Monitor Errors 74,
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Troubleshooting > Paper Jam

Paper Jam

This explains how to remove a paper jam. When a paper jam error appears in the Printer Status monitor, remove the
paper from the location indicated.

o If you cannot locate paper jams or jammed paper cannot be removed easily, you can check the condition of paper from the top of the printer.

Related topics

Removing Paper Jammed in the Paper Tray (Tray 1) 73

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover) ™

Removing Paper Jammed in the Bypass Tray #d

Removing Paper Jammed under the Top Cover 7

Removing Paper Jammed around the Guide Board 23

Removing Paper Jammed in the Duplex Unit 73

Removing Paper Jammed in the Output Tray 7
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Removing Paper Jammed in the Paper Tray (Tray 1)

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | T—— | Settings | | 2]

Troubleshooting > Paper Jam > Removing Paper Jammed in the Paper Tray (Tray 1)

Removing Paper Jammed in the Paper Tray (Tray 1)

Follow the procedure below to remove paper jammed in tray 1.

(1] Lift the output tray.

(2] Pull out tray 1.

o Pull tray 1 completely out. Take care not to drop it.

[3] Remove jammed paper.

o If you cannot remove the jammed paper or it is difficult to remove, the paper may be jammed inside the printer. Examine the paper

carefully and remove.

o If you cannot locate jammed paper, it may be jammed inside the printer.

(4] Push tray 1 gently in until it stops.
(5] Lower the output tray.

[6] Press the [Resume] key.

Printing starts.
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Removing Paper Jammed in the Paper Tray (Tray 1)

o Blank paper may be delivered after printing resumes.

= B Feferen=s

e Removing Paper Jammed around the Guide Board #d

e Paper Is Not Fed or Delivered Normally i |
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Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Follow the procedure below to remove paper jammed in tray 2 (optional).

(1] Hold the grip on tray 2 (optional), lift the tray slightly, and then pull it out.

o Pull tray 2 (optional) completely out. Take care not to drop it.

[2] Lift off the cover.

E] Remove jammed paper.

(4] Re-attach the cover.

[5] Push tray 2 (optional) gently in until it stops.

[6] Press the [Resume] key.

Printing starts.

e Blank paper may be delivered after printing resumes.

If you cannot locate paper jammed in tray 2 (optional), follow the procedure below to remove the paper jammed.
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Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

E] While pushing the tabs on both sides of the tray 2 (optional) rear cover toward the inside, open the tray
2 (optional) rear cover.

[2] Remove jammed paper.

[3] Close the tray 2 (optional) rear cover.

o Press both sides of the cover until it clicks closed.

(4] Press the [Resume] key.

Printing starts.

o Blank paper may be delivered after printing resumes.

= Reference

e Paper Is Not Fed or Delivered Normally |

|| Top | 4 Previous - Next f |
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Removing Paper Jammed in the Bypass Tray
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Bypass Tray

Removing Paper Jammed in the Bypass Tray

Follow the procedure below to remove paper jammed in the bypass tray.

[1] Remove jammed paper.

[2] Press the [Resume] key.

o The [Resume] key stops blinking and stays lit.

E] Insert a sheet of paper into the bypass tray with the print side face up.
Printing starts when you push in the paper.

Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when cleaning
finishes.

y ' |mportant

e When using the bypass tray, make sure the sheet of paper is between the top and bottom of the bypass tray guides.
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Removing Paper Jammed in the Bypass Tray

AGKDEAS

o Paper can only be inserted one sheet at a time.

o Support the sheet with your hands to keep it from sliding out and dropping.

o Insert the sheet straight into the bypass tray.

If it is difficult to remove jammed paper, follow the procedure below to remove it.

[1] Unlock the duplex unit at the back of the machine by raising the levers on its sides. Then, detach the
duplex unit.

[2] Remove jammed paper.
[3] Reinstall the duplex unit in its original position.

(4] Press the [Resume] key.

o The [Resume] key stops blinking and stays lit.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/t0003.htm (2 of 3)2005/10/05 12:04:54



Removing Paper Jammed in the Bypass Tray

[E] Insert a sheet of paper into the bypass tray with the print side face up.
Printing starts when you push in the paper.

Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when cleaning
finishes.

y o Important

e When using the bypass tray, make sure the sheet of paper is between the top and bottom of the bypass tray guides.

AGKDEAS

o Paper can only be inserted one sheet at a time.
o Support the sheet with your hands to keep it from sliding out and dropping.
o Insert the sheet straight into the bypass tray.

= B Feferens

e Paper Is Not Fed or Delivered Normally i |

|| Top | 4 Previous - Next i |
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Removing Paper Jammed under the Top Cover
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Troubleshooting > Paper Jam > Removing Paper Jammed under the Top Cover

Removing Paper Jammed under the Top Cover

Follow the procedure below to remove paper jammed under the top cover.

[1] Open the top cover.
[2] If the carriage stops in the middle, move it to whichever side is easier to move it to.

[3] Remove jammed paper.

o Take care not to snag the sleeves of your clothing on the cord.

o Do not touch the feed belt.

[4] Close the top cover.

[5] Press the [Resume] key.

Printing starts.

e Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.

|| Top | 4 Previous - Next f |
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Removing Paper Jammed under the Top Cover
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Removing Paper Jammed around the Guide Board
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Troubleshooting > Paper Jam > Removing Paper Jammed around the Guide Board

Removing Paper Jammed around the Guide Board

Follow the procedure below to remove paper jammed around the guide board.

[1] Unlock the duplex unit at the back of the machine by raising the levers on its sides. Then, detach the
duplex unit.

[2] Unlock the guide board by moving the tabs on both sides toward the middle, and then open the guide
board.

[3] Turn the paper feed wheel to release paper from the feed belt.

Release paper from the roller to make it removable.

[E] Insert your finger between the paper and the roller, and then remove the paper slowly.

e Do not touch the feed belt.

[5] Close the guide board.

o Push the PUSH area on both sides of the guide board until it firmly closes.

[6] Reinstall the duplex unit in its original position.

[7] Press the [Resume] key.

Printing starts.
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Removing Paper Jammed around the Guide Board

e Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.

= B Feferen=s

e Paper Is Not Fed or Delivered Normally #d

|| Top | 4 Previous - Next i |
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Duplex Unit

Removing Paper Jammed in the Duplex Unit

Follow the procedure below to remove paper jammed in the duplex unit.

[I] Press the duplex unit cover button at the center of the bypass tray, and then open the duplex unit cover.
[2] Remove jammed paper.
[3] Close the duplex unit cover.

(4] Press the [Resume] key.

Printing starts.

e Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.

|| Top | 4 Previous - Next f |
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Removing Paper Jammed in the Output Tray
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Output Tray

Removing Paper Jammed in the Output Tray

Follow the procedure below to remove paper jammed in the output tray.

[1] Remove jammed paper.

[2] Press the [Resume] key.

Printing starts.

e Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.
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Print Results Are Not Satisfactory
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Troubleshooting > Print Results Are Not Satisfactory

Print Results Are Not Satisfactory

If there is a problem with the quality of the printing such as dirty or faint and patchy prints, first check the condition of
the printer.

Check the following:

I Does the envelope selector setting match?

Set the envelope selector according to the type of paper. For envelopes, set the lever to the rear position &, for

everything else, set the lever to the forward position D See Printing on Various Paper Types 7d.

I Has the printer not been used for a long time?

The ink may be dry or the nozzles of the print-heads may be clogged. Print the nozzle check test pattern and clean the

print-heads as necessary. See Nozzle Check 73 and Clean Print-heads (Normal) 7.

I Has the nozzle check test pattern been printed?

Print the nozzle check test pattern and check whether the print-heads are clogged. Clean the print-heads as necessary.

See Nozzle Check 73 and Clean Print-heads (Normal) 3.

I Have the print-heads been aligned?

If the image is fuzzy or lines are doubled, align the print-heads. If the problem persists, print the nozzle check test

pattern and clean the print-heads as necessary. See Adjust Print-head Positions &3, Nozzle Check 7, and Clean Print-

heads (Normal) 3.

I Is there a problem with the printer's location?

Make sure that the printer is level. Place the printer in a location where it will not be subject to shaking or excessive

force.

Related topics
Printing Is Uneven, Too Heavy, or Too Light 3

Dirty or Blotted Prints a3
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Printing Is Uneven, Too Heavy, or Too Light
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Troubleshooting > Print Results Are Not Satisfactory > Printing Is Uneven, Too Heavy, or Too Light

Printing Is Uneven, Too Heavy, or Too Light

If there is a problem with the quality of the printing such as uneven printing or an inappropriate amount of ink being
used, the following questions should be addressed.

I Is an old Print cartridge being used?

Print cartridges should be opened before their expiration date and used within six months of being opened.

I Does the paper type setting match?

Make sure that the paper type setting of the printer driver matches the type of paper loaded. See Printing on Various

Paper Types #d.
I Are you printing on the wrong side of the paper?

Check which side should be printed on when using inkjet plain paper. If you print on the wrong side, the quality of the

printing may be lower and the inside of the printer may get dirty. See Paper Handling Precautions 1.

I Is the setting of the envelope selector suitable?

The printed side may become worn depending on the type of image. If this happens, set the envelope selector to the
rear position .

I Is the brightness of the image suitable?

If the printing is being smeared even when the envelope selector is set to the rear position B, the density of the

printing may be too high. Increase the brightness of the image.

I Is the [Duplex/Booklet] check box selected?

Duplex printing tends to produce fainter prints than single-sided printing. When performing single-sided printing,

make sure the [Duplex/Booklet] check box is not selected.

|| Top | 4 Previous - Next f |
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Dirty or Blotted Prints
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Troubleshooting > Print Results Are Not Satisfactory > Dirty or Blotted Prints

Dirty or Blotted Prints

If prints are dirty or blotted, the following questions should be addressed.

I Is the paper being used too thick or thin?

Check if the paper is compatible. If extremely thick or thin paper is used, the print-heads will rub the paper and ink

will leak. See Compatible Paper 7.

I Does the print-heads rub when plain paper is used?

Set the envelope selector to the rear position E.

I Have you touched the printed side of paper?

Avoid touching the printed side of paper. Particularly, avoid touching semi-gloss photo paper and inkjet transparency
that have just been printed because these require longer than normal to dry. Remove them one at a time from the

output tray without touching the printed side, and then let them dry fully. See Paper Handling Precautions #3.

I Is the inside of the printer dirty?

If the leading edge or back side of printed paper is dirty, the inside of the printer may be dirty. Also, if black vertical
lines appear on the printed side of paper, the delivery rollers may be dirty. Turn the power off, and then while pressing
the [Resume] key, press and hold down the [Power] key for over three seconds. A blank sheet of paper will be

delivered to clean the delivery rollers. Repeat this operation multiple times.

I Is the paper loaded in the correct orientation?

Some paper cannot be loaded lengthwise depending on the size of the paper. Check the orientation in which the paper

is loaded. See Compatible Paper Sizes 7.

I Is a genuine Print cartridge being used?

Using a cartridge other than a genuine Print cartridge or using a cartridge refilled with ink will lower the print quality

and could cause a breakdown. Use a genuine Print cartridge. See Recommended Consumables 7.

I Are you printing densely colored images on both sides of paper?

When a large amount of ink is used to completely cover a side, one-sided printing is recommended.
When duplex printing, after printing one side of a sheet, does the machine wait for the ink to dry before
printing the other side?

Depending on type of paper, prints may require more time to dry properly and so may smear or rub off. Using the
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Dirty or Blotted Prints

printer driver, specify how long to wait for the prints to dry between printing each side. For details, see the printer

driver Help.Opening the Printer Properties Dialog Box ad
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Print Results Do Not Match the Displayed Image
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Troubleshooting > Print Results Do Not Match the Displayed Image

Print Results Do Not Match the Displayed Image

If there are differences between the print results and the displayed image, first check the printer driver.
Check the following:

I Does the printer driver of the printer support the application used?

Check if an application other than a Windows operating system application is being used.

I Is the printer driver of the printer being used?

Make sure that the printer you want to use for printing is selected. See Opening from an Application 7.

I Does data from a failed print job or canceled print job remain in memory?

Check whether data from a failed print job or canceled print job remains in memory. See Canceling Printing 71.

Related topics
Characters and Colors Do Not Match the Displayed Image 73

Positions Do Not Match the Displayed Image 73
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Characters and Colors Do Not Match the Displayed Image
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Troubleshooting > Print Results Do Not Match the Displayed Image > Characters and Colors Do Not Match the Displayed Image

Characters and Colors Do Not Match the Displayed Image

If there are differences between the characters and colors of the print results and the displayed image, the following
questions should be addressed.

I Has the hue of colors been adjusted?
Since printed colors and screen colors are produced by different methods, a color printed and a color displayed on a
screen can have different hues even though they are the "same" color. Use the color matching function to make the

hue of printed colors and displayed colors closer. See Changing the Color Profiling Pattern &,

I Has the nozzle check been performed?

The print-heads may be clogged and the amount of ink may not be able to be regulated. Print the nozzle check test

pattern and clean the print-heads as necessary. See Clean Print-heads (Normal) & and Nozzle Check &1,

I Was printing done in black and white?

Check the color setting of the application and the color print setting of the printer driver. See Printing in Black and

White 23.

I Have the print quality settings been made?

Set the printing resolution to an appropriate level. See Printing Using Preset Print Quality Settings 7.

I Does the paper type setting match?

Make sure that the paper type setting of the printer driver matches the type of paper loaded. See Printing on Various

Paper Types 7.
I Have you tried printing with inkjet plain paper?

Try printing with inkjet plain paper. The print results should be clearer. See Printing on Various Paper Types &1,

Q Changing the printer driver setting
You may eliminate certain problems by changing the printer driver settings as described below:
o Cannot print certain data properly when using a certain application, or cannot print image data properly.

In the [Print Quality] area, select [Standard (quality priority)] or [High quality], and then print. See Printing
Using Preset Print Quality Settings 73.

In the [Change User Settings] dialog box, on the [Image Adjustments] tab, under [Dithering], deselect the
[Use error diffusion] check box. See Using Error Diffusion 7d.

Set [Spool format:] to [RAW] or [EMF] in the [Printer Configuration] dialog box.
In the [Change User Settings] dialog box, on the [Image Adjustments] tab, under [Image processing

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0122.htm (1 of 2)2005/10/05 12:05:04


javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();

Characters and Colors Do Not Match the Displayed Image

priority], deselect the [Adjust photos and images] and [Smooth low resolution images] check boxes. See
Correcting the Hue of Digital Photos 7 and Printing Low Resolution Images Smoothly 7.

In the [Change User Settings] dialog box, on the [Misc.] tab, select the [Print as bitmap] check box. See
Printing a Whole Page as an Image 7.

e Some characters are garbled or missing.

In the [Change User Settings] dialog box, on the [Misc.] tab, select the [Change methods to extract
TrueType fonts] check box. See Changing the Method of Extracting TrueType Fonts 7.

In the [Printer Configuration] dialog box, set [Spool format:] to [EMF]. In the [Change User Settings]
dialog box, on the [Misc.] tab, select the [Print as bitmap] check box. See Printing a Whole Page as an

Image #3.
o Some characters are printed faintly or not printed.

In the [Print Quality] area, select [High quality] or [Standard (quality priority)], and then print. See Printing
Using Preset Print Quality Settings #d.

In the [Change User Settings] dialog box, on the [Image Adjustments] tab, under [Dithering], deselect the
[Use error diffusion] check box. See Using Error Diffusion #4.

o Printing is slow and takes time, which delays release of the application.

In the [Print Quality] area, select [High quality] or [Standard (quality priority)], and then print. See Printing
Using Preset Print Quality Settings 7.

In the [Printer Configuration] dialog box, set [Spool format:] to [EMF].

In the [Change User Settings] dialog box, on the [Image Adjustments] tab, under [Image processing
priority], deselect the [Adjust photos and images] and [Smooth low resolution images] check boxes. See
Correcting the Hue of Digital Photos #3.

Close the resident application.
o Printing stops halfway.

View the status monitor to check whether an error has occurred. See Printer Status Monitor Errors 7.

To print on preprinted or prepunched paper, select the [Use preprinted/prepunched paper] check box in the
[Printer Configuration] dialog box.
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Troubleshooting > Print Results Do Not Match the Displayed Image > Positions Do Not Match the Displayed Image

Positions Do Not Match the Displayed Image

If the position of printed items differs from the position of displayed items, the following questions should be
addressed.

I Have the settings for page layout been made?

Check whether page layout settings have been made with the application.

I Does the paper size setting match?

Make sure that the paper size selected in the [Printout paper size:] list of the printer properties dialog box matches the
size of the paper loaded.

I Does the envelope selector setting match?

Set the envelope selector according to the type of paper. For envelopes, set the lever to the rear position EJ; for

everything else, set the lever to the forward position D See Printing on Various Paper Types 7d.

I Have the print-heads been aligned?

When bidirectional printing is performed, and lines and characters are blurred, align the print-heads. If the problem

persists, print the nozzle check test pattern and clean the print-heads as necessary. See Adjust Print-head Positions 71,

Nozzle Check 73, and Clean Print-heads (Normal) 73
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Troubleshooting > Printer Status Monitor Does Not Open

Printer Status Monitor Does Not Open

If the Printer Status monitor does not open for a shared printer, the following questions should be addressed.

I Are the share settings correct?

Check the share settings of the printer. The printer driver must also be installed on the client computer. See Setting Up

a Server ad and Setting Up a Client Computer 7.

I Does your Web browser support Printer Status Monitor?

Internet Explorer version 4.0 or later is required to display Printer Status Monitor and the dialog boxes displayed from

the [Maintenance] tab of the printer driver.
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Printer Status Monitor Errors
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Troubleshooting > Printer Status Monitor Errors

Printer Status Monitor Errors

If an error occurs with the printer, Printer Status Monitor displays an error message. Click [User Guide...] to display
the page corresponding to the error where you can check how to solve the problem in more detail.

Related topics

No Response from Printer 23

No Paper/Tray Not Detected (Bypass Tray) 74

No Paper/Tray Not Detected (Tray 1) 73

No Paper/Tray Not Detected (Tray 2) 73

Paper Size Mismatch (Bypass Tray) ad

Paper Size Mismatch (Tray 1) 23

Paper Size Mismatch (Tray 2) 73

Cover Open 73
Duplex Unit Not Detected d

Cover Open / Print Cartridge(s) Not Detected 7

Paper in Bypass Tray 73

Cartridge End 23
Cartridge/Print-head Tank Empty 71

Out of Printable Temperature Range ad

When the Internal Unit is Almost Full 73

Printer Error 23
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No Response from Printer
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Troubleshooting > Printer Status Monitor Errors > No Response from Printer

No Response from Printer

Follow the procedure below to check the port settings and the connection between the printer and computer.
E] Check that the power of the printer is on.
E] Make sure that the computer and printer are properly connected using a USB cable.
[3] Open the printer properties dialog box.
[4] Click the [Ports] tab.

[5] Check that USB is selected in the [Print to the following port:] list.

o Under Windows 98/Me, check that USB is selected in the list on the [Details] tab.

= B Feferens

e Opening from the Start Menu i |
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No Paper/Tray Not Detected (Bypass Tray)
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Troubleshooting > Printer Status Monitor Errors > No Paper/Tray Not Detected (Bypass Tray)

No Paper/Tray Not Detected (Bypass Tray)

If no paper is ready to be fed in the bypass tray, this message appears. Follow the procedure below to insert paper into
the bypass tray.

E] Slide the bypass tray guides into position according to the paper size.

AGKD2ES

E] Insert a sheet of paper into the bypass tray with the print side face up.

AGKORES
Printing starts when you push in the paper.
Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when cleaning
finishes.

¥ d |mportant

e When using the bypass tray, make sure the envelope or sheet of paper is between the top and bottom of the bypass tray guides.
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No Paper/Tray Not Detected (Bypass Tray)

AGKDEAS

o Paper can only be inserted one sheet at a time.
o Support the sheet with your hands to keep it from sliding out and dropping.

o Insert the sheet straight into the bypass tray.
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Troubleshooting > Printer Status Monitor Errors > No Paper/Tray Not Detected (Tray 1)

No Paper/Tray Not Detected (Tray 1)

No paper is loaded in tray 1 or paper is not loaded properly. Follow the procedure below to load paper properly.

(1] Lift the output tray.

AGKD10S

o Pull tray 1 completely out. Take care not to drop it.

[3] Squeeze the paper guides on both sides, and then adjust them according to the paper size.
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No Paper/Tray Not Detected (Tray 1)

AGKING

o If paper is already loaded, remove it from the paper tray, fan it well, and tap it on a flat surface such as a desk to even the edges. Check

that the position of the paper guides and the front end guide match the paper size.

o Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

[4] Load paper with the print side face down but not over the limit mark.

AGKD125

AGKD135

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/t0010.htm (2 of 4)2005/10/05 12:05:11



No Paper/Tray Not Detected (Tray 1)

(6] Push tray 1 gently in until it stops.

AGKD145

AGKD15S

Printing starts.
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No Paper/Tray Not Detected (Tray 2)
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Troubleshooting > Printer Status Monitor Errors > No Paper/Tray Not Detected (Tray 2)

No Paper/Tray Not Detected (Tray 2)

No paper is loaded in tray 2 (optional) or paper is not loaded properly. Follow the procedure below to load paper
properly.

[1] Hold the grip on tray 2 (optional), lift the tray slightly, and then pull it out.

AGKOTZE

o Pull tray 2 (optional) completely out. Take care not to drop it.

Lift off the cover.

ACHATEE

E] Load paper print side down, and then adjust the paper guide to the paper size.
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No Paper/Tray Not Detected (Tray 2)

o If paper is already loaded, remove it from the paper tray, fan it well, and tap it on a flat surface such as a desk to even the edges. Check

that the position of the paper guides and the front end guide match the paper size.

e To load 250 or more sheets of paper, first load about 200 sheets, and then load the remaining sheets, making sure that the paper does not

exceed the limit mark.

AGKLTSS

AGKOTER
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No Paper/Tray Not Detected (Tray 2)

(5] Push tray 2 (optional) gently in until it stops.

E] Press the [Resume] key.

Printing starts.

=l Reference

e Loading Paper Larger than A4/Letter (Tray2) |

|| Top | 4 Previous « Next fp |
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Paper Size Mismatch (Bypass Tray)
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Troubleshooting > Printer Status Monitor Errors > Paper Size Mismatch (Bypass Tray)

Paper Size Mismatch (Bypass Tray)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper
size in the printer properties settings.

E] Open the printer properties dialog box from the application.
[2] Click the [Page Settings] tab.

[3] In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the
paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

o If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then select

the correct sizes.

o If paper of the incorrect size is loaded, proceed to the next step.

E] Slide the bypass tray guides into position according to the paper size.

AGKI25S

[5] Insert a sheet of paper into the bypass tray with the print side face up.
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Paper Size Mismatch (Bypass Tray)

AGKORES
Printing starts when you push in the paper.
Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when cleaning
finishes.

y o |mportant

e When using the bypass tray, make sure the envelope or sheet of paper is between the top and bottom of the bypass tray guides.

AGKDEAS

o Paper can only be inserted one sheet at a time.

o Support the sheet with your hands to keep it from sliding out and dropping.

o Insert the sheet straight into the bypass tray.

= B Feferen=s

e Opening from an Application ad

o Canceling Printing #d

|| Top | 4 Previous - Next |
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Paper Size Mismatch (Tray 1)
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Troubleshooting > Printer Status Monitor Errors > Paper Size Mismatch (Tray 1)

Paper Size Mismatch (Tray 1)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper
size in the printer properties settings.

o Ad4/Letter size paper is loaded here.

o Load A4/Letter size paper in D (portrait) orientation.

(1] Open the printer properties dialog box from the application.
Click the [Page Settings] tab.

[3] In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the
paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

o If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then select

the correct sizes.

If paper of the incorrect size is loaded, proceed to the next step.

(4] Lift the output tray.

AGKDOIS

(5] Pull out tray 1.
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Paper Size Mismatch (Tray 1)

AGKD105

o Pull tray 1 completely out. Take care not to drop it.

[6] Remove loaded paper.

[7] Squeeze the paper guides on both sides, and then adjust them according to the paper size.

AGKI115

o The front end paper guide may also need to be adjusted.

Load paper with the print side face down but not over the limit mark.
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Paper Size Mismatch (Tray 1)

AGKD125

E] Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

AGKD13S

Push tray 1 gently in until it stops.

AGKD145

[11] Lower the output tray.
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Paper Size Mismatch (Tray 1)

AGKD155

[12] Press the [Resume] key.

Printing starts.

= B Feferens

e Opening from an Application i |

o Canceling Printing 7

|| Top | 4 Previous - Next fp |
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Troubleshooting > Printer Status Monitor Errors > Paper Size Mismatch (Tray 2)

Paper Size Mismatch (Tray 2)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper
size in the printer properties settings.

o Ad4/Letter size paper is loaded here.

o Load A4/Letter size paper in (portrait) orientation.

E] Open the printer properties dialog box from the application.
Click the [Page Settings] tab.

E] In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the
paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

o If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then select

the correct sizes.

If paper of the incorrect size is loaded, proceed to the next step.

(4] Hold the grip on tray 2 (optional), lift the tray slightly, and then pull it out.

AGKOTZE

o When the output tray is lifted, tray 2 (optional) will pop out slightly. Pull tray 2 (optional) completely out. Take care not to drop it.

E] Lift off the cover.
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Paper Size Mismatch (Tray 2)

ACHOTES
[6] Remove loaded paper.

E] Load paper print side down, and then adjust the paper guide to the paper size.

e To load 250 or more sheets of paper, first load about 200 sheets, and then load the remaining sheets, making sure that the paper does not

exceed the limit mark.

Load paper with the print side face down but not over the limit mark.

AGKITSS
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Paper Size Mismatch (Tray 2)

E] Re-attach the cover.

AGKOTES

Push tray 2 (optional) gently in until it stops.

AGHITTS

@ Press the [Resume] key.

Printing starts.

=} Feference
e Loading Paper Larger than A4/Letter (Trayl) i |

e Opening from an Application =i |
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e Canceling Printing 2
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I Troubleshooting

Printing Will Not Start
# Power Cannot Be Turned On
# Paper Will Not Feed Even When the Power Is On
# An Error Occurs
Paper Is Not Fed or Delivered Normally
Paper Jam
# Removing Paper Jammed in the Paper Tray (Tray 1)
# Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)
# Removing Paper Jammed in the Bypass Tray
# Removing Paper Jammed under the Top Cover
# Removing Paper Jammed around the Guide Board
; Removing Paper Jammed in the Duplex Unit
# Removing Paper Jammed in the Output Tray
Print Results Are Not Satisfactory
# Printing Is Uneven, Too Heavy, or Too Light
# Dirty or Blotted Prints
Print Results Do Not Match the Displayed Image
# Characters and Colors Do Not Match the Displayed Image

# Positions Do Not Match the Displayed Image
Printer Status Monitor Does Not Open

Printer Status Monitor Errors
# No Response from Printer
# No Paper/Tray Not Detected (Bypass Tray)
# No Paper/Tray Not Detected (Tray 1)
# No Paper/Tray Not Detected (Tray 2)
# Paper Size Mismatch (Bypass Tray)
* Paper Size Mismatch (Tray 1)

x Paper Size Mismatch (Tray 2)
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Cover Open
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Troubleshooting > Printer Status Monitor Errors > Cover Open

Cover Open

A cover is open. Close the cover.
Close the top cover or duplex unit cover. If the cover is already closed, open and then reclose it.

Follow the procedure below to close the top cover or duplex unit cover.

E] Close the cover.

o Check that the duplex unit is correctly attached and the duplex unit cover is closed.

[2] If the [Resume] key lights, press that key.
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Cover Open
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Duplex Unit Not Detected
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Troubleshooting > Printer Status Monitor Errors > Duplex Unit Not Detected

Duplex Unit Not Detected

The duplex unit is not attached correctly. Follow the procedure below to attach the duplex unit correctly.

[1] Re-attach the duplex unit.

AGKD1S
(2] If the [Resume] key lights, press that key.
/ .
~ W
QD
T
AGKDRAE

o Even if you are not duplex printing, the duplex unit must be attached. Otherwise printing will not start.

|| Top | 4 Previous - Next fp |
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Cover Open / Print Cartridge(s) Not Detected
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Troubleshooting > Printer Status Monitor Errors > Cover Open / Print Cartridge(s) Not Detected

Cover Open / Print Cartridge(s) Not Detected

The right front cover is open. Close the right front cover. Alternatively, the print cartridges are not installed or are
installed incorrectly. Install the print cartridges correctly.

If the cover is open:

[1] Close the right front cover.

AGHODSE

If the print cartridges are not installed or are installed incorrectly:

[1] Open the right front cover.

[2] Push in the cartridge using the PUSH area.
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Cover Open / Print Cartridge(s) Not Detected

AGHO0SS

o If the error persists, take the Print cartridge out once, and then install it again. The procedure above should be performed only once.

|| Top | 4 Previous - Next i |
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Paper in Bypass Tray

This appears if paper is set before printing from the bypass tray starts. Follow the procedure below to remove the
paper in the bypass tray.

[1] Remove paper.

AGKDELS

E] Insert a sheet of paper into the bypass tray with the print side face up.

AGKORES
Printing starts when you push in the paper.
Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when cleaning
finishes.

¥ d |mportant

e When using the bypass tray, make sure the sheet of paper is between the top and bottom of the bypass tray guides.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/t0019.htm (1 of 2)2005/10/05 12:05:21


javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();

Paper in Bypass Tray

AGKDEAS

o Paper can only be inserted one sheet at a time.
o Support the sheet with your hands to keep it from sliding out and dropping.

o Insert the sheet straight into the bypass tray.

[3] Press the [Resume] key, and then push the sheet a little way into the printer.

|| Top | 4 Previous - Next ¢ |
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Cartridge End
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Cartridge End

A Print cartridge is empty. Printing can continue using ink remaining in the printer; however, no ink is left in the Print
cartridge. Check which color of cartridge needs to be replaced, and then replace it.

Checking ink color

e Checking using the Printer Status monitor

=1c1 x|

Fie name:

Sending data:

g 2 |

Stop Printing |

o In the illustration above, the cyan Print cartridge is empty.

o Checking the cartridge replacement indicators

©oe @

0 0

AGHES

o Blinking

In the illustration above, the cyan Print cartridge is empty.

o From left to right, the cartridge replacement indicators display the status of the black (K), cyan (C), magenta (M), and

yellow (Y) Print cartridges.
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Cartridge End

o Since solid color printing on semi-gloss photo paper consumes a lot of ink of that color, printing may stop in the middle of

the printing process because ink of that color is depleted.

o Do not perform a normal head cleaning or a full head cleaning unless it is necessary. Ink may run out making printing

impossible.

o If you turn the power off and then on again, ink adjustment is performed in the printer which may result in the ink running

out.

= B Feferen=s

e Replacing a Print Cartridge ad

e Displaying the Printer Status i |

|| Top | 4 Previous - Next i |
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Cartridge/Print-head Tank Empty
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Troubleshooting > Printer Status Monitor Errors > Cartridge/Print-head Tank Empty

Cartridge/Print-head Tank Empty

The ink is completely depleted. Printing cannot be performed. Replace the Print cartridge.

Checking ink colors

e Checking using the Printer Status monitor

=101 x|

Fie name:

Sending data:

Progress: |

Stop Frmting |

[ ok | Hee |

o In this illustration, the cyan Print cartridge has completely run out.

o Checking the cartridge replacement indicators

©oe @

6 0 0

o Lit
In this illustration, the cyan Print cartridge has completely run out.

o From left to right, the cartridge replacement indicators display the status of the black (K), cyan (C), magenta (M), and

yellow (Y) Print cartridges.
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Cartridge/Print-head Tank Empty

o Head cleaning cannot be performed.

= B Feferens

e Replacing a Print Cartridge i |

o Displaying the Printer Status 7

|| Top | 4 Previous - Next fp |
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Out of Printable Temperature Range
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Troubleshooting > Printer Status Monitor Errors > Out of Printable Temperature Range

Out of Printable Temperature Range

Follow the procedure below to relocate the printer when the temperature inside the printer is inappropriate, extremely
high or low, for printing.

[1] Turn off the power of the printer.
[1] Place the printer in a 10 to 32°C (50 to 89.6°F) environment.

[3] Turn on the power of the printer.

o If humidity is more than 54%, the high end of the appropriate temperature range will be lower than usual.

o Even after the power is turned on, the printer may remain in the standby mode until it acclimates to the room temperature. If this happens,

wait until the [Power] key stops blinking and stays lit.

= B Feferen=s

o For details about what conditions the printer can be used under (ambient temperature and humidity range), see "Checking the Installation

Area", Setup Handbook.

|| Top | 4 Previous « Next fp |
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When the Internal Unit is Almost Full
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Troubleshooting > Printer Status Monitor Errors > When the Internal Unit is Almost Full

When the Internal Unit is Aimost Full

Depending on your settings, the internal unit may fill up sooner than normal. An "Internal unit nearly full" message
appears shortly before the internal unit is full.

Contact your service representative as soon as possible for a replacement internal unit (charge incurred).

|| Top | 4 Previous - Next i |
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Printer Error
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Troubleshooting > Printer Status Monitor Errors > Printer Error

Printer Error

An error has occurred in the printer. Turn the power off once, and then turn it back on.

o If the printer is relocated from a cold area to a warm area or the printer is placed in a room where the temperature varies greatly,
condensation may form inside the printer causing errors. If this happens, an error might not clear if the power is turned off and then on. Wait

until the printer acclimates and the condensation disappears. This should take about one hour.

= N Reference

o If the error still does not clear after the printer acclimates to room temperature and the power is turned back on, contact your sales or service

representative.

|| Top | 4 Previous - Next i |
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Adjusting the Printer

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | | Settings | | 2]

Troubleshooting > Adjusting the Printer

Adjusting the Printer

Adjust the printer from the [Maintenance] tab in the printer properties dialog box.

= B Feferen=s

e Clean Print-heads (Normal) a4

e Clean Print-heads (Full) i |

e Adjust Print-head Positions |

o Registration i

o Adjust Paper Feed i

|| Top | 4 Previous - Next f |
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Error Indicator Summary
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Troubleshooting > Error Indicator Summary

Error Indicator Summary

You can check the status of the printer using the lit or blinking indicators on the control panel.

1T 2 3 4

© 6 ©

9 0 0 0

AGKIMNME

1. Cartridge replacement indicators

N

. [Power] key

w

. [Resume] key

N

. [Cancel] key

Status of Indicators Status/Solutions

The printer has completely run out of the

. . . indicated ink.
A cartridge replacement indicator is lit.

(In the illustration, the printer has run out of

(The [Power] key may be lit or blinking at the cyan ink.)

same time.)
Further printing is impossible. Check the

color indicated, and replace the corresponding
print cartridge immediately.

=>Cartridge/Print-head Tank Empty 7.

@ ©
0 0

The print cartridges are not installed or are not
installed correctly (in the illustration, cyan is
not installed).

©

.

Install the print cartridges correctly.

ARinE =>Cover Open / Print Cartridge(s) Not
Detected ad.
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Error Indicator Summary

A cartridge replacement indicator is blinking.

(The [Power] key may be lit or blinking at the
same time.)

© e ©

5 8 0 o0

ALK IS

The corresponding print cartridge has run out
of ink.

(In the illustration, the cyan print cartridge has
run out of ink.)

Printing can continue with the ink remaining
in the printer, but there is no more ink in the
print cartridge. Check the color indicated, and
replace the corresponding print cartridge.

=>Cartridge End 7.

All the indicators are blinking.

alp e alp alp
6

AL RS

A maintenance error has occurred.
Turn the power off, and then on.
If that does not clear the error, contact your

sales or service representative.

=>Where to Inquire 7d.

The [Resume] key is lit.

(The [Power] key may be lit or blinking at the
same time.)

@ ©
0 0

©

0

AL S

There may be a problem with feeding paper.

Check the printer and paper, and then press
the [Resume] key.

=>Paper Is Not Fed or Delivered Normally #d.

The paper tray may be empty.

Load the paper tray, and then press the
[Resume] key.

=rLoading Paper 7.

The [Power] key is blinking.

©® 6 ©

00 0

AGKIOTS
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The printer is either warming up or receiving
print data.

(If the blinking is slow, the printer is in
standby mode with its main power off.)

If the blinking continues, the temperature
inside the printer may be outside of the
operating temperature range.

Turn the power off, move the printer to a
location where the temperature is within the

range 10-32°C (50-89.6°F), and then turn the
power on.

=>Qut of Printable Temperature Range 7d.




Error Indicator Summary

The duplex unit may not be installed correctly.

Install the duplex unit correctly, and then
press the [Resume] key.

=>Duplex Unit Not Detected 7.

A cover may be open.

Close the cover, and then press the [Resume]
key.

=>»Cover Open ad.

Paper may be jammed.
Remove the jammed paper, and then press the
The [Resume] key is blinking. [Resume] key.

(The [Power] key may be lit or blinking at the

) =>»Paper Jam #d.
same time.)

The temperature inside the printer may have
gone outside of the operating temperature
range while the power was on, or the

S temperature may be outside of the operating
@ . ) temperature range now.
Turn the power off, move the printer to a
location where the temperature within the
range 10-32°C (50-89.6°F), and then turn the
power on.

=>Qut of Printable Temperature Range 7d.

Paper of the correct size may not be loaded.
Load paper of the correct size, or change the
printer driver settings.

=>Paper Size Mismatch (Bypass Tray) 7,
Paper Size Mismatch (Tray 1) 73, and Paper
Size Mismatch (Tray 2) 4.

The right front cover is open.
Close the right front cover.

=»Cover Open / Print Cartridge(s) Not
Detected Ad.

= Reference

o For details about what conditions the printer can be used under (ambient temperature and humidity range), see "Checking the Installation

Area", Setup Handbook.
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Replacing a Print Cartridge > Checking the Remaining Ink

Checking the Remaining Ink

Follow the procedure below to check when to replace Print cartridges using the Printer Status monitor or the cartridge
replacement indicators.

Checking using the Printer Status monitor

[1] Open the printer properties dialog box.
[2] Click the [Maintenance] tab.

[3] Click [Display Status Monitor].

The Printer Status monitor dialog box appears.

[4] Check the cartridge status.

Y ] A |
Fie name:
Sending data:
Progress: |
Stop Frmtng

Fieplace carindge(s). Cartridge{s]

Dpan the indicated cover and

replace the cartndges].

Right Front Cover-Cipan

replacing, pull out all emply LI

Wses Guide, |
[ ok | Hep |

In the illustration above, the cyan Print cartridge is empty.

If the background of the image in the top left corner of dialog box is yellow, the indicated cartridge is empty.
Replace the cartridge.
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Checking the Remaining Ink

T |

Fie name:

Sending data:

Frogress [

Stop Piinting

Catidge/Prit-head T ank Emply |

[ ok | Hee |

In this illustration, the cyan ink has completely run out.

If the background of the image in the top left corner of dialog box is red, the printer has run out of the indicated
ink. Replace the cartridge.

Checking the cartridge replacement indicators of the printer

©oe @

6 0 0

ALK S

o Blinking

In the illustration above, the cyan Print cartridge is empty.
o Lit

In the illustration above, the cyan ink has completely run out.
o From left to right, the cartridge replacement indicators display the status of the black (K), cyan (C), magenta (M), and yellow (Y)

Print cartridges.

e The cartridge status can be used for determination of cartridge change. If cartridge status is not monitored, visual indication of the cartridge

may not be correct.
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e Opening the Printer Status Monitor i |

|| Top | 4 Previous - Next o |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0144.htm (3 of 3)2005/10/05 12:05:31



Replacing a Print Cartridge

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | | Settings | | 2]

Replacing a Print Cartridge > Replacing a Print Cartridge

Replacing a Print Cartridge

Follow the procedure below to replace an empty Print cartridge.

Clear any errors, such as when there is a paper jam or when no paper is loaded, before replacing a Print cartridge.

[1] Remove the Print cartridges' packaging.

o If multiple cartridges are empty, replace all the empty cartridges. You can shorten the time for needed replacement.

[2] Open the right front cover.
[3] Take out the empty cartridges.

[4] Check the cartridges' orientation, and then install them gently.

Install in the following order from the left: black, cyan, magenta, and yellow.

pd Important |

o Take care to install the cartridges in the correct position.

(5] Push in the cartridge using the PUSH area.
[6] Close the right front cover.

= B Feferens

o Recommended Consumables 7
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Handling Print Cartridges
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Handling Print Cartridges

Important points about handling Print cartridges are explained.

/A CAUTION

o If ink comes into contact with your eyes, rinse immediately in running water. For other symptoms, consult a doctor.
o Ifink is ingested, induce vomiting by drinking a strong saline solution. Consult a doctor immediately.

o If your skin comes into contact with ink, immediately wash the affected area with water or soap and water.

A CAUTION

o Keep the ink or ink container out of reach of children.

About Print cartridges
o Print cartridges comply with the manufacturer's safety specifications. To ensure safety and reliability,
use genuine Print cartridges.

e When using the printer for the first time, install the Print cartridges supplied with the printer.

Using Print cartridges
o Print cartridges should be opened before their expiration date and used within six months of being
opened.
o Do not open the package of a Print cartridge until the cartridge will be installed in the printer.
e Do not touch the ink supply port of Print cartridges.
o Do not shake Print cartridges strongly. Ink may leak out.
o Do not take apart Print cartridges.

e Do not open the right front cover except when installing Print cartridges. Do not turn off the power or
unplug the power cord during the process of installing the cartridges.

o Always confirm the color of a Print cartridge before installing it.
e Do not remove a Print cartridge once it has been installed unless necessary.

e Do not remove a Print cartridge while printing is being performed. Printing will stop.

Storing Print cartridges

e Avoid storing Print cartridges in hot or freezing places.

Ink consumption

o In addition to printing, ink is consumed when the power is turned on, head cleaning is performed, or
Print cartridges are installed.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0146.htm (1 of 2)2005/10/05 12:05:33


javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();

Handling Print Cartridges

|| Top | 4 Previous . Next f |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0146.htm (2 of 2)2005/10/05 12:05:33



Chapter contents - - User Guide

User Guide

I Replacing a Print Cartridge

Checking the Remaining Ink

Replacing a Print Cartridge

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/index_chap_06.htm2005/10/05 12:05:34


javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_a();

Setting Up a Server

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | | Settings | | 2]

Sharing the Printer > Setting Up a Server

Setting Up a Server

Follow the procedure below to set up a print server so that the printer can be shared by users.

s o |mportarnt

o For Windows 2000/XP, Windows Server 2003, and Windows NT 4.0, log on as an administrator (a user with an administrator right).

o Configure a computer connected to the printer as the print server.

o The print server is a computer used to manage the shared printer on the network.

E] On the [Start] menu, point to [Settings], and then click [Control Panel].

E] Double-click [Network and Dial-up Connections].

[E] Click [Local Area Connection] to highlight it, and then, in the [File] menu, click [Properties].
E] Select the [Client for Microsoft Networks] check box.

[5] Click [OK].

[6] Install the printer driver.

[7] On the [Start] menu, point to [Settings], and then click [Printers].

o Under Windows XP Professional, click [Printers and Faxes] on the [Start] menu.

e Under Windows XP Home Edition, click [Control Panel] on the [Start] menu. Click [Printers and Other Hardware], and then click
[Printers and Faxes].
Click the icon of the printer, and then click [Sharing...] on the [File] menu.

E] Click [Shared as:], and then enter a name in the [Shared as:] box.

Click [OK].

o Configure a computer connected to the network, where the print server is connected, as a client computer.

= Reference

o For details about installing the printer driver, see "Installing the Printer Driver", Setup Handbook.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0147.htm (1 of 2)2005/10/05 12:05:35


javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();

Setting Up a Server

e Setting Up a Client Computer i |

|| Top | 4 Previous - Next i |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0147.htm (2 of 2)2005/10/05 12:05:35



Setting Up a Client Computer

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | | Settings | | 2]

Sharing the Printer > Setting Up a Client Computer

Setting Up a Client Computer

Follow the procedure below to configure a computer as a client computer and connect it to the shared printer. Make
this setting when installing the printer driver from the CD-ROM provided.

s o [mportarnt

o For Windows 2000/XP, Windows Server 2003, and Windows NT 4.0, log on as an administrator (a user with an administrator right).

o Configure a computer connected to the network where the print server is connected.

[I] Start Windows, and then insert the ''Drivers & Manual'' CD-ROM into the CD-ROM drive.

o Quit all other applications currently running.

e When starting Windows, a wizard for adding new hardware may open. If this happens, click [Cancel]. Check again that the power is

off, and then proceed to step .
o When the CD-ROM is inserted, the [Drivers & Manual] dialog box appears. If it does not, double-click the CD-ROM drive icon under
[My Computer] or [Explorer], and then double-click [SETUP.EXE].
Click [Printer Driver].
E] Read the license agreement, and then click [I accept the agreement.].
(@] Click [Next >].
[5] Click [Connected via LAN].
[6] Click [Next >].
[7] Click [Add a new printer].
Click [Next >].
[E] Click the plus mark next to a printer name.
Click [Port:< LPT1: >] under [Printer Name:].

[11] Click [Add].
The [Add Port] dialog box appears.
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Setting Up a Client Computer

[12] Click [Network Printer].

(13] Click [OK].

[14] Select a shared printer.

[15] Click [OK].

Check that [<\\servername\sharedprintername>] appears after [Port:].

Click [Continue].

Installation starts.

Select whether or not to open the Printer Status monitor automatically.

Click [Next >].

[20] Check the installation result, and then click [Finish].

o If the message prompting you to restart the computer appears, restart the computer.

= B Feferen=s

o For details about installing the printer driver, see "Installing the Printer Driver", Setup Handbook.

e Setting Up a Server ad
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Where to Inquire
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Inquiries and Consumables > Where to Inquire

Where to Inquire

For inquiries, contact your sales or service representative.
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Recommended Consumables

User Guide
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For screen reader Standard

Inquiries and Consumables > Recommended Consumables

Recommended Consumables

Consumables recommended for this printer are listed.
Purchase necessary consumables before your supply runs out.
For information about consumables, contact your sales or service representative.

o Print cartridges
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Option and Consumables
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Inquiries and Consumables > Option and Consumables

Option and Consumables

The optional Paper Feed Unit Type 7500 is available. If installed, a large number of prints can be made at one time
using plain paper.

o For information about options and consumables, contact your service representative.
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Additional Information > Color Guide

Color Guide

For screen reader

|

Related topics

Color Printing Mechanism 73

Color Production Method of Printers 74
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Color Printing Mechanism
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Additional Information > Color Guide > Color Printing Mechanism

Color Printing Mechanism

The three primary colors of light (RGB) and the three primary colors of Pigment (CMY)

All light can be produced using a mixture of three colors known collectively as RGB. R stands for red, G for
green, and B for blue. When mixed in the same proportion, white light is created.

o The three RGB colors are called the primary colors of light. The RGB colors are also used to produce the colors displayed on the

screen of a computer.

Printed colors are produced using a mixture of the three CMY colors. C stands for cyan, M for magenta, and Y
for yellow. When mixed in the same proportion, black is created.

yoliow

e The CMY colors are called the primary colors of pigment. Printers use cyan (C), magenta (M), yellow (Y), and K (black) to print in

full color.

The primary colors of light (RGB) can be mixed to produce the secondary colors of cyan, magenta, and yellow.
Conversely, the primary colors of pigment (CMY) can be mixed to produce red, green, and blue. When two
primary colors are mixed, the resulting color is the complimentary color of the remaining primary color. Red
and cyan, green and magenta, and blue and yellow are pairs of complementary colors.

E' Top | 4 Previous - Next f |
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Additional Information > Color Guide > Color Production Method of Printers

Color Production Method of Printers

Printers use cyan (C), magenta (M), yellow(Y), and K (black) to print in full color.

o If equal proportions of the three CMY colors are mixed, in theory, pure black should be produced. In practice, the resulting printed color is
not pure black and has an inferior feel due to the limitations of printing. In order to reproduce a distinct black color, normally black ink is

used when printing color images.
For example, a cyan image can be printed using only cyan ink without any complications; however, a full color image

can be made up of over 16 million subtlety different colors. These complicated colors are produced by translating
them into proportions of CMYK dots per unit area.

In addition, the same color in an image can have lighter and darker parts. These shades of color are produced by
varying the amount of ink dots per unit area.
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Guide to Components

User Guide

For screen reader Standard
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Additional Information > Guide to Components

Guide to Components

The names and functions of parts of the printer body, control panel, and options are explained.

Related topics
Printer Body 3

Printer Rear 74

Control Panel a3

Option a3
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Printer Body

User Guide
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For screen reader Standard

Additional Information > Guide to Components > Printer Body

Printer Body

10.

AGKI1S

. Top cover

Keep this cover closed during printing. If you cannot locate paper jams, or jammed paper cannot be removed easily, you
can check the condition of paper from the top of the printer.

. Envelope selector

For envelopes, set the lever to the rear position E=; for everything else, set the lever to the forward position D

. Print cartridge (yellow)
. Print cartridge (magenta)
. Print cartridge (cyan)

. Print cartridge (black)

Right front cover

Keep this cover closed during printing. Open to install or replace Print cartridges.
Tray 1
Load paper here.

QOutput tray extension

Pull out when using paper larger than Letter to keep the printed paper from falling.

QOutput tray

Prints are delivered to this tray.

When using paper larger than Letter, pull out the output tray extension.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0156.htm (1 of 2)2005/10/05 12:05:47


javascript:back_to_index()
javascript:back_to_index()
javascript:SetWord2_i();

Printer Body

|| Top | 4 Previous - Next fp |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/int/0156.htm (2 of 2)2005/10/05 12:05:47



Printer Rear

User Guide

For screen reader Standard

| # Contents | § Previous - Next - | I | | Settings | | 2]

Additional Information > Guide to Components > Printer Rear

Printer Rear

1. USB slot

Connect the USB cable from the computer here.

2. Duplex unit cover button

Press to open the duplex unit cover.

3. Bypass tray

Insert paper by hand here. Insert thick paper and label paper.

4. Duplex unit locks

Use to lock or unlock the duplex unit when attaching or detaching it.

5. Duplex unit cover

Open to remove paper jammed inside the duplex unit.

6. Vent

Air is vented here to prevent the inside of the printer from getting too warm. Do not lean anything against the vent or block
it in any way. If the inside of the printer gets too warm, a breakdown could occur.

7. Guide board

Open to remove paper jammed inside the printer.
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Printer Rear

8. Paper feed wheel

Use to wind out paper jammed around the guide board.

9. Power cord

Plug the power cord into a wall outlet.

Connect the grounding wire attached to the power plug directly to a grounding terminal.

10. Bypass tray guides

Slide the left and right guides in to match the size of paper being used in the bypass tray.

11. Duplex unit

Turns the paper over when performing duplex printing.
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Control Panel

-

2 3 4

© 6 ©

5 0 0 0

ACKINE

1. Cartridge replacement indicators

o The indicators correspond to the positions of the Print cartridges. From left to right, the cartridge replacement
indicators display the status of the black (K), cyan (C), magenta (M), and yellow (Y) Print cartridges.

2. [Power] key

o Press to turn the power on and off.
o To turn the power on, press the key for one second until it lights.

o After the power is turned on, the [Power] key will blink until the printer is ready for printing at which point the key
will stop blinking and stay lit.

o The [Power] key will also blink when the printer is processing data.

o When the power is turned off, the key will blink slowly until the printer has completely shut down at which point
the key will be dark.

o (D' means "standby".

3. [Resume] key

o Press to resume printing after dealing with an error.

o This key lights or blinks when paper runs out or a paper jam or error occurs.

4. [Cancel] key

o Press to cancel printing.
e When the power is off, if you hold down the [Cancel], [Resume], and [Power] keys together for more than three seconds, all four cartridge
replacement indicators light. When you release the keys, the machine produces a sample print. On the sample print, you can check

“Secondary Counter”.

e When the power is off, if you hold down the [Resume] and [Power] keys together for more than three seconds, all four cartridge replacement
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Control Panel
indicators light. When you release the keys, the machine ejects a blank sheet.

o If you hold down the [Cancel] key down for more than three seconds, the [Power] key blinks. When you release the key, the machine cleans

the heads for all four inks.

o When the power is off, if you hold down the [Cancel] and [Power] keys together for more than three seconds, all four cartridge replacement

indicators light. When you release the keys, the machine prints the “Nozzle Check” test pattern.

=l Reference

e Error Indicator Summary |
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Additional Information > Guide to Components > Option

Option

Paper Feed Unit Type 7500

AGRITIS

1. Tray 2

Load plain paper here.

2. Tray 2 rear cover

Open to remove paper jammed in tray 2.

3. Tray cover

This is attached to tray 2.
Take this cover off when loading paper.
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Additional Information > Cleaning

Cleaning

Clean the outside of the printer regularly to maintain the condition of the printer.

AWARNING

o To avoid hazardous electric shock, do not remove any covers or screws other than those specified in this manual. When
the machine needs to be checked, adjusted, or repaired, contact your service representative.

o Do not take apart or attempt any modifications to this machine. There is a risk of fire, electric shock, explosion or loss
of sight.

To clean the exterior of the printer, wipe it with a soft, dry or damp cloth. If the dirt does not come off, wipe the
printer first with a cloth moistened with a neutral detergent, then with a damp cloth, and finally with a dry cloth.

s |mportant

o Do not use volatile chemicals like benzene or thinner, or insecticides on the printer. Using these chemicals could deform, crack, or change

the color of the printer.

e When wiping the printer with a cloth moistened with detergent, be sure to wipe only the exterior.
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Additional Information > Moving

Moving

The precautions when moving the printer a short distance or long distance are explained.

Related topics

Moving a Short Distance ad

Moving a Long Distance 74
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Additional Information > Moving > Moving a Short Distance

Moving a Short Distance

The precautions when moving the printer a short distance or long distance are explained.

/A CAUTION

o The printer weighs approximately 14.2 kg (31.3 1b.).

o When moving the machine, hold the machine by the bottom below the two indentations. Lift the machine slowly in
order to avoid straining your body. Lifting the machine without sufficient strength or assistance or handling it roughly
and dropping it could cause an injury.

A CAUTION

o Unplug the power cord from the wall outlet before you move the machine. While moving the machine, you should take
care that the power cord will not be damaged under the machine.

A CAUTION

e When you disconnect the power plug from the wall outlet, always pull the plug (not the cable).

E] Turn the power off, disconnect the USB cable, and then unplug the power cord from the wall outlet.

y ' Important

o To make sure the print heads are capped when the machine is off, always switch the machine off from the control panel. Switching off

in any other way may leave the print heads uncapped, possibly leading to printing problems.

[2] Lift the printer using the indents on the printer's sides near the base, and then slowly lift and move the
printer without tilting.

AGHKOEES
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Moving a Long Distance

E] Turn the power off, disconnect the USB cable, and then unplug the power cord from the wall outlet. Do
not remove the print cartridges. Remove the paper.

v d |mportant

o To make sure the print heads are capped when the machine is off, always switch the machine off from the control panel. Switching off

in any other way may leave the print heads uncapped, possibly leading to printing problems.

E] Pack the printer for transport when moving it a long distance such as when changing office or
residence. Disconnect all cables, place the printer in the box it was in when purchased, and transport in a
level manner.

Contact sales or service representative for details.

o The inside of the printer may become dirty if the printer is not level when transported.
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Disposing

Consult with an authorized dealer to dispose of the printer.
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When Not Using for a Long Period of Time

When the printer will not be used for a long period of time, turn the power off, disconnect the USB cable, and unplug
the power cable from the wall outlet.

Be careful of the following:

o The nozzles of the print-heads may dry out and become clogged. To prevent this, periodically print something.
Even if you do not print anything, turn the printer on for a few minutes once a month.

o If you do not use the printer for a long period of time, always check if the nozzles are clogged by printing a
nozzle check test pattern. Clean the print-heads as necessary, and then begin printing.

o If you do not use the printer for a long period of time, printing may not be performed normally even if head
cleaning is performed multiple times. If this happens, turn the power off and leave the printer alone for eight
hours or longer.

o After head cleaning is performed multiple times, clogged ink will dissolve over time, and normal printing may become possible.

o If there is no improvement after performing the steps above, contact sales or service representative.

=l Reference

o Where to Inquire =
o Nozzle Check ad

o Clean Print-heads (Normal) ad

e Clean Print-heads (Full) 71
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Printer Body

Print speed

Measurements according to the manufacturer's measurement system
Black draft: 20 ppm
Color draft: 20 ppm

Depending on the operating environment, printing may take longer than normal.

Print direction

Supports bidirectional, minimum distance printing

Print resolution

Max 3600 x 1200 dpi equivalent

Nozzles

Black: 384 nozzles

Cyan, magenta, and yellow: 384 nozzles per color

Paper sizes (Tray 1 : standard)

Standard paper size: A3 (Portrait), B4 (portrait), A4 (portrait), BS (portrait), AS (landscape), A6 (portrait), 11" x
17" (portrait), Legal (portrait), Letter (portrait), 5 1/," x 8 1/," (landscape), Executive (portrait) (184.2 mm x

266.7 mm (7.3 x 10.5 inches)), F (portrait) (203.2 mm X 330.2 mm (8.0 x 13.0 inches)), Foolscap (F4) (portrait)
(215.9 mm x 330.2 mm (8.5 x 13.0 inches)), Folio (portrait) (209.5 mm x 330.2 mm (8.3 x 13.0 inches)), 16K
(portrait) (195 x 267mm(7.7 x 10.6 inches)), Com10 (portrait) (104.8 mm x 241.3 mm (4.2 x 9.5 inches)),
Monarch (portrait) (98.4 mm x 190.5 mm (3.9 x 7.5 inches)), C6 (portrait)(114 mm x 162 mm (4.5 x 6.4
inches)), C5 (portrait) (162 mm x 229 mm (6.4 x 9.1 inches)), DL Env (portrait)(110 mm x 220 mm (4.4 x 8.7
inches))

Custom paper sizes: 139.7-431.8mm (length) x 90-305mm (width), (5.5-17.0 inches (Iength) x 5.5-17.0 inches
(width))

Paper sizes (Bypass tray)

Standard paper size: 12" x 18" (Portrait), A3 (Portrait), B4 (portrait), A4 (portrait), BS (portrait), AS
(landscape), A6 (portrait), 11" x 17" (portrait), Legal (portrait), Letter (portrait), 5 1/,"x8 1/," (landscape),

Executive (portrait) (184.2 mm x 266.7 mm (7.3 x 10.5 inches)), F (portrait) (203.2 mm x 330.2 mm (8.0 x
13.0 inches)), Foolscap (F4) (portrait) (215.9 mm x 330.2 mm (8.5 x 13.0 inches)), Folio (portrait) (209.5 mm X
330.2 mm (8.3 x 13.0 inches)), 16K (portrait), Com10 (portrait) (104.8 mm x 241.3 mm (4.2 x 9.5 inches)),
Monarch (portrait) (98.4 mm x 190.5 mm (3.9 x 7.5 inches)), C6 (portrait) (114 mm x 162 mm (4.5 x 6.4
inches)), C5 (portrait) (162 mm x 229 mm (6.4 x 9.1 inches)), DL Env (portrait) (110 mm x 220 mm (4.4 x 8.7
inches))

Custom paper sizes: 148-1295.4 mm (length) x 90-216 mm (width), (5.9-51.0 inches (length) x 3.6-8.5 inches
(width))

Paper sizes (Duplex unit)
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Printer Body

Standard paper size: A3 (Portrait), B4 (portrait), A4 (portrait), BS (portrait), AS (landscape), A6 (portrait), 11" x
17" (portrait), Legal (portrait), Letter (portrait), 5 1/," x 8 1/," (landscape), Executive (portrait), 16K (portrait)

Paper type
Plain paper
Recycled paper
Color paper
Inkjet plain paper
Semi-gloss photo paper
Inkjet transparency

Envelope
Paper weight
Tray 1/optional tray: 60-105 g/m?2 (114.7-198.5 Ib.)
Bypass tray: 60-163 g/m2 (114.7-297.7 1b.)
Paper capacity
Tray 1: 250 sheets
Bypass tray: 1 sheet
Maximum paper capacity

750 sheets (with the optional tray installed)

Output tray capacity
150 sheets

The capacity may be less depending on the images printed.

Power supply
120 V or more, 60Hz, 0.9 A or more (when fully equipped)

Power consumption

Average power consumption while printing: 30 W or less (not including options)
less than 39 W (when fully equipped)

Energy Saver mode: less than 6 W

When power is off: 0.2 W or less

To avoid any power consumption, disconnect the power plug from the wall outlet.

(Disconnect the power plug after turning the power off with the [Power] key.)

Operating environment

Temperature: 10 to 32°C (50 to 89.6°F))
Humidity: 15-80% RH (maximum wet-bulb temperature: 25°C (77°F) )

Printing may stop to protect the printer for conditions outside those described above.

Storage environment

Temperature: 1 to 43°C (33.8 to 109.4°F)
Humidity: 15-80% RH

External dimensions
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(W x D x H) 615 x 557 x 250 mm (24.3 x 22.0 x 9.9 inches) (when A4/Letter paper is loaded)
(W xD xH) 615 %692 x 250 mm (24.3 x 27.3 x 9.9 inches) (when A3/11" x 17" paper is loaded)
Weight

Approximately 14.2 kg (31.3 Ib.) (printer body with consumables)

Noise emission

Approximately 49 dB (high quality mode)

Interface

USB 2.0 high speed

Printer language

RPCS Raster

Print cartridges

Types and yields measured using A4 (Letter) 5% chart printed in standard (speed priority) mode.
Print cartridge black: approximately 3200 sheets

Print cartridge cyan: approximately 2500 sheets

Print cartridge magenta: approximately 2500 sheets

Print cartridge yellow: approximately 2500 sheets

The printing yields of Print cartridges vary depending on the number of times print-head cleaning is performed.
Also, the printing yields of the Print cartridges packaged with the printer are lower than the yields of the Print
cartridges available for purchase separately.
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Option (Paper Feed Unit)

Paper Feed Unit Type 7500

Paper sizes

A4 (portrait), B5 (portrait), Legal (portrait), Letter (portrait), Executive (portrait) (184.2 mm x 266.7 mm
(7.3 x 10.5 inches)), F (portrait) (203.2 mm x 330.2 mm (8.0 x 13.0 inches)), Foolscap (F4) (portrait)
(215.9 mm x 330.2 mm (8.5 x 13.0 inches)), Folio (portrait) (209.5 mm x 330.2 mm (8.3 x 13.0 inches)),
16K (portrait)

Paper type

Plain paper
Inkjet plain paper
Recycled paper
Color paper

Paper weight
60-105 g/m?2 (114.7-198.5 1b.)

Paper capacity

500 sheets

External dimensions

(W x D xH) 615 x 557 x 110 mm (24.3 x 22.0 x 43.3 inches)

Weight

Approximately 5 kg (11 1b.)
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Electromagnetic Interference

If another electronic device is placed next to the printer, each will influence the other negatively. In the case of a
television or radio, noise may be generated. If this happens, do the following:

e Move the television or radio as far as possible from the printer.
o Change the position of the antenna of the television or radio.

o Use a different wall outlet on a different circuit.
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About NetBSD

For software installed on this printer such as a controller, the NetBSD operating system is used.
1. Copyright Notice of NetBSD
For all users to use this product:
This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not in the public domain; its
authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD source code. For exact copyright
notice applicable for each of the files/binaries, the source code tree must be consulted.

A full source code can be found at http://www.netbsd.org/ 7.
Copyright (c) 1999, 2000 The NetBSD Foundation, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement:

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS *"AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

2. Authors Name List
All product names mentioned herein are trademarks of their respective owners.

The following notices are required to satisfy the license terms of the software that we have mentioned in this
document:

This product includes software developed by Jonathan R. Stone for the NetBSD Project.

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.
This product includes software developed by Manuel Bouyer.

This product includes software developed by Charles Hannum.

This product includes software developed by Charles M. Hannum.
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About NetBSD

This product includes software developed by Christopher G. Demetriou.

This product includes software developed by TooLLs GmbH.

This product includes software developed by Terrence R. Lambert.

This product includes software developed by Adam Glass and Charles Hannum.

This product includes software developed by Theo de Raadt.

This product includes software developed by Jonathan Stone and Jason R. Thorpe for the NetBSD Project.

This product includes software developed by the University of California, Lawrence Berkeley Laboratory and
its contributors.

This product includes software developed by Christos Zoulas.

This product includes software developed by Christopher G. Demetriou for the NetBSD Project.
This product includes software developed by Paul Kranenburg.

This product includes software developed by Adam Glass.

This product includes software developed by Jonathan Stone.

This product includes software developed by Jonathan Stone for the NetBSD Project.

This product includes software developed by Winning Strategies, Inc.

This product includes software developed by Frank van der Linden for the NetBSD Project.
This product includes software developed for the NetBSD Project by Frank van der Linden
This product includes software developed for the NetBSD Project by Jason R. Thorpe.

The software was developed by the University of California, Berkeley.

This product includes software developed by Chris Provenzano, the University of California, Berkeley, and
contributors.

Copyright (¢) 1993 by Sun Microsystems, Inc. All rights reserved.
Developed at SunPro, a Sun Microsystems, Inc. business.

Permission to use, copy, modify, and distribute this software is freely granted, provided that this notice is
preserved.

Copyright (c) 1995 Carnegie-Mellon University.
All rights reserved.
Author: Chris G. Demetriou

Permission to use, copy, modify and distribute this software and its documentation is hereby granted, provided
that both the copyright notice and this permission notice appear in all copies of the software, derivative works
or modified versions, and any portions thereof, and that both notices appear in supporting documentation.

CARNEGIE MELLON ALLOWS FREE USE OF THIS SOFTWARE IN ITS "AS IS" ONDITION.
CARNEGIE MELLON DISCLAIMS ANY LIABILITY OF ANY KIND FOR ANY DAMAGES
WHATSOEVER RESULTING FROM THE USE OF THIS SOFTWARE.

Carnegie Mellon requests users of this software to return to

Software Distribution Coordinator or Software.Distribution@CS.CMU.EDU
School of Computer Science

Carnegie Mellon University

Pittsburgh PA 15213-3890

any improvements or extensions that they make and grant Carnegie the rights to redistribute these changes.
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Trademarks

Adobe and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States
and/or other countries.

Pentium is a registered trademark of Intel Corporation.
Netscape is a registered trademark of Netscape Communication Corporation in the U.S. and/or other countries.

Macromedia and Flash are either registered trademarks or trademarks of Macromedia, Inc. in the U.S. and/or other
countries.

Microsoft, Windows, Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the U.
S. and/or other countries.

Other product names used herein are for identification purposes only and might be trademarks of their respective
companies. We disclaim any and all rights to those marks.

e The product name of Windows® 95 is Microsoft® Windows® 95.
o The product name of Windows® 98 is Microsoft® Windows® 98.
e The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me).
e The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server
e The product names of Windows® XP are as follows:
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Professional
e The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition
Microsoft® Windows ServerT™ 2003 Web Edition
o The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0
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Printing Multiple Document Pages per Sheet (Layout)
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Printing from the Last Page
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Printing Documents with an Overlay Image Superimposed (Overlay)
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Creating a New Overlay Set
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Using the User Guide

User Guide ' St andard

For screen reader

| # Contents | - Next f | I | | Settings |

Using and Removing User Guide > Using the User Guide

Using the User Guide

Read this manual carefully before you use this product and keep it handy for future reference. For safe and correct use,
please be sure to read the Safety Information before using the machine.

This section describes the items that appear in the User Guide.

Click to display the standard version of the User Guide.

Ve

Standard

Click to display the screen-reader version of the User Guide.

IR

For screen reader

Click to display the [Settings] page. On this page, you can select the display color and whether or not to
hide illustrations for procedures.

| 8 Settings |

Enter a word you want to search for.

| Search

If you point to a character string, it turns blue and is underlined. Click the string to jump to the linked
page.

(] TTammg and Eemowing the TTzer Ghnde 53
[ Printing 5
(% Printer Driver =
Click to display the contents.
| ﬁ Contents |
Click to display the previous topic.
| 4 Presvious -
Click to display the next topic.
- Hext |
Click to return to the top of the displayed page.

[+] Top |

If a description contains a hyperlink, the hyperlink appears at the bottom of each page.
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Using the User Guide

This User Guide describes procedures using Windows 2000 as an example. Procedures under other operating systems
may differ. Screens vary according to the operating environment.

pf Important |

o Contents of this manual are subject to change without prior notice. In no event will the company be liable for direct, indirect, special,

incidental, or consequential damages as a result of handling or operating the machine.

o Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

o Some illustrations in this manual might be slightly different from the machine.

o Certain options might not be available in some countries. For details, please contact your local dealer.

E' Top | 4 Previous - Next fi |
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Removing the User Guide

User Guide

For screen reader Standard
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Using and Removing User Guide > Removing the User Guide

Removing the User Guide

Follow the procedure below to remove the User Guide installed on your computer.
Removing the User Guide using its [Uninstall] function

1. Click [Start], and then point to [Programs].
2. Point to the installed [Product name], and then click [Uninstall].

3. Follow the instructions that appear to remove the User Guide.

Removing the User Guide using [Add/Remove Programs]

1. Open [My Computer], and then open [Control Panel].
2. Double-click [Add/Remove Programs].
3. Select the installed [Product name User Guide], and then click [Change/Remove].

4. Follow the instructions that appear to remove the User Guide.

o As well as removing the entire User Guide, you can also remove selected manuals from the guide.

|| Top | 4 Previous - Next ¢ |
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Printing on Various Paper Types

User Guide

For screen reader Standard
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Printing > Printing on Various Paper Types

Printing on Various Paper Types

The print method differs depending on the type of paper used for printing. Use a print method appropriate for each
paper type.

Related topics

Printing on Plain Paper

Printing on Thick Paper

Printing on Inkjet Plain Paper

Printing on Inkjet Transparency

Printing on Semi-gloss Photo Paper

Printing on Envelopes

|| Top | 4 Previous - Next f |
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Printing on Plain Paper

User Guide

For screen reader Standard
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Printing > Printing on Various Paper Types > Printing on Plain Paper

Printing on Plain Paper

Follow the procedure below to print on plain paper. Plain paper are fed from tray 1 or tray 2 (optional).
1. Load plain paper into tray 1 or tray 2 (optional).
2. Open the printer properties dialog box from the application.
3. On the [Setup] tab, click [Plain] in the [Paper type:] list.
4. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
5. Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application

o Paper Handling Precautions

o Loading Paper

|| Top | 4 Previous - Next i |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/0004.htm2005/10/05 12:06:13


javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();

Printing on Thick Paper

User Guide

For screen reader Standard
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Printing > Printing on Various Paper Types > Printing on Thick Paper

Printing on Thick Paper

Follow the procedure below to print on thick paper and label paper. Thick paper and label paper are fed from the
bypass tray.

o Paper heavier than 105 g/m2 (198.5 Ib.) is inserted into the bypass tray one sheet at a time. Paper lighter than that can be loaded into tray 1 or

tray 2 (optional).

o To use Paper lighter than 105 g/m? (198.5 Ib.), click [Plain] in the [Paper type:] list.

1. Open the printer properties dialog box from the application.
2. On the [Setup] tab, click [Thick] in the [Paper type:] list.
3. Make the necessary settings, and then click [OK].
A confirmation message appears.
4. Check the message, and then click [OK].
5. Make print settings, and then click [OK].

o The [Resume] key lights.

6. Slide the envelope selector to the rear position .

AGHINS

7. Slide the bypass tray guides into position according to the paper size.
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Printing on Thick Paper

AGKDRES

8. Insert a sheet of paper into the bypass tray with the print side face up.

AGHDRES
Printing starts when you push in the paper.
Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when
cleaning finishes.

v d |mportant

o When using the bypass tray, make sure sheet of paper is between the top and bottom of the bypass tray guides.

AGKDEES

o Paper can only be inserted one sheet at a time.
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Printing on Thick Paper

o Support the sheet with your hands to keep it from sliding out and dropping.

o Insert the sheet straight into the bypass tray.

= Reference

e Opening from an Application

e Paper Handling Precautions

|| Top | 4 Previous - Next fp |
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Printing on Inkjet Plain Paper

USEI' GUldE For screen reader Standard
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Printing > Printing on Various Paper Types > Printing on Inkjet Plain Paper

Printing on Inkjet Plain Paper

Follow the procedure below to print on Inkjet Plain Paper. Inkjet Plain Paper are fed from tray 1 or tray 2 (optional).
1. Load Inkjet Plain Paper into tray 1 or tray 2 (optional).
2. Open the printer properties dialog box from the application.
3. On the [Setup] tab, click [Inkjet Plain Paper] in the [Paper type:] list.

o Only one-sided printing is possible when [Inkjet Plain Paper] is selected. For duplex printing, click [Plain].

4. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
5. Make print settings, and then click [OK].

= Reference

o Opening from an Application

e Paper Handling Precautions

o Loading Paper

|| Top | 4 Previous - Next f |
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Printing on Inkjet Transparency

User Guide

For screen reader Standard
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Printing > Printing on Various Paper Types > Printing on Inkjet Transparency

Printing on Inkjet Transparency

Follow the procedure below to print on inkjet transparency.

Load inkjet transparency in tray 1.

o Printed inkjet transparencies take some time to dry. We recommend that you remove a printed inkjet transparency from the output tray before

the next inkjet transparency is delivered.
o The print delivery time interval can be set longer to avoid printed inkjet transparency from sticking together due to print wetness.
o Load A4/Letter size inkjet transparencies here.

o Load A4/Letter size paper in I (portrait) orientation.

1. Lift the output tray.

AGKDOSS
2. Pull out tray 1.

AGKD0E
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Printing on Inkjet Transparency

o Pull tray 1 completely out. Take care not to drop it.

3. Squeeze the paper guides on both sides, and then adjust them according to the paper size.

ACINE

o Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

4. Load inkjet transparency into tray 1 with the notched corner in the right front corner of the tray. Do not
load transparencies over the limit mark.

AGKD2S

o Curled inkjet transparency may jam. Straighten any curls before loading.
o If other paper is loaded, remove it, and then load inkjet transparency.

o To prevent the leading edge of transparencies from being scratched, place transparencies one at a time.

5. Squeeze the front end paper guide, and then slide it to meet the edge of the inkjet transparency.
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Printing on Inkjet Transparency

AGKDE1S

6. Push tray 1 gently in until it stops.

7. Lower the output tray.

AGKDEISE

8. Slide the envelope selector to the forward position D
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Printing on Inkjet Transparency

9. Open the printer properties dialog box from the application.
10. On the [Setup] tab, click [Inkjet Transparency] in the [Paper type:] list.
11. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
12. Make print settings, and then click [OK].

= Reference

e Opening from an Application

e For details about [Sheet-dry Print Delay...], see the printer driver Help.

e Paper Handling Precautions

E' Top | 4 Previous - Next f |
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Printing on Semi-gloss Photo Paper

User Guide
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Printing > Printing on Various Paper Types > Printing on Semi-gloss Photo Paper

Printing on Semi-gloss Photo Paper

Follow the procedure below to print on semi-gloss photo paper. Load semi-gloss photo paper in tray 1.

o Ad4/Letter size paper is loaded here.

o Load A4/Letter size paper in D (portrait) orientation.

1. Lift the output tray.

AGKI0S

o Pull tray 1 completely out. Take care not to drop it.

3. Squeeze the paper guides on both sides, and then adjust them according to the paper size.
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Printing on Semi-gloss Photo Paper

MGG

o Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

4. Load semi-gloss photo paper with the print side face down but not over the limit mark.

AGKI25

o The print side is rough and white-coated.

o Curled paper may jam. Straighten any curls before loading.

5. Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

AGKD3S
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Printing on Semi-gloss Photo Paper

6. Push tray 1 gently in until it stops.

AGKD145

7. Lower the output tray.

AGKDES

8. Slide the envelope selector to the forward position D

9. Open the printer properties dialog box from the application.
10. On the [Setup] tab, click [Semi-gloss Photo Paper] in the [Paper type:] list.
11. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
12. Make print settings, and then click [OK].
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Printing on Semi-gloss Photo Paper

o The output tray can hold up to 20 sheets of semi-gloss photo paper at a time.

= B Feferens

e Opening from an Application

e Paper Handling Precautions

|| Top | 4 Previous - Next f |
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Printing on Envelopes
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Printing > Printing on Various Paper Types > Printing on Envelopes

Printing on Envelopes

Follow the procedure below to print on envelopes. The envelopes are fed from tray 1.
1. Lift the output tray.

AGKD0S

o Pull tray 1 completely out. Take care not to drop it.

3. When printing on an envelope that has the flap on the long edge, fold the flap, and then load the
envelope with the flap to the right of the paper feed direction, print side down.
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Printing on Envelopes

AHCO015

o When printing on an envelope that has the flap on the short edge, leave the flap unfolded, and then load the envelope bottom-first,

print side down.

AGKI2IS

o You can load up to 30 envelopes.
o Before loading envelopes, make sure their edges are sharply creased by rubbing the edges with a pen or similar object.

o Load envelopes carefully because the printable area depends on the orientation.

4. Squeeze the paper guide release, and then slide the paper guides into position according to the paper size.

AHCO025
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Printing on Envelopes

5. Push tray 1 gently in until it stops.
6. Lower the output tray.
7. Slide the envelope selector to the rear position .

AGKEI1S
8. Open the printer properties dialog box from the application.
9. On the [Setup] tab, click [Envelope] in the [Paper type:] list.
10. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
11. Make print settings, and then click [OK].

= N Reference

e Opening from an Application

e Paper Handling Precautions

e Printable Area

ot Important |

o To print in reverse orientation in the printer driver settings, select the [Rotate by 180 degrees] check box on the [Page Settings] tab.

|| Top | 4 Previous - Next f |
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Canceling Printing
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Printing > Canceling Printing

Canceling Printing

Print jobs can be canceled from either a printer or computer. How to cancel print jobs differs according to their job
status. Check the job status first.

Canceling a print job being printed
Cancel the print job from the Printer Status monitor or by pressing the [Cancel] key of the printer.
Canceling a print job in queue

Cancel the print job from the taskbar of the computer.

Related topics

Canceling Printing from the Printer Status Monitor

Canceling Printing Using the [Cancel] Key of the Printer

Canceling Printing from the Taskbar

|| Top | 4 Previous - Next i |
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Canceling Printing from the Printer Status Monitor

User Guide

For screen reader Standard
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Printing > Canceling Printing > Canceling Printing from the Printer Status Monitor

Canceling Printing from the Printer Status Monitor

Follow the procedure below to cancel a print job being printed.
1. Check that printing and the Printer Status monitor have started.
2. Click [Stop Printing].

_Iol x|
Fi= name:
Repoit.benp
Sending data: 2727 / T323KE
Progeess: ﬁ
kT Stop Printing |
L
Dperational =]
Ready
I
E [zer Guide. . I
I 0K I Help

o It will take a few moments for printing to stop.

= N Reference

e Displaying the Printer Status

|| Top | 4 Previous - Next i |
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Canceling Printing Using the [Cancel] Key of the Printer

User Guide

For screen reader Standard
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Printing > Canceling Printing > Canceling Printing Using the [Cancel] Key of the Printer

Canceling Printing Using the [Cancel] Key of the Printer

Follow the procedure below to cancel a print job being printed.
1. Check that printing has started.

o Not only the print job being printed but also the print jobs in queue will be canceled.

o If you press the [Cancel] key while the printer is receiving print data for a print job (the [Power] key is blinking), that print job is

also canceled.

2. Press the [Cancel] key.

o It will take a few moments for printing to stop.

|| Top | 4 Previous « Next fp |
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Canceling Printing from the Taskbar

User Guide
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Printing > Canceling Printing > Canceling Printing from the Taskbar

Canceling Printing from the Taskbar

Follow the procedure below to cancel a print job in queue.
1. Double-click the icon of the printer on the taskbar.

2. Select the print job you want to cancel, and then click Cancel (Windows 98/Me: Cancel Printing) on the
Document menu.

|| Top | 4 Previous « Next fp |
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Adjusting Print Quality

User Guide
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Printing > Adjusting Print Quality

Adjusting Print Quality

Print quality and color tone can be adjusted to suit the print data.

Related topics

Printing Using Preset Print Quality Settings

Printing in Black and White

Saving Color Ink When Printing

Printing with Print Quality Settings You Want

Emphasizing Bold Type According to the Font Size

Changing the Method of Extracting TrueType Fonts

Printing Images Vividly

|| Top | 4 Previous - Next fp |
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Printing Using Preset Print Quality Settings

User Guide

For screen reader Standard
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Printing > Adjusting Print Quality > Printing Using Preset Print Quality Settings

Printing Using Preset Print Quality Settings

With preset print quality settings, you do not have to make print quality settings every time you print. Follow the
procedure below to print using a preset print quality setting.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, select a print quality setting in the [Print Quality] area.
3. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
4. Make print settings, and then click [OK].

= N Reference

e Opening from an Application

o For details about [Print Quality], see the printer driver Help.
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Printing in Black and White
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Printing > Adjusting Print Quality > Printing in Black and White

Printing in Black and White

Follow the procedure below to print using only black.

Since black and white printing is faster than color printing, it is efficient for printing color documents that do not need
to be printed in color. Also, the black produced by black and white printing is a more distinct black than that produced
by color printing.

o Be sure to select black and white printing if you specified black and white printing in an application.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [Black and White] in the [Color/Black and White] area.
3. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
4. Make print settings, and then click [OK].

= N Reference

e Opening from an Application
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Saving Color Ink When Printing

User Guide
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Printing > Adjusting Print Quality > Saving Color Ink When Printing

Saving Color Ink When Printing

Follow the procedure below to save color ink by printing graphics and images with less than the usual amount of ink.
Text is printed as usual so that it can remain clear and easy to read.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [Color] in the [Color/Black and White] area.
3. Select the [Level color] check box.
4. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
5. Make print settings, and then click [OK].

o Overall color, except for text, will be lighter.

o The color of text may be printed lighter depending on the application used.

= N Reference

e Opening from an Application
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Printing with Print Quality Settings You Want

User Guide
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Printing > Adjusting Print Quality > Printing with Print Quality Settings You Want

Printing with Print Quality Settings You Want

You can make print quality settings more in details.

Related topics

Changing Image Printing Method

Correcting the Hue of Digital Photos

Printing Low Resolution Images Smoothly

Changing the Dither Pattern

Using Error Diffusion

Changing the Color Profiling Pattern

Printing Grayscale Images Using Black or CMYK

Printing Text in Black

Using ICM

Adjusting Brightness, Contrast, and Saturation

Adjusting Color Balance

Printing a Whole Page as an Image

Changing the Image Data Process

Printing with Particular CMYK Colors
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Changing Image Printing Method
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Changing Image Printing Method

When printing images, the higher the resolution of images, the longer the time required for printing. Follow the
procedure below to print with priority on print quality or print speed.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. On the [Image Adjustments] tab, select an image printing method in the [Image processing priority] list.
5. Click [OK].
The [Change User Settings] dialog box closes.
6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
7. Make print settings, and then click [OK].

= Reference

e Opening from an Application

o For details about [Image processing priority], see the printer driver Help.
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Correcting the Hue of Digital Photos

Correct the hue of digital photos. This is effective especially for overexposed or underexposed images.

o Exposure is affected by the levels of light in which the photo was taken. If there are extreme light and shade differences between object and

background, the object may be underexposed (too dark) or overexposed (too light).

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].

The [Change User Settings] dialog box appears.
4. On the [Image Adjustments] tab, select the [Adjust photos and images] check box.

H
o If the [Adjust photos and images] check box is selected, the [Use ICM] check box is unavailable.

5. Click [OK].

The [Change User Settings] dialog box closes.
6. Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
7. Make print settings, and then click [OK].

= N Reference

e Opening from an Application
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Printing Low Resolution Images Smoothly

Follow the procedure below to print outlines of low resolution images, which often appear on Web pages, smoothly.
1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.

3. Click [Change...].
The [Change User Settings] dialog box appears.
4. On the [Image Adjustments] tab, select the [Smooth low resolution images] check box.
5. Click [OK].
The [Change User Settings] dialog box closes.
6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
7. Make print settings, and then click [OK].

=l Reference

e Opening from an Application
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Changing the Dither Pattern

A dither pattern is a pattern of dots used to simulate a color or shade of an image. If the pattern is changed, the
characteristics of the image will also change. Follow the procedure below to select a pattern suitable for the image to
be printed.

o Dithering is a technique where tiny dots are printed in patterns in order to create the illusion of tones and colors that cannot be physically

reproduced.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. On the [Image Adjustments] tab, select a dither pattern in the [Dithering] list.

o Thin lines may break depending on the pattern used. If this happens, select another pattern.

5. Click [OK].
The [Change User Settings] dialog box closes.

6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

7. Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application

o For details about [Dithering], see the printer driver Help.
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Using Error Diffusion

Error Diffusion is a type of dithering that produces halftones by printing dots densely for dark colors and diffusely for
light colors. Select the appropriate pattern for the image you want print.

i Limitation |

o Depending on the operating system or application, error diffusion may not be printed correctly.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. On the [Image Adjustments] tab, select the [Use error diffusion] check box.
5. Select the error diffusion target from the drop-down menu.
6. Click [OK].
The [Change User Settings] dialog box closes.
7. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
8. Make print settings, and then click [OK].

=l Reference

e Opening from an Application

o For details about [Dithering], see the printer driver Help.
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Changing the Color Profiling Pattern

Follow the procedure below to select a color profiling pattern to adjust the tone of colors for prints according to the
colors displayed on the computer screen.

Colors on the computer screen are expressed using the three RGB colors, but colors used for printing are composed of
the four CMYK colors. When printing, RGB colors are converted to CMYK colors.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. On the [Image Adjustments] tab, select a color profiling pattern in the [Color profile:] list.
5. Click [OK].
The [Change User Settings] dialog box closes.
6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
7. Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application

o For details about [Color profile:], see the printer driver Help.

e Color Guide
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Printing Grayscale Images Using Black or CMYK

Follow the procedure below to print black or gray parts of an image using black or CMYK.
1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.

4. On the [Image Adjustments] tab, select a gray reproduction method in the [Gray reproduction (Text/
Line Art):] list.

5. Click [OK].
The [Change User Settings] dialog box closes.

6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

7. Make print settings, and then click [OK].

= Reference

e Opening from an Application

o For details about [Gray reproduction (Text/Line Art):], see the printer driver Help.
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Printing Text in Black

Follow the procedure below to print text other than black in black. This is useful when text other than black looks
lighter when printed.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. On the [Image Adjustments] tab, select the [Print all texts in black] check box.
5. Click [OK].
The [Change User Settings] dialog box closes.
6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
7. Make print settings, and then click [OK].

= Reference

e Opening from an Application
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Using ICM

Follow the procedure below to correct colors using the Windows ICM (Image Color Matching) function.

o ICM is a color management system that adjusts colors between 1/O devices. Use this function to produce print results with colors as close as

possible to those displayed on the computer screen. To use this function, the color profile must be added to the printer.

e You can find the color profile in the ICM folder stored on the CD-ROM provided. For information about adding a color profile, search for

the words "color profile" in Windows Help, and then see the appropriate topic.

e This function is unavailable under Windows 95 or Windows NT 4.0.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. On the [Image Adjustments] tab, select the [Use ICM] check box.
H
o If the [Use ICM] check box is selected, the [Color profile:] list on the [Image Adjustments] tab is unavailable. Windows performs

color correction using the profile specified on the [Color Management] tab.

o If the [Use ICM] check box is selected, the [Adjust photos and images] check box is unavailable.

5. In the [ICM method:] and [ICM intent:] lists, select a color correction process.
6. Click [OK].
The [Change User Settings] dialog box closes.
7. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
8. Make print settings, and then click [OK].

= Reference

e Opening from an Application

o For details about [ICM method:] and [ICM intent:], see the printer driver Help.
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Adjusting Brightness, Contrast, and Saturation
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Adjusting Brightness, Contrast, and Saturation

Follow the procedure below to adjust brightness, contrast, and saturation for printing.
1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. Click the [Balance Adjustments] tab.

5. Adjust the brightness, contrast, and saturation.

o Make adjustments by moving the slider or clicking [-] or [+].

6. Click [OK].
The [Change User Settings] dialog box closes.

7. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

8. Make print settings, and then click [OK].

=l Reference

e Opening from an Application

o For details about [Brightness:], [Contrast:], and [Saturation:], see the printer driver Help.
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Adjusting Color Balance

Follow the procedure below to adjust color balance by changing the mixture of red (R), green (G), and blue (B).
1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. Click the [Balance Adjustments] tab.
5. Adjust color balances.
o Make adjustments by moving the slider or clicking [-] or [+]. Click [+] and [®] to move all sliders at the same time.
o Cyan (C) and red (R), magenta (M) and green (G), and yellow (Y) and blue (B) are pairs of complementary colors.
6. Click [OK].
The [Change User Settings] dialog box closes.
7. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
8. Make print settings, and then click [OK].
Q Complementary Colors
It is helpful to understand the concept of complementary colors when adjusting color balance. When two
primary colors of the primary colors of light (RGB) or primary colors of pigment (CMY) are mixed, the
resulting color is the complimentary color of the remaining primary color. Red and cyan, green and
magenta, and blue and yellow are pairs of complementary colors.
Q Hints for Adjusting Color Balance
The following methods are available to make a specific color stronger: decreasing the color's
complementary color or decreasing the other colors (that is, decreasing complementary colors relatively).
A combination of both methods can be used.
For example, to make red more vivid, make red stronger (by decreasing cyan) or decrease green and blue
(making magenta and yellow stronger). The more red is used, the brighter the image looks. This is useful to
adjust the color of a dark image. On the contrary, the less green and blue are used, the duller the image
looks. Use this method to make a bright image dull.
= | Feference
e Opening from an Application
o For details about [Color balance:], see the printer driver Help.
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Printing a Whole Page as an Image

This section explains how to convert a print job to image data using a Windows application, and then print the image
using the printer driver. Follow the procedure below to print a whole page as an image. This will allow you to get print
results that resemble the display image more closely. Since more data has to be processed, printing will take much
longer. Use this function if the printed image differs from the display image.

o Black or gray parts will be printed with the four CMYK colors regardless of the settings made in the [Gray reproduction (Text/Line Art):] list

on the [Image Adjustments] tab in the [Change User Settings] dialog box.

o This setting overrides the watermark setting.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. Click the [Misc.] tab.
5. Select the [Print as bitmap] check box.
6. Click [OK].
The [Change User Settings] dialog box closes.
7. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
8. Make print settings, and then click [OK].

= N Reference

e Opening from an Application

e Printing Images or Text Superimposed on Prints
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Changing the Image Data Process

Depending on the application, there may be cases where printing takes a long time or colors are not printed correctly.
Follow the procedure below to change the image data process to solve the problem.

o Since changing the image data processing method may cause printing not to be performed correctly with some applications, you should

normally leave this option unselected.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. Click the [Misc.] tab.
5. Select the [Change data processing] check box.
6. Click [OK].
The [Change User Settings] dialog box closes.
7. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
8. Make print settings, and then click [OK].

= Reference

e Opening from an Application
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Printing with Particular CMYK Colors

Normally full color (CMYK) is used for color printing. Follow the procedure below to print using particular CMYK
colors.

o These settings are unavailable when black and white printing is specified.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. Click the [Misc.] tab.

5. In the [Separate into CMYK, then print in designated color only] area, select colors.

o Select colors you want to use.

6. Click [OK].
The [Change User Settings] dialog box closes.

7. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

8. Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application
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Emphasizing Bold Type According to the Font Size

You can emphasize bold type according to the font size.
!

e This function is not available under Windows 95/98/Me.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].
The [Change User Settings] dialog box appears.
4. Click the [Misc.] tab.
5. Select the [Increase bold with font size] check box.
6. Click [OK].
The [Change User Settings] dialog box closes.
7. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
8. Make print settings, and then click [OK].

= N Reference

e Opening from an Application
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Changing the Method of Extracting TrueType Fonts

This is useful for correcting garbled or incorrectly printed characters.

s o |mportarnt

o If you perform [Reduce/Enlarge] together with this function, printed text may be of reduced quality.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, click [User settings] in the [Print Quality] area.
3. Click [Change...].

The [Change User Settings] dialog box appears.
4. Click the [Misc.] tab.
5. Select the [Change methods to extract TrueType fonts] check box.
6. Click [OK].

The [Change User Settings] dialog box closes.
7. Make the necessary settings, and then click [OK].

The printer properties dialog box closes.
8. Make print settings, and then click [OK].

= N Reference

e Opening from an Application
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Printing Images Vividly

By changing the printer properties settings or using special paper, vivid images can be printed.

Changing the printer properties settings
Prints can be made with priority on print quality. Change print quality settings in the printer properties dialog
box.

Using special paper
Printing on special paper will look more vivid compared to printing on plain paper. Use inkjet plain paper or

semi-gloss photo paper.

= Reference

e Printing Using Preset Print Quality Settings

¢ Recommended Consumables
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Various Print Functions

By using various print functions, you can make prints appropriate for your purposes.

= B Feferen=s

e Printing on Various Paper Types

Related topics

Printing Multiple Document Sets

Collating
Printing Web Pages

Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Reducing to A4/Letter Automatically

Reducing to A3/11" x 17" Automatically

Rotating the Image by 180 Degrees

Printing on Registered Custom Size Paper

Printing on Unregistered Custom Size Paper

Printing on Both Sides of Paper

Printing Multiple Document Pages per Sheet (Layout)

Splitting the Document Image across Multiple Sheets (Poster)

Printing from the Last Page

Creating a Binding Margin

Printing Documents with a Header and Footer

Printing with a Layout Suitable for Making Booklets

Printing Images or Text Superimposed on Prints

Printing Documents with an Overlay Image Superimposed (Overlay)
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Printing Multiple Document Sets
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Printing > Various Print Functions > Printing Multiple Document Sets

Printing Multiple Document Sets

Follow the procedure below to print multiple sets of the same document.

i Limitation |

o Depending on the application, this setting may not be available.

o If you do not use the Collate function, prints will be delivered in page batches (P1, P1, P2, P2 ...). If you use the Collate function, prints will

be delivered in document batches (P1, P2, P1, P2 ...).

Open the file you want to print from the application, and then open the printer properties dialog box.

Click the [Page Settings] tab.
In the [Copies] box, enter the number of sets you want to print between 1 and 999.

b=

Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
5. Make print settings, and then click [OK].

= B Feferen=s

o Collating

e Opening from an Application
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Collating
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Printing > Various Print Functions > Collating

Collating

Follow the procedure below to print complete sets of prints one set at a time when printing multiple sets such as for
presentation materials.

i Limitation |

e Depending on the application, this setting may not be usable.

o Even when using the Collate function with Layout, Poster, or Duplex, document boundaries are correctly recognized so problems like the

first page and last page being printed on the same sheet do not occur.

Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Page Settings] tab.

In the [Copies] box, enter the number of sets you want to print between 1 and 999.

Select the [Collate] check box.

Make the necessary settings, and then click [OK].

A

The printer properties dialog box closes.
6. Make print settings, and then click [OK].

=l Reference

e Opening from an Application
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Printing Web Pages
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Printing Web Pages

Use the procedures described below to make settings for printing Web pages.

When a Web page is printed, it may not fit on the paper used or it may not be printed as it looks on the screen. Use the
information below to print Web pages correctly.

Printing low resolution images smoothly

Images displayed on Web sites tend to be low resolution images to reduce data size. Before printing, be sure to
make the setting to print low resolution images smoothly.

Fitting a whole Web page to the paper size
If a whole Web page cannot be printed on the paper size used, reduce it using [Fit to paper size] or [Scale] under
the [Reduce/Enlarge] function.
If [A3 (297 x 420 mm)] or [B4 JIS (257 x 364 mm)] is selected for [Original size:] and [Reduce automatically
to fit A4 (210 x 297 mm )] in the [Auto reduce] list is selected, print image is automatically reduced to fit A4
size paper.
If [11" x 17"] or [Legal (8 1/," x 14")] is selected for [Original size:] and [Reduce automatically to fit Letter (8

1/," x 11")] in the [Auto reduce] list is selected, print image is automatically reduced to fit Letter size paper.

e When a Web page is printed over multiple sheets, images or text where any two sheets are connected may not be printed.

Printing the background color of a Web page

The background color of a Web page may not be printed. Make the settings to print the background color using
a Web browser.

Internet Explorer
1. On the [View] or [Tools] menu of the browser, click [Internet Options...].
2. Click the [Advanced] tab.
3. In the [Settings] list, select the [Print background colors and images] check box under [Printing].
4. Click [OK].

Netscape Navigator
1. On the [File] menu of the browser, click [Page Setup].

2. On the [Format & Options] tab, select the [Print Background (colors & images)] check box in the
[Options] area.

3. Click [OK].

= B Feferen=s

e Printing Low Resolution Images Smoothly

e Reducing and Enlarging to Fit the Paper Size (Fit to paper size)
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Printing Web Pages

e Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

o Reducing to A4/Letter Automatically
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Printing > Various Print Functions > Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Reducing and Enlarging to Fit the Paper Size (Fit to paper size)

Follow the procedure below to print document pages reduced or enlarged to fit the paper size. By specifying a
document and paper size, an appropriate reduction or enlargement ratio is selected automatically. This is useful when
reducing or enlarging from or to standard paper sizes such as when reducing an A3/11" x 17" document to A5/5 1/," x

8 1/," paper.
1. Open the file you want to print from the application, and then open the printer properties dialog box.

2. Click the [Page Settings] tab.
3. Check that the document orientation and size are the same as those selected in the application.

o Usually the settings made in the application are reflected here; however, it depends on the application used. If they are not reflected,

make the correct settings.

4. Select the [Reduce/Enlarge] check box, and then click [Fit to paper size] in the list.
5. In the [Printout paper size:] list, select a paper size.

Select the size of paper loaded in the paper tray.

o An automatically selected ratio appears in the [Scaling(%):] box.

6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
7. Make print settings, and then click [OK].

= N Reference

e Opening from an Application
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Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)
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Printing > Various Print Functions > Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

Reducing and Enlarging by a Specified Ratio (Scale, Directional magnification)

8.

Follow the procedure below to print with a reduction or enlargement ratio in the range of 20-300% adjustable in 1%
increments. Use this to reduce the size of the print image slightly to insert a margin, for example.

Two methods are available: scale and directional magnification. Scale is used to specify the same ratio in both
horizontal and vertical directions while directional magnification is used to specify a different ratio for each direction.

1.
2.
3.
4.

Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Page Settings] tab.
Select the [Reduce/Enlarge] check box, and then click [Scale] or [Directional magnification...] in the list.

If [Scale] is selected, enter a ratio in the [Scaling(%):] box.

o Enter a number between 20 and 300.

o In the [Printout paper size:] list, you can change the paper size.

If [Directional magnification...] is selected, enter ratios in the [Vertical:] and [Horizontal:] boxes, and
then click [OK].

. Select the [Centering] check box to center an image.

o If [Scale] or [Directional magnification...] is selected, a wide margin may be created on the right or bottom of the paper. If this

happens, select the [Centering] check box to center an image and create margins of the same width.

o If the [Centering] check box is not selected, the reduced or enlarged image is positioned in the upper left of the paper.

Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application
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Reducing to A4/Letter Automatically
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Reducing to A4/Letter Automatically

6.

Follow the procedure below to print a document larger than A4/Letter onto A4/Letter size paper by reducing it. For
example, if a document is A3/11" x 17" size, it can be automatically reduced to A4/Letter and printed.

1.

Open the file you want to print from the application it was created in, and then open the printer
properties dialog box.

2. Click the [Page Settings] tab.

3. Check the document orientation and size are the same as those selected in the application.

o Normally, settings made in the application are reflected here; however, this may not be the case depending on the application used.

If necessary, make the correct settings.

In the [Printout paper size:] list, [Reduce to fit A4]/[Reduce to fit Letter] appears.

o If [Reduce to fit A4]/[Reduce to fit Letter] does not appear, select the [Auto reduce] check box, and then select [Reduce

automatically to fit A4 ( 210 x 297 mm )}/[Reduce automatically to fit Letter (8 1/," x 11")] in the [Auto reduce] list.

4. Click [OK].

Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
Make print settings, and then click [OK].

If you do not want to reduce images from documents larger than A4/Letter, clear the [Auto reduce] check box in the [Printer Configuration]

dialog box. This is useful if you want to print document images at full size even if they run off the paper.

= B Feferens

Opening from an Application

For details about [Auto reduce], see the printer driver Help.
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Reducing to A3/11" x 17" Automatically

Follow the procedure below to print a document larger than A3/11" x 17" onto A3/11" x 17" size paper by reducing it.
For example, if a document is A2/17" x 22" size, it can be automatically reduced to A3/11" x 17" and printed.

1. Open the file you want to print from the application it was created in, and then open the printer
properties dialog box.

2. Click the [Page Settings] tab.

3. Check t the document orientation and size are the same as those selected in the application.

o Normally, settings made in the application are reflected here; however, this may not be the case depending on the application used.

If necessary, make the correct settings.

In the [Printout paper size:] list, [Reduce to fit A3]/[Reduce to fit 11" x 17"] appears.

o If [Reduce to fit A3]/[Reduce to fit 11" x 17"] does not appear, select is [Auto reduce] check box, and then select [Reduce

automatically to fit A3 (297 x 420 mm )]/[Reduce automatically to fit 11" x 17"] in the [Auto reduce] list.

4. Click [OK].

5. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

6. Make print settings, and then click [OK].

o If you do not want to reduce images from documents larger than A3/11" x 17", clear the [Auto reduce] check box in the [Printer

Configuration] dialog box. This is useful if you want to print document images at full size even if they run off the paper.

= B Feferen=s

e Opening from an Application

o For details about [Auto reduce], see the printer driver Help.
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Rotating the Image by 180 Degrees

Follow the procedure below to print images rotated by 180 degrees. Use this function if paper loaded in the paper tray
has a distinct top and bottom and printing with the paper in that orientation would otherwise make the image upside-

down.
1. Open the file you want to print from the application, and then open the printer properties dialog box.

2. Click the [Page Settings] tab.

3. Select the [Rotate by 180 degrees] check box.

4. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

5. Make print settings, and then click [OK].

= B Feferens

e Opening from an Application
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Printing on Registered Custom Size Paper

10.
11.
12.

Follow the procedure below to print on registered custom size paper.
i B P reparation

o Register the size of the custom size paper loaded in the paper tray in the [Printer Configuration] dialog box.

. Open the [Page Setup] dialog box from the application.

The [Page Setup] dialog box is usually opened by clicking [Page Setup...] on the [File] menu, but the method to
open it may differ in some applications. Open the dialog box according to the application being used.

2. Open the printer properties dialog box from the [Page Setup] dialog box.
3. Click the [Page Settings] tab.

4. In the [Original size:] list, select a custom paper size.

Select from the sizes already registered.
Click [Portrait] or [Landscape].

Select the orientation that matches the document orientation and feeding direction.

6. Click the [Setup] tab.
7. Check that the tray with the paper you want to print on is selected in the [Paper source tray:] list.

8. Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

Check that the orientation selected in the [Setup] dialog box of the application is the same as that
selected in step 5..

If it is not, make the correct setting.
Close the [Page Setup] dialog box of the application.
Create a file in the application.

In the printer properties dialog box, make the print settings for the printer selected in step 2., and then
click [OK].

= Reference

e Opening from an Application

o For details about [Custom Paper Sizes], see the printer driver Help.
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Printing on Unregistered Custom Size Paper

Follow the procedure below to print on unregistered custom size paper.
1. Open the [Page Setup] dialog box from the application.

The [Page Setup] dialog box is usually opened by clicking [Page Setup...] on the [File] menu, but the method to
open it may differ in some applications. Open the dialog box according to the application being used.

2. Open the printer properties dialog box from the [Page Setup] dialog box.
3. Click the [Page Settings] tab.
4. In the [Original size:] list, click [Custom paper size...].
The [Custom Paper Size] dialog box appears.
5. In the [Long edge:] and [Short edge:] boxes, enter values.

o To change the measurement unit, click [Measurement Unit...].

6. In the [Paper source tray:] list, select a paper tray.
7. In the [Paper Position in Tray] area, select a paper orientation.
8. Click [OK].

o To register the paper size as a custom paper size, click [Open [Custom Paper Sizes]...].

9. Click the [Setup] tab.
10. Check that the tray with the paper you want to print on is selected in the [Paper source tray:] list.
11. Click the [Page Settings] tab.
12. Click [Portrait] or [Landscape].
Select the orientation that matches the document orientation and feeding direction.
13. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

14. Check that the orientation selected in the [Page Setup] dialog box of the application is the same as that
selected in step 12..

If it is not, make the correct setting.
15. Close the [Page Setup] dialog box of the application.
16. Create a file in the application.

17. In the printer properties dialog box, make the print settings for the printer selected in step 2., and then
click [OK].

=l Reference

e Opening from an Application

o For details about [Custom Paper Sizes], see the printer driver Help.
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Printing on Both Sides of Paper

Follow the procedure below to print on both sides of paper.

i Limitation |

o Only plain paper can be printed on both sides.

o If the page size varies within a document, a page break will occur before the page where the size changes.
e We recommend one-sided printing for documents containing areas of heavy, solid color image.
o If two-sided prints fail to dry fully, set a print-dry delay using the printer driver.

o If two-sided prints stick or jam, use single-sided printing.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. Click the [Edit] tab.
3. Select the [Duplex/Booklet] check box.

o If you select the [Create margin] check box when printing on plain paper, the machine automatically reduces the size of the page

images and centers them on the paper.

4. Click the icon representing the binding method you want to use.

o The icons are displayed in either landscape or portrait depending on the document orientation.

5. Select the [Header/Footer/Adjust image position/Binding margins] check box to create a binding margin.
Click [Details...] to specify a margin in the [Binding Margins for Duplex Printing] area.

6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

7. Make print settings, and then click [OK].

= Reference

e Opening from an Application

e Printing with a Layout Suitable for Making Booklets

e Creating a Binding Margin
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Printing Multiple Document Pages per Sheet (Layout)

Follow the procedure below to print multiple document pages per sheet.

e When using Layout, a suitable reduction or enlargement ratio is selected automatically based on the paper size and the number of pages you

want to fit on each sheet.
o If the page orientation varies within a document, a page break will occur before a page where the orientation changes.

o If an equivalent function is available from your application, do not use it. Use the function that can be set in the printer properties.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. Click the [Edit] tab.

3. Select the [Layout/Poster] check box, and then select the number of document pages you want to fit on
each sheet in the list.

o Do not click [Poster] since it is a different function.

4. Click the icon that matches the page flow you want to use.

o The icons show the available page flows for the number of pages selected.

o The icons are displayed in either landscape or portrait depending on the document orientation.

5. Select the [Draw border] check box to print borders.

6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.

7. Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application
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Splitting the Document Image across Multiple Sheets (Poster)

Follow the procedure below to print a single document page over multiple sheets to make a poster size print.

o The enlargement ratio used is based on the specified paper size and the number of sheets you want to split the image over.

o Prints are made with a 15 mm (0.6 inches) overlap margin. When pasting sheets together, overlap them to hide this margin.

Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Edit] tab.
Select the [Layout/Poster] check box, and then click [Poster] in the list.

Click the icon representing the number of sheets you want to split the image over.

o The icons are displayed in either landscape or portrait depending on the document orientation.

b=

5. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
6. Make print settings, and then click [OK].

= Reference

e Opening from an Application
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Printing from the Last Page

Follow the procedure below to start printing from the last page of a document. Use this function when prints come out
face up in the output tray. This allows a printed document to be assembled in page order.

o If an equivalent function is available from your application, do not use it. Use the function that can be set in the printer properties.

Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Page Settings] tab.

Select the [Reverse order printing] check box.

Make the necessary settings, and then click [OK].

Eall e

The printer properties dialog box closes.
5. Make print settings, and then click [OK].

= Reference

o Opening from an Application
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Creating a Binding Margin

Follow the procedure below to print with a binding margin. If you create a binding margin, it is offset from the
document margin set from the application.

o Since the margin opposite the binding margin will be shifted toward the paper edge, be sure to make this margin wide enough when making

the document.

o If a binding margin is set in an application, do not make this setting in the printer properties. This would result in a binding margin twice as

wide as expected.

Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Edit] tab.

Select the [Header/Footer/Adjust image position/Binding margins] check box.

Click [Details...].

The [Header/Footer/Adjust image position/Binding margins] dialog box appears.

b=

5. In the [Adjust Image Position] area, select the direction in which you want to shift the print area in the
[Direction:] list.

o Margins (top, bottom, left, right) change according to the selected direction.

6. Enter a binding margin width, and then click [OK].

o To change the measurement unit, click [Measurement Unit...].

7. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
8. Make print settings, and then click [OK].

= B Feferens

e Opening from an Application
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Printing Documents with a Header and Footer
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Printing > Various Print Functions > Printing Documents with a Header and Footer

Printing Documents with a Header and Footer

Follow the procedure below to print documents with character strings in the top and bottom margins.

o Besides date, page number, and file name, text of up to 32 characters can be inserted into these areas.
o If you print a document using the Reduce/Enlarge function, the header and footer will also be reduced or enlarged.

o A header and footer will be printed on every page. For example, if you print several document pages on a sheet of paper (Layout), a header

and footer will appear for every page.

o If a header and footer are set in an application, do not make this setting in the printer properties.

Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Edit] tab.

Select the [Header/Footer/Adjust image position/Binding margins] check box.

Click [Details...].

The [Header/Footer/Adjust image position/Binding margins] dialog box appears.

Db =

5. In the [Header/Footer] area, make the necessary settings, and then click [OK].

o If the same position is selected for the date and time, page number, or text, the printing order is as follows: date and time, text, page

number.

6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
7. Make print settings, and then click [OK].

= B Feferen=s

e Opening from an Application
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Printing with a Layout Suitable for Making Booklets
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Printing > Various Print Functions > Printing with a Layout Suitable for Making Booklets

Printing with a Layout Suitable for Making Booklets

Follow the procedure below to print on both sides of paper using a layout suitable for making booklets.

e There are two kinds of booklet layout: [Booklet 1] and [Booklet 2]. With [Booklet 1], each sheet is folded in half separately, then the folded

sheets are stacked and bound. With [Booklet 2], the whole stack is folded in half in a similar way to a magazine.

Open the file you want to print from the application, and then open the printer properties dialog box.
Click the [Edit] tab.

Select the [Duplex/Booklet] check box.

Click the icon representing the booklet format you want to use.

o The icons are displayed in either landscape or portrait depending on the document orientation.

Eall e

5. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
6. Make print settings, and then click [OK].

= Reference

e Opening from an Application

e Printing on Both Sides of Paper
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Printing Images or Text Superimposed on Prints
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Printing > Various Print Functions > Printing Images or Text Superimposed on Prints

Printing Images or Text Superimposed on Prints

Follow the procedure below to print an image or text superimposed on prints. The image or text is referred to as a
watermark.

o A watermark made up of a bitmap file (extension .bmp) is referred to as an image watermark. A watermark made up of text data is referred to

as a text watermark. You cannot use both together.

e Various predefined watermarks are provided. You can also create your own watermarks.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. Click the [Edit] tab.
3. Select the [Watermarks/Overlay] check box, and then select a watermark in the list.

o To edit the watermark, click [Edit...].

o To create a new watermark, click [Add Bitmap...] or [Add Text...].

4. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
5. Make print settings, and then click [OK].

= N Reference

e Opening from an Application

Related topics

Creating a New Watermark
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Printing > Various Print Functions > Printing Images or Text Superimposed on Prints > Creating a New Watermark

Creating a New Watermark

Follow the procedure below to create a new watermark.

o There are two kinds of watermarks: image watermarks made up of a bitmap file (extension .bmp) and text watermarks made up of text data.

Open the printer properties dialog box.

Click the [Edit] tab.

Select the [Watermarks/Overlay] check box.

Click [Add Bitmap...] to create an image watermark, or click [Add Text...] to create a text watermark.
Make the necessary settings in the [Add Bitmap Watermark] or [Add Text Watermark] dialog box, and
then click [OK].

The watermark is registered and added to the list.

A e

= Reference

o Opening from the Start Menu

e Opening from an Application

e Printing Images or Text Superimposed on Prints
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Printing Documents with an Overlay Image Superimposed (Overlay)
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay)

Printing Documents with an Overlay Image Superimposed (Overlay)

Follow the procedure below to print a document with an overlay image superimposed.

o Before printing using the Overlay function, an overlay image file and overlay set must be created.

o A superimposing image will be aligned with the document page at the upper left corner. If the document to be printed and superimposing

image differ in size and orientation, the superimposing image may be cut or run off.

e Depending on the application, you may not get the expected result.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. Click the [Edit] tab.
3. Select the [Watermarks/Overlay] check box, and then select an overlay set in the list.

o To edit the overlay set, click [Edit...].

o To create a new overlay set, click [Add Overlay....].

4. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
5. Make print settings, and then click [OK].

ﬁ Overlay image file:

Data saved in a format allowing it to be used as a superimposing image.

Q Overlay set:

An overlay image file and setting details (such as how and which page an overlay image is superimposed on) are
combined, named, and registered as a set. Each set registered is called an overlay set.

When printing, select an overlay set.

= B Feferen=s

e Opening from an Application

Related topics

Creating a New Overlay Image File

Deleting an Overlay Image File
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Creating a New Overlay Set
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Creating a New Overlay Image File

Follow the procedure below to create an overlay image file.

e You can create an overlay image file with any application.

e When an overlay image file is created using a multiple-page document, only the first page will be saved as an overlay image.

1. Open the file with which you want to create an overlay image file, and then open the printer properties
dialog box.

2. On the [Setup] tab, click [Save as Overlay Data...] in the [Job type:] list.
The [Job Type Details] dialog box appears.

3. In the [File name:] box, enter a file name.

o Enter a name using up to 32 characters.

o Under Windows 95/98/Me, enter a name using up to eight characters.

4. Click [OK].
5. Make the necessary settings, and then click [OK].

The printer properties dialog box closes.

o When creating an overlay image file (when [Save as Overlay Data...] is selected in the [Job type:] list), only print quality settings are
available.
6. Click [OK] in the [Print] dialog box.

The overlay image file is created.

= B Feferen=s

e Opening from an Application
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Deleting an Overlay Image File
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay) > Deleting an Overlay Image File

Deleting an Overlay Image File

b

Follow the procedure below to delete an overlay image file.
1.

Open the printer properties dialog box.

2. On the [Setup] tab, click [Save as Overlay Data...] in the [Job type:] list.
3.
4. Click [Delete].

Select the overlay image file you want to delete.

A confirmation message appears.
Click [OK].

The overlay image file is deleted.

e You can also delete overlay image files (extension .rpo) using Windows Explorer.

= Reference

o Opening from the Start Menu

e Opening from an Application
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Creating a New Overlay Set
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Printing > Various Print Functions > Printing Documents with an Overlay Image Superimposed (Overlay) > Creating a New Overlay Set

Creating a New Overlay Set

Follow the procedure below to combine an overlay image file and setting details (such as how and which page an
overlay image is superimposed on), name it, and register it as a set. Each set registered is called an overlay set.

o For printing the same overlay image with different setting details, set different combinations of setting details for the same overlay image

file, and then register each set as a different overlay set.

Open the printer properties dialog box.

Click the [Edit] tab.

Select the [Watermarks/Overlay] check box.

Click [Add Overlay....].

In the [Add Overlay] dialog box, make the necessary settings, and then click [OK].

A

The overlay set is registered and added to the list.

= N Reference

e Opening from the Start Menu

e Opening from an Application
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Printing > Custom Settings

Custom Settings

In [Custom Settings:], frequently used printer properties settings can be registered as a custom setting.

Since custom settings can be saved in a file and recalled from that file, multiple users can share that file to print with
the same printer properties settings.

Related topics

Printing

Registering

Changing the Name

Deleting

Updating Custom Settings According to the Current Printer Configuration

Changing the Custom Settings Display Order

Saving a Registered Custom Setting in a File

Registering a Custom Setting Using a Custom Setting File
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Printing > Custom Settings > Printing

Printing

Follow the procedure below to print with the registered custom settings.

i B P reparation

o The printer configuration settings must be made beforehand.

1. Open the file you want to print from the application, and then open the printer properties dialog box.
2. On the [Setup] tab, select a setting in the [Custom Settings:] list.
Click [No setting] to print with the standard settings.

3. On the [Page Settings] tab, check that the document orientation and size are the same as those selected in
the application.

o Usually the settings made in the application are reflected here; however, it depends on the application used. If they are not reflected,

make the correct settings.

4. To print multiple sets, enter the number of sets in the [Copies] box.
5. On the [Setup] tab, click [Normal Print] in the [Job type:] list.

o A paper tray and paper type are included in a registered custom setting. If you want to print on paper that is different from the one in

the selected custom setting, you can select the paper tray and paper type you want to use on the [Setup] tab.

6. Make the necessary settings, and then click [OK].
The printer properties dialog box closes.
7. Make print settings, and then click [OK].

= N Reference

o For details about specifying the installed options, see the printer driver Help.

e Opening from an Application
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Registering

Follow the procedure below to register a new custom setting.

o Up to 16 custom settings can be registered.

1. Open the printer properties dialog box.
2. Click the [Setup], [Page Settings], or [Edit] tab.

3. In the [Custom Settings:] list, select the custom setting on which you want to base the new custom setting.

o To base the new setting on the default settings, click [No setting].

o When creating a new custom setting based on an existing custom setting, select the custom setting from which you can make the
new setting with the least changes.
4. Make the settings on the [Setup], [Page Settings], and [Edit] tabs.
!
o Settings not included in a custom setting are as follows: [Job type:] on the [Setup] tab, [Original orientation:], [Original size:],
[Printout paper size:], and [Copies] on the [Page Settings] tab, and all settings in the [Printer Configuration] dialog box.
5. Click [Save...].

The [Save New Custom Setting] dialog box appears.

6. In the [Custom Setting name:] box, enter a custom setting name.

o Up to 36 characters can be entered.

7. Click [OK].
The custom setting is registered and added to the list.
8. Click [OK].

The printer properties dialog box closes.

= B Feferen=s

e Opening from the Start Menu

e Opening from an Application
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Printing > Custom Settings > Changing the Name

Changing the Name

Follow the procedure below to change a name of a registered custom setting.
1. Open the printer properties dialog box.
2. Click the [Setup], [Page Settings], or [Edit] tab.
3. Click [Manage...].
The [Manage Custom Settings] dialog box appears.

4. Select the custom setting whose name you want to change.

o [No setting] cannot be changed.

5. In the [Custom Setting name:] box, enter a new name.

o Up to 36 characters can be entered.

6. Click [Close].
The custom setting name is changed.
7. Click [OK].

The printer properties dialog box closes.

= Reference

e Opening from the Start Menu

e Opening from an Application
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Printing > Custom Settings > Deleting

Deleting

Follow the procedure below to delete a registered custom setting.

o If you delete the custom settings that were registered automatically during installation of the printer driver, they will reappear when the

custom settings display is updated.

1. Open the printer properties dialog box.
2. Click the [Setup], [Page Settings], or [Edit] tab.
3. Click [Manage...].

The [Manage Custom Settings] dialog box appears.

4. Select the custom setting you want to delete.

o [No setting] cannot be deleted.

5. Click [Delete Custom Setting].
A confirmation message appears.

6. Click [OK].

7. Click [Close].

8. Click [OK].

The printer properties dialog box closes.

= B Feferens

e Opening from the Start Menu

e Opening from an Application
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Updating Custom Settings According to the Current Printer Configuration
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Printing > Custom Settings > Updating Custom Settings According to the Current Printer Configuration

Updating Custom Settings According to the Current Printer Configuration

There are two kinds of custom settings displayed in the printer properties dialog box: those registered automatically
during installation of the printer driver and custom settings added later by the user. Since these custom settings are not
deleted automatically, depending on the installed options, some custom settings that cannot be used to print may
remain.

To keep only custom settings that can be used with the options installed, follow the procedure below to update custom
settings after you install or uninstall options. The following is how each kind of custom settings will be updated:

o Custom settings registered automatically during printer driver installation
Custom settings that can still be used remain registered. Custom settings that cannot be used are deleted.
o Custom settings registered by user

Custom settings that cannot be used are deleted. Deleted custom settings cannot be recovered.
o If bidirectional communication is not working, you must configure installed options in the [Printer Configuration] dialog box before

performing this procedure.

1. Open the printer properties dialog box.
2. Click the [Setup], [Page Settings], or [Edit] tab.
3. Click [Manage...].

The [Manage Custom Settings] dialog box appears.
4. Click [Refresh Printer Information].

o If bidirectional communication is working, printer configuration settings in the [Accessories] area and custom settings in the

[Custom Settings:] list are updated.

o If bidirectional communication is not working, custom settings in the [Custom Settings:] list are updated according to the current

printer configuration settings in the [Accessories] area.

5. Click [Close].
6. Click [OK].

The printer properties dialog box closes.

= Reference

e Checking Whether Bidirectional Communication is Working or Not

o For details about [Printer Configuration], see the printer driver Help.

e Opening from the Start Menu

e Opening from an Application
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Changing the Custom Settings Display Order

Follow the procedure below to change the display order in the [Custom Settings:] list. For optimal ease-of-use, change
the order according to the setting type and how often you use them.

1. Open the printer properties dialog box.
2. Click the [Setup], [Page Settings], or [Edit] tab.
3. Click [Manage...].

The [Manage Custom Settings] dialog box appears.

4. Select the custom setting you want to move.

o [No setting] cannot be moved.

5. Click [Move Up] or [Move Down].
6. Click [Close].
7. Click [OK].

The printer properties dialog box closes.

= N Reference

e Opening from the Start Menu

e Opening from an Application
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Saving a Registered Custom Setting in a File

Follow the procedure below to save a registered custom setting in a custom setting file.
!

o Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, this function is unavailable.

1. Open the printer properties dialog box.
2. Click the [Setup], [Page Settings], or [Edit] tab.
3. Click [Manage...].

The [Manage Custom Settings] dialog box appears.
4. Select the custom setting you want to save.
5. Click [Save Custom Setting...].

The [Save Custom Setting] dialog box appears.
6. In the [File name:] box, enter a file name.

o Up to eight characters can be entered.

o The extension is .rst.

7. Click [OK].

The [Save Custom Setting] dialog box closes. The custom setting is saved in a custom setting file.

= B Feferen=s

e Opening from the Start Menu

e Opening from an Application
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Registering a Custom Setting Using a Custom Setting File
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Registering a Custom Setting Using a Custom Setting File

Follow the procedure below to register a custom setting from a custom setting file. This file would be provided by an
administrator, for example.

o The custom settings file name can be up to eight characters.

1. Open the printer properties dialog box.
2. Click the [Setup], [Page Settings], or [Edit] tab.
3. Click [Manage...].

The [Manage Custom Settings] dialog box appears.
4. Click [Load Custom Setting].

The [Load Custom Setting...] dialog box appears.
5. Select the file containing the custom setting you want to register.
6. Click [OK].

The custom setting is imported and registered.
7. Click [Close].
8. Click [OK].

The printer properties dialog box closes.

= Reference

e Opening from the Start Menu

e Opening from an Application
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Printer Driver > Opening the Printer Properties Dialog Box

Opening the Printer Properties Dialog Box

The printer properties dialog box can be opened from an application or from the [Start] menu of Windows. Depending
on how you open it, the available tabs vary.

Related topics

Opening from the Start Menu

Opening from an Application
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Opening from the Start Menu

All printer properties settings can be changed if the printer properties dialog box is opened from the [Printers] folder
(Windows XP, Windows Server 2003: the [Printers and Faxes] folder).

o The printer properties settings made here are displayed as the default when the printer properties dialog box is opened from an application.

Related topics
For Windows 95/98/Me

For Windows 2000, Windows NT 4.0

For Windows XP, Windows Server 2003
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For Windows 95/98/Me

User Guide

For screen reader Standard
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu > For Windows 95/98/Me

For Windows 95/98/Me

Follow the procedure below to open the printer properties dialog box from the [Start] menu.
1. On the [Start] menu, point to [Settings], and then click [Printers].
2. Click the icon of the printer, and then click [Properties] on the [File] menu.

The printer properties dialog box appears.
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For Windows 2000, Windows NT 4.0
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu > For Windows 2000, Windows NT 4.0

For Windows 2000, Windows NT 4.0

Follow the procedure below to open the printer properties dialog box (Windows NT 4.0: the [Default] dialog box)
from the [Start] menu.

1. On the [Start] menu, point to [Settings], and then click [Printers].

2. Click the icon of the printer, and then click [Printing Preferences...] on the [File] menu.

o Under Windows NT 4.0, click [Document Defaults...] on the [File] menu.

o To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box (Windows NT 4.0: the [Default] dialog box) appears.
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For Windows XP, Windows Server 2003
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from the Start Menu > For Windows XP, Windows Server 2003

For Windows XP, Windows Server 2003

Follow the procedure below to open the printer properties dialog box from the [Start] menu.

e Depending on the operating system settings, the actual procedure may differ.

Windows XP Home Edition

1. On the [Start] menu, click [Control Panel].
2. Click [Printers and Other Hardware].
3. Click [Printers and Faxes].

4. Click the icon of the printer, and then click [Printing Preferences...] on the [File] menu.

o To open the Windows printer properties, click [Properties] on the [File] menu.
The printer properties dialog box appears.

Windows XP Professional, Windows Server 2003

1. On the [Start] menu, click [Printers and Faxes].

2. Click the icon of the printer, and then click [Printing Preferences...] on the [File] menu.

o To open the Windows printer properties, click [Properties] on the [File] menu.

The printer properties dialog box appears.
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Opening from an Application
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Printer Driver > Opening the Printer Properties Dialog Box > Opening from an Application

Opening from an Application

Follow the procedure below to open the printer properties dialog box from an application. The default properties
settings are displayed when opened from an application. Change the settings as necessary.

o Changes made here are only applicable with that application and only as long as that application stays open.
o Some applications may automatically change the printer properties settings.
e The procedure below is an example for Paint (included in the standard Windows package).

o How to open the printer properties dialog box differs depending on the application. From most applications, the printer properties dialog box
can be opened by clicking [Print...] or [Page Setup...] on the [File] menu, and then clicking [Properties] (Windows XP, Windows Server

2003: [Preferences]). For details, see Help of the application.

1. On the [File] menu, click [Print...].

2. In the Name list, select the name of this printer, and then click Properties (Windows XP, Windows
Server 2003: Preferences).

The printer properties dialog box (Windows XP, Windows Server 2003: the [Printing Preferences] dialog box)
appears.
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Displaying the Printer Status
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Printer Driver > Displaying the Printer Status

Displaying the Printer Status

Using the Printer Status monitor, printer conditions such as the print jobs can be checked from the computer. Also,
when errors occur, the status of the printer and the solution to the problem can be checked quickly.

Related topics

Opening the Printer Status Monitor
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Opening the Printer Status Monitor

USEI' GUldE For screen reader Standard
| # Contents | 4 Previous - Next - | I | | Settings | 2]

Printer Driver > Displaying the Printer Status > Opening the Printer Status Monitor

Opening the Printer Status Monitor

The Printer Status monitor automatically opens when printing starts. It can also be opened when not printing. Follow
the procedure below to open the Printer Status monitor.

1. Open the printer properties dialog box.
2. Click the [Maintenance] tab.
3. Click [Display Status Monitor].

The Printer Status monitor dialog box appears.

= N Reference

e Opening from the Start Menu

e Opening from an Application
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Using Help / Checking Bidirectional Communication
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Printer Driver > Using Help / Checking Bidirectional Communication

Using Help / Checking Bidirectional Communication

This section describes how to use the printer driver Help and how to check whether bidirectional communication is
working or not.

Related topics

Using Help

Checking Whether Bidirectional Communication is Working or Not
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Using Help
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Printer Driver > Using Help / Checking Bidirectional Communication > Using Help

Using Help

For information about setting items and how to make settings, see Help.

Two types of the printer driver Help are available: context Help and content Help.

Related topics

Displaying an Explanation for Each Setting Item (Context Help)

Displaying Help in a Help Window (Content Help)
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Displaying an Explanation for Each Setting Item (Context Help)
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Printer Driver > Using Help / Checking Bidirectional Communication > Using Help > Displaying an Explanation for Each Setting Item (Context Help)

Displaying an Explanation for Each Setting ltem (Context Help)

Follow the procedure below to display Help for each setting item.
1. Click the [?] button found at the upper right of each dialog box.
A question mark appears beside the pointer.

2. Move the pointer over the setting item for which you want to read Help.

o You can also display Help for the setting item by right-clicking the setting item, and then clicking [Help] on the shortcut menu that

appears.
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Displaying Help in a Help Window (Content Help)
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Printer Driver > Using Help / Checking Bidirectional Communication > Using Help > Displaying Help in a Help Window (Content Help)

Displaying Help in a Help Window (Content Help)

Follow the procedure below to display Help.
1. Click [Help] found at the lower right in each dialog box.
Help for the open dialog box appears.
2. To display the contents, click [Help Topics].
3. In the [Help Topic] dialog box, select a topic.
4. Click [Display].

o To print the currently displayed Help topic, click [Print] at the top.
o To print from the [Help Topics] dialog box, select a topic, and then click [Print].
o In the [Help Topics] dialog box, selecting a book and printing it will print all topics in that book.

= N Reference

o Opening from the Start Menu

e Opening from an Application

o For details about using [Help], see the manual provided with Windows.
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Checking Whether Bidirectional Communication is Working or Not
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Printer Driver > Using Help / Checking Bidirectional Communication > Checking Whether Bidirectional Communication is Working or Not

Checking Whether Bidirectional Communication is Working or Not

Follow the procedure below to check if bidirectional communication is working by obtaining the printer version
information.

1. Open the printer properties dialog box.
2. Click the [Maintenance] tab.
3. Click [About].
The [About] dialog box appears.
4. Check that the printer version is displayed.
When bidirectional communication is working, the printer version is displayed.
5. Click [OK].

o The printer version appears under [System Version:].

Q Requirements for Bidirectional Communication

If bidirectional communication is working between the printer and computer, information about the paper loaded
in the printer is sent to the computer and is applied automatically to the printer properties settings. In addition to
that, the printer status can be checked from the computer.

o The computer must support bidirectional communication.
o The bidirectional communication settings must be enabled in the printer properties.

o The printer and computer must be connected using a USB cable.

= B Feferens

e Opening from the Start Menu

e Opening from an Application
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Maintaining the Printer Using Utilities
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Printer Driver > Maintaining the Printer Using Ultilities

Maintaining the Printer Using Utilities

If you repeatedly print, the inside of the printer will get dirty and print quality may degrade. Perform printer
maintenance from the [Maintenance] tab in the printer properties dialog box.

Related topics
Nozzle Check

Clean Print-heads (Normal)

Clean Print-heads (Full)

Adjust Print-head Positions

Registration
Adjust Paper Feed

Restore Defaults/Other Settings
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Nozzle Check
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Printer Driver > Maintaining the Printer Using Utilities > Nozzle Check

Nozzle Check

Follow the procedure below to check whether the print-head nozzles are clogged up or not by printing a nozzle check
test pattern.

o To check the printed test pattern, proceed to step 7..

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Nozzle Check].

Click [Next >].

Check that A4/Letter size paper is loaded in the paper tray.
Click [Next >].

Check the printed test pattern.

A o e

Normal

[11]

I
[1]

—_ —_—

8. Click [Finish].

o If the printed test pattern is not clear, select the [Clean Print-heads (Normal)] check box, and then click [Next >].

= N Reference

o Opening from the Start Menu

e Opening from an Application

e Clean Print-heads (Normal)
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Nozzle Check
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Clean Print-heads (Normal)
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Printer Driver > Maintaining the Printer Using Utilities > Clean Print-heads (Normal)

Clean Print-heads (Normal)

Follow the procedure below to perform a normal print-head cleaning. Perform a head cleaning when a particular color
cannot be printed or print images are blurred. Head cleaning consumes ink.

e When the Print cartridge is empty, replace it instead of performing a print-head cleaning. After a Print cartridge is replaced, a print-head

cleaning will be automatically performed.

1. Slide the envelope selector D to the forward position.

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Clean Print-heads (Normal)].

In the [Select print-head(s)] area, select a color.
Click [Next >].

Click [Next >].

o Do not perform another operation before cleaning is complete.

A A

8. Click [Finish].

o To check the condition of print-heads after cleaning, select the [Print nozzle check test pattern] check box, and then click [Next >].

Nozzle check starts.

o If the condition of the print-heads is not satisfactory, perform head cleaning again. However, the heads may remain clogged and the
printer may not print properly even if you clean the heads multiple times. If this happens, perform a full print head cleaning. If there

is still no improvement, turn the printer off, and then leave it turned off for at least 8 hours. This may solve the problem.
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Clean Print-heads (Normal)

= Reference

o Opening from the Start Menu

e Opening from an Application

e Nozzle Check

e Clean Print-heads (Full)
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Clean Print-heads (Full)
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Printer Driver > Maintaining the Printer Using Utilities > Clean Print-heads (Full)

Clean Print-heads (Full)

Follow the procedure below to perform a thorough print-head cleaning. Since this consumes more ink than a normal
head cleaning does, perform this when the problem persists after performing a normal head cleaning.

e When the Print cartridge is empty, replace it instead of performing a print-head cleaning. After a Print cartridge is replaced, a print-head

cleaning will be automatically performed.

1. Slide the envelope selector D to the forward position.

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Clean Print-heads (Full)].

In the [Select print-head(s)] area, select a color.
Click [Next >].

Select the [Clean Print-heads (Full)] check box.
Click [Next >].

Head cleaning starts.

o Do not perform another operation before cleaning is complete.

e I e

9. Click [Finish].

o To check the condition of print-heads after cleaning, select the [Print nozzle check test pattern] check box, and then click [Next >].

The nozzle check starts.
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Clean Print-heads (Full)
o A full print-head cleaning consumes a lot of ink. Perform it only when necessary.

o A full print-head cleaning may deplete the ink before the Print cartridge is expected to need to be changed.

= Reference

e Opening from the Start Menu

e Opening from an Application

e Nozzle Check
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Printer Driver > Maintaining the Printer Using Utilities > Adjust Print-head Positions

Adjust Print-head Positions

Follow the procedure below to print a test pattern and adjust the print-head positions if vertical lines are printed
unaligned or printed colors look blurred.

o To check the printed test pattern, proceed to step 8..

o When the envelope selector is not at the correct position, the colors may be printed unaligned.

Open the printer properties dialog box.
Click the [Maintenance] tab.
Click [Adjust Print-head Positions].

In the [Select a test pattern:] list, select a test pattern.

o Select a resolution. To adjust print-head positions for all resolutions, repeat this procedure selecting the other resolution.

Db =

[High speed/ Standard (speed priority)] is selected here as an example.
5. Click [Next >].
6. Check that Ad4/Letter size paper is loaded in the paper tray.
7. Click [Next >].

A test pattern to adjust print-head positions is printed.

o Do not perform other operations during printing.

o The "High quality" test pattern differs from the "Standard" test pattern.

8. Check the optimal adjustment values on the printed test pattern.

o The optimal adjustment value is the column number that appears above the lightest gray square with straight vertical lines on both

sides. When the column number is "+2" for the "A" line, the optimal adjustment value is "+2" for "A".
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Adjust Print-head Positions

/[ +1 +2 +3

9. Enter the optimal adjustment values.
10. Click [Finish].

o Repeat steps 4. to10. to print the "High quality" or "Standard" test pattern and enter the optimal adjustment values.

= Reference

o Opening from the Start Menu

e Opening from an Application
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Registration

A o e

Follow the procedure below to adjust where to start printing on paper loaded in each paper tray after checking the test
pattern printed.

o To check the printed test pattern, proceed to step 8..

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Registration].

In the [Unit type:] list, select a paper tray. In the [Paper type:] list, select a paper type.
Click [Next >].

Check that A4/Letter size paper is loaded in the paper tray.

Click [Next >].

A test pattern to adjust the print start position is printed.

o Do not perform other operations during printing.

Check the optimal adjustment values on the printed test pattern.

o Fold the test pattern sheet in half lengthwise.

+

o The optimal adjustment value is the difference between the single vertical line and the cross's vertical line that you can see when the
folded paper is held up to light. When the difference is one calibration mark in the "+" direction, the optimal adjustment value for

the [Printing direction:] is "+1.0".
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Registration

wolfofff

o Fold the test pattern sheet in half widthwise, and then check the adjustment value for the [Paper feed direction:].

o Adjustment values are in 0.1 increments.

9. In the [Printing direction:] and [Paper feed direction:] boxes, enter the adjustment values (-4.0 to +4.0)
from step 8..

10. Click [Finish].

o If a test pattern does not print or the image is not clear, select the [Print a test pattern and return to this screen] check box, and then

click [Next >]. A registration test pattern is printed and the dialog box displayed in step 9..

= N Reference

o Opening from the Start Menu

e Opening from an Application
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Adjust Paper Feed

If horizontal lines are printed unaligned or print images are patchy, print a test pattern, and then adjust the paper feed
setting.

o To check the printed test pattern, proceed to step 7..

Open the printer properties dialog box.

Click the [Maintenance] tab.

Click [Adjust Paper Feed].

Click [Next >].

Check that A4/Letter size paper is loaded in the paper tray.
Click [Next >].

A test pattern to adjust paper feed is printed.

o Do not perform other operations during printing.

AN e

7. Check the optimal adjustment values on the printed test pattern.

o The optimal adjustment value is the number that appears on the left of the lightest gray square with straight horizontal lines on both

sides. When this number is "+2", the optimal adjustment value is "+2".

+6

o When horizontal lines beside the lightest gray square are broken, select the optimal adjustment value by referring to the lines broken
in the opposite direction. When the "+2" square is the lightest gray square and the "+6" horizontal lines are broken in the opposite

direction, the optimal adjustment value is between "+3" and "+5". After adjustment, check the adjustment result.
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Adjust Paper Feed
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8. In the [Paper feed value:] box, enter the adjustment value (-14 to +14) from step 7..
9. Click [Finish].

o If a test pattern is not printed or the image is not clear, select the [Print a test pattern and return to this screen] check box, and then

click [Next >].

=l Feference

e Opening from the Start Menu

e Opening from an Application
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Restore Defaults/Other Settings

Follow the procedure below to restore the settings to their defaults or specify the amount of time the printer will wait
for more information from the computer sending the print data before it times out (I/O timeout).

1. Open the printer properties dialog box.
2. Click the [Maintenance] tab.
3. Click [Restore Defaults/Other Settings].
The [Restore Defaults/Other Settings] dialog box appears.

= N Reference

e Opening from the Start Menu

e Opening from an Application

Related topics

Restoring the Settings to Their Defaults

Specifying an I/0O Timeout
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Restoring the Settings to Their Defaults

Follow the procedure below to restore the settings for [Adjust Print-head Positions], [Registration], [Adjust Paper
Feed], and [I/O Timeout:] to their defaults.

1. Open the printer properties dialog box.
Click the [Maintenance] tab.

Click [Restore Defaults/Other Settings].
Click [Restore Defaults]

A confirmation message appears.

Click [OK].

o The settings currently made for [Adjust Print-head Positions], [Registration], [Adjust Paper Feed], and [I/O Timeout:] will be lost. These

Sl e

b

settings cannot be restored.

=l Reference

o Opening from the Start Menu

e Opening from an Application

e Adjust Print-head Positions

e Registration

o Adjust Paper Feed

e Specifying an I/0 Timeout
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Specifying an I/0 Timeout

USEI' GUldE For screen reader Standard
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Printer Driver > Maintaining the Printer Using Utilities > Restore Defaults/Other Settings > Specifying an I/O Timeout

Specifying an I/0 Timeout

Follow the procedure below to specify the amount of time the printer will wait for more information from the
computer sending the print data before it times out.

1. Open the printer properties dialog box.
2. Click the [Maintenance] tab.
3. Click [Restore Defaults/Other Settings].
The [Restore Defaults/Other Settings] dialog box appears.
4. In the [Select a time period] area, select the amount of time in the [I/O Timeout:] list.
5. Click [OK].
Even if you change the [I/O Timeout:] setting, the displayed setting remains unchanged.

=l Reference

o Opening from the Start Menu

e Opening from an Application
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Checking the Current Printer Driver Version

User Guide
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Printer Driver > Checking the Current Printer Driver Version

Checking the Current Printer Driver Version

Follow the procedure below to check the version of the printer driver currently installed.
1. Open the printer properties dialog box.
2. Click the [Maintenance] tab.
3. Click [About].
The [About] dialog box appears.
4. Check the version.

= Reference

o Opening from the Start Menu

e Opening from an Application
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Uninstalling the Printer Driver

User Guide For screen reader Standard
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Printer Driver > Uninstalling the Printer Driver

Uninstalling the Printer Driver

Follow the procedure below to uninstall the current printer driver before installing the new version of the printer driver.

o The Printer Status monitor installed with the current printer driver will be uninstalled when the current printer driver is uninstalled.

o Custom settings registered are also deleted. To continue using the registered custom settings, save them as custom setting files before

uninstalling.

1. On the [Start] menu, point to [Settings], and then click [Printers].
2. Click the icon of the printer, and then click [Delete] on the [File] menu.
3. A confirmation message appears. Click [Yes].

The printer driver is uninstalled.

4. After uninstalling the printer driver, restart Windows.

= N Reference

e Saving a Registered Custom Setting in a File

|| Top | 4 Previous - Next i |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/0093.htm2005/10/05 12:07:52


javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();

Loading Paper

User Guide

For screen reader Standard
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Paper > Loading Paper

Loading Paper

Load paper into the paper tray.
Normally, load paper into tray 1. Tray 2 (optional) can be used if installed.

o Load paper with the paper grain parallel to the feed direction.

= N Reference

e Printing on Thick Paper

Related topics

Loading Paper into Tray 1

Loading Paper into Tray 2 (optional)
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Loading Paper into Tray 1

User Guide

For screen reader Standard
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Paper > Loading Paper > Loading Paper into Tray 1

Loading Paper into Tray 1

Follow the procedure below to load paper into tray 1.

o Ad4/Letter size paper is loaded here.

o Load A4/Letter size paper in D (portrait) orientation.

1. Lift the output tray.

AGKI0S

o Pull tray 1 completely out. Take care not to drop it.

3. Squeeze the paper guides on both sides, and then adjust them according to the paper size.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/0095.htm (1 of 3)2005/10/05 12:07:54


javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();

Loading Paper into Tray 1

MGG

o Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

4. Load paper with the print side face down but not over the limit mark.

AGKI25

5. Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

AGKD35

6. Push tray 1 gently in until it stops.
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Loading Paper into Tray 1

7. Lower the output tray.

Related topics
Loading Paper Larger than A4/Letter (Trayl)
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Loading Paper Larger than A4/Letter (Trayl)

USEI' GUldE For screen reader Standard
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Paper > Loading Paper > Loading Paper into Tray | > Loading Paper Larger than A4/Letter (Trayl)

Loading Paper Larger than A4/Letter (Tray1)

Follow the procedure below to use the paper tray extension for paper larger than A4/Letter size, such as A3/11" x 17"
size paper.

e A3/11" x 17" size paper is loaded here.

e Load A3/11" x 17" size paper in L (portrait) orientation.

1. Lift the output tray.

AGKI0S

o Pull tray 1 completely out. Take care not to drop it.

3. Slide the tabs on both sides of the tray's interior to the unlocked position.
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Loading Paper Larger than A4/Letter (Trayl)

AGKDES

AGHITS

5. Slide the tabs back into place to lock the paper tray extension into position.

AGKDES

6. Squeeze the paper guide release, and then slide the paper guides into position according to the paper size.
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Loading Paper Larger than A4/Letter (Trayl)

AGKDES

o Do not use the paper tray extension for A4 (Letter) size paper or smaller paper. Use it only for long paper.

7. Load paper with the print side face down but not over the limit mark.

AGKD215

9. Push tray 1 gently in until it stops.
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Loading Paper Larger than A4/Letter (Trayl)

AGKDZ2S

AGHDZIS

11. Pull out the output tray extension.
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Loading Paper into Tray 2 (optional)
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Paper > Loading Paper > Loading Paper into Tray 2 (optional)

Loading Paper into Tray 2 (optional)

Follow the procedure below to load paper into tray 2 (optional).

e You can load plain paper and inkjet plain paper in tray 2 (optional).
o Ad/Letter size paper is loaded here.

o Load A4/Letter size paper in L (portrait) orientation.

1. Hold the grip on tray 2 (optional), lift the tray slightly, and then pull it out.

AGEOTXE

o Pull tray 2 (optional) completely out. Take care not to drop it.

2. Lift off the cover.

ACHOTEE

3. Load paper print side down, and then adjust the paper guide to the paper size.
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Loading Paper into Tray 2 (optional)

AGKDTES

AGKLTSS

o To load 250 or more sheets of paper, first load about 200 sheets, and then load the remaining sheets, making sure the paper does not

exceed the limit mark.

5. Re-attach the cover.

AGHOTES

6. Push tray 2 (optional) gently in until it stops.
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Loading Paper into Tray 2 (optional)

AGHOTTS

Related topics
Loading Paper Larger than A4/Letter (Tray2)
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Loading Paper Larger than A4/Letter (Tray2)
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Paper > Loading Paper > Loading Paper into Tray 2 (optional) > Loading Paper Larger than A4/Letter (Tray?2)

Loading Paper Larger than A4/Letter (Tray2)

Follow the procedure below to use the paper tray extension for paper larger than Ad/Letter size, such as Legal/8 1/," x
14" size paper.

1. Hold the grip on tray 2 (optional), lift the tray slightly, and then pull it out.

AGEOTEE

o Pull tray 2 (optional) completely out. Take care not to drop it.

2. Lift off the cover.

ACEOTE

3. Slide the tabs on both sides of the tray's interior to the unlocked position.
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Loading Paper Larger than A4/Letter (Tray2)

AGRDTES

AGHITES

5. Slide the tabs back into place to lock the paper tray extension into position.

AGKDADE

6. Load paper print side down, and then adjust the paper guide to the paper size.
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Loading Paper Larger than A4/Letter (Tray2)

o Do not use the paper tray extension for A4 (Letter) size paper or smaller paper. Use it only for long paper.
o To load 250 or more sheets of paper, first load about 200 sheets, and then load the remaining sheets, making sure that the paper does
not exceed the limit mark.

7. Re-attach the cover.

8. Push tray 2 (optional) gently in until it stops.

AGHOTTS
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Compatible Paper
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Paper > Compatible Paper

Compatible Paper

Before printing, check the paper types compatible with this printer.

Related topics

Compatible Paper Types

Compatible Paper Sizes

Paper Handling Precautions

Printable Area
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Compatible Paper Types

User Guide -

For screen reader Standard
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Paper > Compatible Paper > Compatible Paper Types

Compatible Paper Types

You can use various types of paper.
o Plain paper

This paper is normally used for copying and printing. Unlike inkjet plain paper or semi-gloss photo paper, it is
uncoated.

o Inkjet plain paper

This extra-white plain paper makes the printed colors appear more vivid. Since it does not have an ink-
absorbent coating, you can write on it and use it for photocopying, just like regular plain paper.

o Semi-gloss photo paper
This machine prints best on reduced-reflection glossy photo paper.

Paper for dye inks is not recommended because the machine's pigmented inks may not take properly to it or
may smear or rub off. Glossy photo paper can be used in this machine provided it is compatible with pigmented
inks.

o Inkjet transparency

Transparency film for equipment such as overhead projectors is designed for the pigmented inks used by the
machine. Film for plain paper copiers cannot be used because it does not absorb ink. Film for dye inks is not
recommended because the machine's pigmented inks may not take properly to it or may smear or rub off.
Transparency film can be used in this machine provided it is compatible with pigmented inks.

o Envelopes

For details about the types of envelope that can be used, see Paper Handling Precautions. Paper Handling
Precautions

o Thick paper
For details about the types of thick paper that can be used, see Paper Handling Precautions. Paper Handling
Precautions

o All types of paper besides thick paper can be loaded in tray 1.

e You can load plain paper and inkjet plain paper in tray 2 (optional).

= B Feferen=s

e Printing on Various Paper Types

e Paper Handling Precautions

Q Maximum Paper Feed and Output Capacity for Different Paper Types

Maximum paper feed and output capacity depends on paper type. This section lists the maximum paper feed and
output capacities for different paper types.

Plain Paper
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Compatible Paper Types

e Maximum paper capacity
250 sheets

e Maximum paper output capacity
150 sheets

Semi-gloss photo paper
e Maximum paper capacity
20 sheets

e Maximum paper output capacity
20 sheets

Inkjet Transparencies
e Maximum paper capacity
1 sheet

e Maximum paper output capacity
3 sheets

Envelopes
e Maximum paper capacity
30 sheets

e Maximum paper output capacity
30 sheets
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Compatible Paper Sizes
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Paper > Compatible Paper > Compatible Paper Sizes

Compatible Paper Sizes

You can use various sizes of paper.
Tray 1
Standard Sizes

o A3[J (portrait)

o A4l (portrait)

o AS[Y (landscape)

o A6D (portrait)

o B4l) (portrait)

e B3[ (portrait)

o ExecutivelJ (portrait) (184.2 x 266.7 mm (7.3 x 10.5 inches))
o FLJ (portrait) (203.2 x 330.2 mm (8.0 x 13.0 inches))

o Foolscap (F4) D(portrait) (215.9 x 330.2 mm (8.5 x 13.0 inches))
¢ Foliol/ (portrait) (209.5 x 330.2 mm (8.3 x 13.0 inches))

o 11" x 17" (portrait)

o Letter) (portrait)

e Legalld (portrait)

e 51/2" x 8 1/2"[F (landscape)

o 16K[J (portrait) (195 x 267mm (7.7 x 10.6 inches))

Custom paper sizes
o Custom paper sizes: 139.7-431.8mm (length) x 90-305mm (width), (5.5-17.0 inches (length) x 3.6-
12.0 inches (width))
Envelopes

e ComlO (104.8 x 241.3 mm (4.2 x 9.5 inches))
e Monarch (98.4 x 190.5 mm (3.9 x 7.5 inches))
e C6 (114 x 162 mm (4.5 x 6.4 inches))

e C5(162 x 229 mm (6.4 x 9.1 inches))

e DL Env (110 x 220 mm (4.4 x 8.7 inches))

Tray 2(optional)
Standard Sizes

o A4 (portrait)
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Compatible Paper Sizes

o B5[/ (portrait)

o ExecutivelJ (portrait) (184.2 x 266.7 mm (7.3 x 10.5 inches))

o F[J (portrait) (203.2 x 330.2 mm (8.0 x 13.0 inches))

e Foolscap (F4HD (portrait) (215.9 x 330.2 mm (8.5 x 13.0 inches))
e FoliolJ (portrait) (209.5 x 330.2 mm (8.3 x 13.0 inches))

o Letterl) (portrait)

e Legall} (portrait)

o 16K[J (portrait) (195 x 267mm(7.7 x 10.6 inches))

Custom paper sizes
o Custom paper sizes: 210-356mm (length) x 148-216mm (width), (8.3-14.0 inches (length) x 5.9-
8.5 inches (width))

Bypass tray
Standard Sizes

o 12" x 18"L) (Portrait)

o A3D) (Portrait)

o A4 (portrait)

e A5 (landscape)

o AGL (portrait)

o B4l (portrait)

e B5D (portrait)

o ExecutivelJ (portrait) (184.2 x 266.7 mm (7.3 x 10.5 inches))
o FL) (portrait) (203.2 x 330.2 mm (8.0 x 13.0 inches))

e Foolscap (F4)[J (portrait) (215.9 x 330.2 mm (8.5 x 13.0 inches))
o FoliolJ (portrait) (209.5 x 330.2 mm (8.3 x 13.0 inches))

o 11" x 17"l (portrait)

o Letter) (portrait)

e Legalld (portrait)

e 51/," x 8 1/,"[3 (landscape)

o 16K[J (portrait) (195 x 267mm (7.7 x 10.6 inches))

Custom paper sizes

o Custom paper sizes: 139.7-1295.4mm (Iength) x 90-305mm (width), (5.5-51.0 inches (lengths) x
3.6-12.0 inches (width))

Envelopes

e ComlO (104.8 x 241.3 mm (4.2 x 9.5 inches))
e Monarch (98.4 x 190.5 mm (3.9 x 7.5 inches))
e C6 (114 x 162 mm (4.5 x 6.4 inches))
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Compatible Paper Sizes

o C5(162 x229 mm (6.4 x 9.1 inches))
e DL Env (110 x 220 mm (4.4 x 8.7 inches))
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Paper Handling Precautions

To ensure optimum print results, take care when handling paper before and after printing.

Loading precautions

o Use compatible paper.

o Load paper with the print side face down in the paper trays.

o Load paper with the paper grain parallel to the feed direction.

e Do not load paper of different types at the same time.

o To load a different type of paper than that already loaded, first remove all currently loaded paper.

e Do not stack paper over the limit mark.

AGKD2S

o Curled paper may jam. Straighten any curls before loading.

-

o Before loading envelopes, make sure their edges are sharply creased by rubbing the edges with a pen or
similar object.
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Paper Handling Precautions

.. WA N
’_’z 72

o When using the bypass tray, make sure the envelope or sheet of paper is between the top and bottom of
the bypass tray guides.

AGHKDEAS

Paper storage precautions

e Do not store paper in humid places.
e Do not store paper in direct sunlight.
e Store paper flat.

o Store unused paper in the original package.

Paper type precautions
Plain paper

o Use the bypass tray to print on paper heavier than 105 g/m2 (198.5 1b.).

o The only type of A6 (105 x 148 mm(4.2 x 5.9 inches)) paper that can be loaded in tray 1 is that of
105 g/m?2 (198.5 Ib.).

o After printing, some types of paper take longer than others to dry. With duplex printing, the ink
may smear or rub off. Using the printer driver, specify how long to wait for the prints to dry
between printing each side of a duplex sheet. For details, see the printer driver Help. Opening the
Printer Properties Dialog Box

Inkjet plain paper
e When printing on inkjet plain paper, in the printer properties dialog box, click [Inkjet Plain Paper].
This allows printing at higher quality.

o In the printer properties dialog box, when [Inkjet Plain Paper] is selected, only one-sided printing
is possible. To print on both sides of a sheet, click [Plain].

o The ink may smear depending on the type of image. If this happens, set the envelope selector to
the rear position .

o Use as soon as possible after opening the package.

Semi-gloss photo paper
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Paper Handling Precautions

o The glossy side (or the pearl side) of the paper is the printing surface.

o Handle paper by the edges so as not to dirty or leave fingerprints on the print side.

o Make sure that sheets are not badly bent or scratched, and the print side is not damaged.
e Only one-sided printing is possible.

o Before handling, make sure printed sheets have fully dried.

o If you want to stack prints soon after they are printed, we recommend inserting a moisture-
absorbent sheet, like copy paper, between prints.

e Make sure that the output tray has no more than twenty sheets stacked on it.

o Semi-gloss photo paper is designed for photograph printing. For graphics, we recommend plain or
inkjet plain paper.

o When using these sheets, see the instructions supplied with them.

Inkjet transparency
o Identify the print side by orientating the sheet vertically, so that the notched corner is at the bottom
left. The side facing you is the print side.

o Load one sheet at a time. If multiple sheets are loaded, the leading edge of transparencies may get
scratched.

o Handle sheets by the edges so as not to dirty or leave fingerprints on the print side.

e Make sure that sheets are not badly bent or scratched, and the print side is not damaged.
o Only one-sided printing is possible.

e Remove sheets from the output tray individually, as they come out.

o Before handling, make sure printed sheets have fully dried.

o If you want to stack prints soon after they are printed, we recommend inserting a moisture-
absorbent sheet, like copy paper, between prints.

o Ink takes time to dry. To prevent sheets from sticking together, remove them from the output tray
individually, as they come out.

o If printing comes out streaked, adjust the paper feed level. See Adjust Paper Feed.
o Use at 15-25°C (59-77°F) and 30-70% humidity.

o Use as soon as possible after opening the package.

o When using these sheets, see the instructions supplied with them.

Envelopes

o Up to 30 envelopes can be loaded in tray 1.
o If the envelopes bulge, flatten them.

o Load envelopes carefully, because the printable area depends on the orientation. See Printable
Area.
Thick paper

e Use tray 1 to load paper lighter than 105 g/m2 (198.5 Ib.).

e You can insert paper with weights up to 163 g/m?2 (308.7 1b.) into the bypass tray.
o Insert paper with the print side face up into the bypass tray.

Cautions to Observe After Printing

Depending on the paper type, the ink may take a while to dry. Before handling, make sure printed sheets have
fully dried. otherwise, the ink may smudge.
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Paper Handling Precautions

= Reference

e Printing on Various Paper Types
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Paper > Compatible Paper > Printable Area

Printable Area

Printable and unprintable areas

1. Feed Direction
2. Printable Area

3. 3 mm (0.12 inches)

o Do not attempt to print beyond the guaranteed printable area. Paper feed precision is reduced around the printable area limits, resulting in
lower print quality.

e When printing on envelopes, the following print area limitations apply.
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1. Feed Direction

2. Printable Area

3. 8 mm (0.4 inches)
4. 38 mm (1.5 inches)

5. 5 mm (0.2 inches)
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Non-compatible Paper

User Guide
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Paper > Non-compatible Paper

Non-compatible Paper

Check if the paper is compatible.
Do not use paper that is:
o wrinkled, folded, or damaged
e wavy at the ends
o curled
o absorbent
e dry and conducive to static buildup
o already printed on (such as the back of preprinted paper)
o preprinted (unless specified)
o heat sensitive/non-carbon
o too thick or thin
o pre-stitched
o glued or tacked
o stapled or clipped together
o dark in places

o irregular in length and proportion

o Even if compatible paper types are used, print quality may be lower than usual or paper jams may occur if the paper was improperly stored.
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Printing Will Not Start

User Guide

For screen reader Standard
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Troubleshooting > Printing Will Not Start

Printing Will Not Start

If printing will not start, check whether the power of the printer is on or whether the power can be turned on or not.

If an error occurs when you try printing, change the computer or printer driver settings.

Related topics

Power Cannot Be Turned On

Paper Will Not Feed Even When the Power Is On

An Error Occurs
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Power Cannot Be Turned On

User Guide

For screen reader Standard

| # Contents | 4 Previous - Next - | I | | Settings | 2]

Troubleshooting > Printing Will Not Start > Power Cannot Be Turned On

Power Cannot Be Turned On

If the [Power] key does not light or does not blink when it is pressed, check if there is something wrong with the
power cord or wall outlet.

Check the following:
o Make sure that the power plug is firmly inserted into the wall outlet.

o Check if there is something wrong with the wall outlet. Do this by connecting another electronic product whose
operation you are familiar with.

If the above steps do not solve the problem, turn the power off, pull out the power cable, and contact your sales or
service representative. See Where to Inquire.
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Paper Will Not Feed Even When the Power Is On

User Guide

For screen reader Standard

| # Contents | 4 Previous - Next - | I | | Settings |

Troubleshooting > Printing Will Not Start > Paper Will Not Feed Even When the Power Is On

Paper Will Not Feed Even When the Power Is On

If printing will not start even when the power is on, check if an error has occurred using the indicators or Printer Status
monitor.

I An indicator is lit or blinking

Only the [Power] key is blinking.

The printer may be receiving data or replenishing its ink. Wait momentarily for the blinking [Power] key to stop

and stay lit.

The [Resume] key or a cartridge replacement indicator is blinking or lit.

An error has occurred. See Error Indicator Summary.

I An error message is displayed on the Printer Status monitor.

Click [User Guide...] to display the page corresponding to the error where you can check how to solve the problem in

more detail. See Printer Status Monitor Errors.

i ]

A print sample can be printed using keys on the control panel to check that the printer is not out of order.

When the power is off, while holding down the [Cancel] key and the [Resume] key, press and hold down the
[Power] key for over three seconds. The cartridge replacement indicators will light once and a print sample will be
delivered.
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An Error Occurs
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Troubleshooting > Printing Will Not Start > An Error Occurs

An Error Occurs

If an error occurs when you try printing, change the computer or printer properties settings.
Do the following:
o Check the printer icon name does not exceed 32 alphanumeric characters.
(If it does, shorten it.)
o Check whether other applications are operating.

Close all other applications because these could be interfering with the installation. Be sure to close all resident
programs also.

o Check the printer properties settings.
In the [Change User Settings] dialog box, on the [Misc.] tab, select the [Change data processing] check box.

For details, see Changing the Image Data Process.

o Check whether the latest printer driver is being used.

If the printer driver being used is not the latest one, update it with the latest version.
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Paper Is Not Fed or Delivered Normally

User Guide For screen reader Standard

| # Contents | 4 Previous - Next - | I | | Settings |

Troubleshooting > Paper Is Not Fed or Delivered Normally

Paper Is Not Fed or Delivered Normally

If the printer is operating but paper will not feed or paper jams multiple times, check the condition of the printer and
paper.
I Paper does not feed smoothly.

Paper guides are not adjusted properly.

o The paper guides of the paper tray do not match the paper loaded. Adjust the paper guides and load the paper

again. See Loading Paper.

Paper is not loaded properly.

o The paper is not loaded properly. Load the paper correctly. See Loading Paper.

Paper is curled.

o Remove the loaded paper and check if it is curled. If it is, straighten the curl.

Paper that is not compatible is loaded.

o Remove the loaded paper and replace it with compatible paper. See Non-compatible Paper.

I Paper jams multiple times.
The guide board is not closed.

o Make sure that the guide board is closed. Remove the duplex unit and press both sides of the guide board until

it clicks closed.

Multiple sheets are inserted in the bypass tray.

o When using the bypass tray, insert paper one sheet at a time. See Printing on Thick Paper.

The tray 2(optional) rear cover is not closed.

o Make sure that the tray 2(optional) rear cover is closed. Press both sides of the cover until it clicks closed.
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Paper Is Not Fed or Delivered Normally

Printing densely colored images on both sides.

e When printing images containing areas of solid color that consume a lot of ink, we recommend single-sided

printing.

The paper feed roller may be misaligned.
o Take the following steps:
1. Remove jammed paper.
2. Press the [Resume] key.
3. Load paper.

4. Press the [Resume] key.

I Multiple sheets of paper are fed at one time.

Load the paper again. Remove the paper from the paper tray, fan it well, and tap it on a flat surface such as a desk to
even the edges. Check the position of the paper guides of the paper tray, and then load the paper again.

I Though a paper jam is cleared, paper does not feed.

When a paper jam occurs, clear the paper jam, and then press the [Resume] key. See Paper Jam.

o If an error is displayed on the Printer Status monitor, follow the instructions to solve the problem.Printer Status Monitor Errors.
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Paper Jam
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Troubleshooting > Paper Jam

Paper Jam

This explains how to remove a paper jam. When a paper jam error appears in the Printer Status monitor, remove the
paper from the location indicated.

o If you cannot locate paper jams or jammed paper cannot be removed easily, you can check the condition of paper from the top of the printer.

Related topics

Removing Paper Jammed in the Paper Tray (Tray 1)

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Removing Paper Jammed in the Bypass Tray

Removing Paper Jammed under the Top Cover

Removing Paper Jammed around the Guide Board

Removing Paper Jammed in the Duplex Unit

Removing Paper Jammed in the Output Tray
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Removing Paper Jammed in the Paper Tray (Tray 1)

User Guide
| # Contents | 4 Previous - Next - | I | T—— | Settings | 2]

For screen reader Standard

Troubleshooting > Paper Jam > Removing Paper Jammed in the Paper Tray (Tray 1)

Removing Paper Jammed in the Paper Tray (Tray 1)

Follow the procedure below to remove paper jammed in tray 1.
1. Lift the output tray.
2. Pull out tray 1.

o Pull tray 1 completely out. Take care not to drop it.

3. Remove jammed paper.

AGHOA2E

o If you cannot remove the jammed paper or it is difficult to remove, the paper may be jammed inside the printer. Examine the paper
carefully and remove.
o If you cannot locate jammed paper, it may be jammed inside the printer.

4. Push tray 1 gently in until it stops.

AGHDN1A5
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Removing Paper Jammed in the Paper Tray (Tray 1)

5. Lower the output tray.

AGKDTES
6. Press the [Resume] key.
/ﬁ
\ W
4 B
\ g
Erctial ]

Printing starts.

o Blank paper may be delivered after printing resumes.

= Reference

¢ Removing Paper Jammed around the Guide Board

e Paper Is Not Fed or Delivered Normally
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Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

User Guide

For screen reader Standard
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Follow the procedure below to remove paper jammed in tray 2 (optional).

1. Hold the grip on tray 2 (optional), lift the tray slightly, and then pull it out.

AGHOTEE

o Pull tray 2 (optional) completely out. Take care not to drop it.

2. Lift off the cover.

3. Remove jammed paper.
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Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

AGKDEIS
4. Re-attach the cover.

AGEOTES

5. Push tray 2 (optional) gently in until it stops.

AGHOTTS
6. Press the [Resume] key.
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Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

Printing starts.

o Blank paper may be delivered after printing resumes.

If you cannot locate paper jammed in tray 2 (optional), follow the procedure below to remove the paper jammed.

1. While pushing the tabs on both sides of the tray 2 (optional) rear cover toward the inside, open the tray 2
(optional) rear cover.

2. Remove jammed paper.

3. Close the tray 2 (optional) rear cover.
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Removing Paper Jammed in the Optional Tray (Tray 2 (Optional)/Tray 2 Rear Cover)

o Press both sides of the cover until it clicks closed.

4. Press the [Resume] key.

—

Printing starts.

o Blank paper may be delivered after printing resumes.

= B Feferens

e Paper Is Not Fed or Delivered Normally
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Removing Paper Jammed in the Bypass Tray

User Guide
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Bypass Tray

Removing Paper Jammed in the Bypass Tray

Follow the procedure below to remove paper jammed in the bypass tray.

1. Remove jammed paper.

2. Press the [Resume] key.

o The [Resume] key stops blinking and stays lit.

3. Insert a sheet of paper into the bypass tray with the print side face up.
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Removing Paper Jammed in the Bypass Tray

AGKDRESE
Printing starts when you push in the paper.
Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when
cleaning finishes.

v o [mportarnt

o When using the bypass tray, make sure the sheet of paper is between the top and bottom of the bypass tray guides.

AGHDEES

o Paper can only be inserted one sheet at a time.

o Support the sheet with your hands to keep it from sliding out and dropping.

o Insert the sheet straight into the bypass tray.

If it is difficult to remove jammed paper, follow the procedure below to remove it.

1. Unlock the duplex unit at the back of the machine by raising the levers on its sides. Then, detach the
duplex unit.
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Removing Paper Jammed in the Bypass Tray

AGKIEISE

2. Remove jammed paper.

AGHIEES

3. Reinstall the duplex unit in its original position.

AGKD415

4. Press the [Resume] key.
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Removing Paper Jammed in the Bypass Tray

o The [Resume] key stops blinking and stays lit.

5. Insert a sheet of paper into the bypass tray with the print side face up.

AGKDREGSE
Printing starts when you push in the paper.
Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when
cleaning finishes.
¥ o |mportant

o When using the bypass tray, make sure the sheet of paper is between the top and bottom of the bypass tray guides.

AGKDERS
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Removing Paper Jammed in the Bypass Tray

o Paper can only be inserted one sheet at a time.
o Support the sheet with your hands to keep it from sliding out and dropping.
o Insert the sheet straight into the bypass tray.

= B Feferen=s

e Paper Is Not Fed or Delivered Normally
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Removing Paper Jammed under the Top Cover
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Troubleshooting > Paper Jam > Removing Paper Jammed under the Top Cover

Removing Paper Jammed under the Top Cover

Follow the procedure below to remove paper jammed under the top cover.

1. Open the top cover.

AGKD3LS
2. If the carriage stops in the middle, move it to whichever side is easier to move it to.

3. Remove jammed paper.

o Take care not to snag the sleeves of your clothing on the cord.

o Do not touch the feed belt.

4. Close the top cover.
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Removing Paper Jammed under the Top Cover

Printing starts.

o Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.
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Removing Paper Jammed around the Guide Board

User Guide
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Troubleshooting > Paper Jam > Removing Paper Jammed around the Guide Board

Removing Paper Jammed around the Guide Board

Follow the procedure below to remove paper jammed around the guide board.

1. Unlock the duplex unit at the back of the machine by raising the levers on its sides. Then, detach the
duplex unit.

AGKOE3S

2. Unlock the guide board by moving the tabs on both sides toward the middle, and then open the guide
board.

AGKDATS
3. Turn the paper feed wheel to release paper from the feed belt.
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Removing Paper Jammed around the Guide Board

Release paper from the roller to make it removable.

4. Insert your finger between the paper and the roller, and then remove the paper slowly.

AGKIESS

o Do not touch the feed belt.

5. Close the guide board.

AGKD405

o Push the PUSH area on both sides of the guide board until it firmly closes.

6. Reinstall the duplex unit in its original position.
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Removing Paper Jammed around the Guide Board

AGKD41S
7. Press the [Resume] key.
/f
~ f”?@@
- oy
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Printing starts.

o Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.

=l Reference

e Paper Is Not Fed or Delivered Normally
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Removing Paper Jammed in the Duplex Unit
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Duplex Unit

Removing Paper Jammed in the Duplex Unit

Follow the procedure below to remove paper jammed in the duplex unit.

1. Press the duplex unit cover button at the center of the bypass tray, and then open the duplex unit cover.

2. Remove jammed paper.

AGKMISE

3. Close the duplex unit cover.
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Removing Paper Jammed in the Duplex Unit

4. Press the [Resume] key.

Printing starts.

o Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.
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Removing Paper Jammed in the Output Tray
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Troubleshooting > Paper Jam > Removing Paper Jammed in the Output Tray

Removing Paper Jammed in the Output Tray

Follow the procedure below to remove paper jammed in the output tray.

1. Remove jammed paper.

AGKD4ES

2. Press the [Resume] key.

Printing starts.

o Depending on how the paper was jammed, printing may resume from the next page, not the one jammed.
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Print Results Are Not Satisfactory

User Guide
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For screen reader Standard

Troubleshooting > Print Results Are Not Satisfactory

Print Results Are Not Satisfactory

If there is a problem with the quality of the printing such as dirty or faint and patchy prints, first check the condition of
the printer.

Check the following:

I Does the envelope selector setting match?

Set the envelope selector according to the type of paper. For envelopes, set the lever to the rear position &, for

everything else, set the lever to the forward position D See Printing on Various Paper Types.

I Has the printer not been used for a long time?

The ink may be dry or the nozzles of the print-heads may be clogged. Print the nozzle check test pattern and clean the

print-heads as necessary. See Nozzle Check and Clean Print-heads (Normal).

I Has the nozzle check test pattern been printed?

Print the nozzle check test pattern and check whether the print-heads are clogged. Clean the print-heads as necessary.

See Nozzle Check and Clean Print-heads (Normal).

I Have the print-heads been aligned?

If the image is fuzzy or lines are doubled, align the print-heads. If the problem persists, print the nozzle check test

pattern and clean the print-heads as necessary. See Adjust Print-head Positions, Nozzle Check, and Clean Print-heads

(Normal).

I Is there a problem with the printer's location?

Make sure that the printer is level. Place the printer in a location where it will not be subject to shaking or excessive

force.

Related topics

Printing Is Uneven, Too Heavy, or Too Light

Dirty or Blotted Prints
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Printing Is Uneven, Too Heavy, or Too Light

User Guide -

For screen reader Standard

| # Contents | 4 Previous - Next - | I | | Settings |

Troubleshooting > Print Results Are Not Satisfactory > Printing Is Uneven, Too Heavy, or Too Light

Printing Is Uneven, Too Heavy, or Too Light

If there is a problem with the quality of the printing such as uneven printing or an inappropriate amount of ink being
used, the following questions should be addressed.

I Is an old Print cartridge being used?

Print cartridges should be opened before their expiration date and used within six months of being opened.

I Does the paper type setting match?

Make sure that the paper type setting of the printer driver matches the type of paper loaded. See Printing on Various

Paper Types.
I Are you printing on the wrong side of the paper?

Check which side should be printed on when using inkjet plain paper. If you print on the wrong side, the quality of the

printing may be lower and the inside of the printer may get dirty. See Paper Handling Precautions.

I Is the setting of the envelope selector suitable?

The printed side may become worn depending on the type of image. If this happens, set the envelope selector to the
rear position .

I Is the brightness of the image suitable?

If the printing is being smeared even when the envelope selector is set to the rear position B, the density of the

printing may be too high. Increase the brightness of the image.

I Is the [Duplex/Booklet] check box selected?

Duplex printing tends to produce fainter prints than single-sided printing. When performing single-sided printing,

make sure the [Duplex/Booklet] check box is not selected.
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Troubleshooting > Print Results Are Not Satisfactory > Dirty or Blotted Prints

Dirty or Blotted Prints

If prints are dirty or blotted, the following questions should be addressed.

I Is the paper being used too thick or thin?

Check if the paper is compatible. If extremely thick or thin paper is used, the print-heads will rub the paper and ink

will leak. See Compatible Paper.

I Does the print-heads rub when plain paper is used?

Set the envelope selector to the rear position E.

I Have you touched the printed side of paper?

Avoid touching the printed side of paper. Particularly, avoid touching semi-gloss photo paper and inkjet transparency
that have just been printed because these require longer than normal to dry. Remove them one at a time from the

output tray without touching the printed side, and then let them dry fully. See Paper Handling Precautions.

I Is the inside of the printer dirty?

If the leading edge or back side of printed paper is dirty, the inside of the printer may be dirty. Also, if black vertical
lines appear on the printed side of paper, the delivery rollers may be dirty. Turn the power off, and then while pressing
the [Resume] key, press and hold down the [Power] key for over three seconds. A blank sheet of paper will be

delivered to clean the delivery rollers. Repeat this operation multiple times.

I Is the paper loaded in the correct orientation?

Some paper cannot be loaded lengthwise depending on the size of the paper. Check the orientation in which the paper

is loaded. See Compatible Paper Sizes.

I Is a genuine Print cartridge being used?

Using a cartridge other than a genuine Print cartridge or using a cartridge refilled with ink will lower the print quality

and could cause a breakdown. Use a genuine Print cartridge. See Recommended Consumables.

I Are you printing densely colored images on both sides of paper?

When a large amount of ink is used to completely cover a side, one-sided printing is recommended.
When duplex printing, after printing one side of a sheet, does the machine wait for the ink to dry before
printing the other side?

Depending on type of paper, prints may require more time to dry properly and so may smear or rub off. Using the
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Dirty or Blotted Prints

printer driver, specify how long to wait for the prints to dry between printing each side. For details, see the printer

driver Help.Opening the Printer Properties Dialog Box
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Print Results Do Not Match the Displayed Image

If there are differences between the print results and the displayed image, first check the printer driver.
Check the following:

I Does the printer driver of the printer support the application used?

Check if an application other than a Windows operating system application is being used.

I Is the printer driver of the printer being used?

Make sure that the printer you want to use for printing is selected. See Opening from an Application.

I Does data from a failed print job or canceled print job remain in memory?

Check whether data from a failed print job or canceled print job remains in memory. See Canceling Printing.

Related topics
Characters and Colors Do Not Match the Displayed Image

Positions Do Not Match the Displayed Image

|| Top | 4 Previous « Next fp |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/0121.htm2005/10/05 12:08:26


javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();
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Characters and Colors Do Not Match the Displayed Image

If there are differences between the characters and colors of the print results and the displayed image, the following
questions should be addressed.

I Has the hue of colors been adjusted?
Since printed colors and screen colors are produced by different methods, a color printed and a color displayed on a
screen can have different hues even though they are the "same" color. Use the color matching function to make the

hue of printed colors and displayed colors closer. See Changing the Color Profiling Pattern.

I Has the nozzle check been performed?

The print-heads may be clogged and the amount of ink may not be able to be regulated. Print the nozzle check test

pattern and clean the print-heads as necessary. See Clean Print-heads (Normal) and Nozzle Check.

I Was printing done in black and white?

Check the color setting of the application and the color print setting of the printer driver. See Printing in Black and

White.

I Have the print quality settings been made?

Set the printing resolution to an appropriate level. See Printing Using Preset Print Quality Settings.

I Does the paper type setting match?

Make sure that the paper type setting of the printer driver matches the type of paper loaded. See Printing on Various

Paper Types.
I Have you tried printing with inkjet plain paper?

Try printing with inkjet plain paper. The print results should be clearer. See Printing on Various Paper Types.

Q Changing the printer driver setting
You may eliminate certain problems by changing the printer driver settings as described below:
o Cannot print certain data properly when using a certain application, or cannot print image data properly.

In the [Print Quality] area, select [Standard (quality priority)] or [High quality], and then print. See Printing
Using Preset Print Quality Settings.

In the [Change User Settings] dialog box, on the [Image Adjustments] tab, under [Dithering], deselect the
[Use error diffusion] check box. See Using Error Diffusion.

Set [Spool format:] to [RAW] or [EMF] in the [Printer Configuration] dialog box.
In the [Change User Settings] dialog box, on the [Image Adjustments] tab, under [Image processing
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Characters and Colors Do Not Match the Displayed Image

priority], deselect the [Adjust photos and images] and [Smooth low resolution images] check boxes. See
Correcting the Hue of Digital Photos and Printing Low Resolution Images Smoothly.

In the [Change User Settings] dialog box, on the [Misc.] tab, select the [Print as bitmap] check box. See
Printing a Whole Page as an Image.

e Some characters are garbled or missing.

In the [Change User Settings] dialog box, on the [Misc.] tab, select the [Change methods to extract
TrueType fonts] check box. See Changing the Method of Extracting TrueType Fonts.

In the [Printer Configuration] dialog box, set [Spool format:] to [EMF]. In the [Change User Settings]
dialog box, on the [Misc.] tab, select the [Print as bitmap] check box. See Printing a Whole Page as an

Image.
o Some characters are printed faintly or not printed.

In the [Print Quality] area, select [High quality] or [Standard (quality priority)], and then print. See Printing
Using Preset Print Quality Settings.

In the [Change User Settings] dialog box, on the [Image Adjustments] tab, under [Dithering], deselect the
[Use error diffusion] check box. See Using Error Diffusion.

o Printing is slow and takes time, which delays release of the application.

In the [Print Quality] area, select [High quality] or [Standard (quality priority)], and then print. See Printing

Using Preset Print Quality Settings.

In the [Printer Configuration] dialog box, set [Spool format:] to [EMF].

In the [Change User Settings] dialog box, on the [Image Adjustments] tab, under [Image processing
priority], deselect the [Adjust photos and images] and [Smooth low resolution images] check boxes. See
Correcting the Hue of Digital Photos.

Close the resident application.
o Printing stops halfway.

View the status monitor to check whether an error has occurred. See Printer Status Monitor Errors.

To print on preprinted or prepunched paper, select the [Use preprinted/prepunched paper] check box in the
[Printer Configuration] dialog box.
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Positions Do Not Match the Displayed Image

If the position of printed items differs from the position of displayed items, the following questions should be
addressed.

I Have the settings for page layout been made?

Check whether page layout settings have been made with the application.

I Does the paper size setting match?

Make sure that the paper size selected in the [Printout paper size:] list of the printer properties dialog box matches the
size of the paper loaded.

I Does the envelope selector setting match?

Set the envelope selector according to the type of paper. For envelopes, set the lever to the rear position EJ; for

everything else, set the lever to the forward position D See Printing on Various Paper Types.

I Have the print-heads been aligned?

When bidirectional printing is performed, and lines and characters are blurred, align the print-heads. If the problem

persists, print the nozzle check test pattern and clean the print-heads as necessary. See Adjust Print-head Positions,

Nozzle Check, and Clean Print-heads (Normal).
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Printer Status Monitor Does Not Open

If the Printer Status monitor does not open for a shared printer, the following questions should be addressed.

I Are the share settings correct?

Check the share settings of the printer. The printer driver must also be installed on the client computer. See Setting Up

a Server and Setting Up a Client Computer.

I Does your Web browser support Printer Status Monitor?

Internet Explorer version 4.0 or later is required to display Printer Status Monitor and the dialog boxes displayed from

the [Maintenance] tab of the printer driver.
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Troubleshooting > Printer Status Monitor Errors

Printer Status Monitor Errors

If an error occurs with the printer, Printer Status Monitor displays an error message. Click [User Guide...] to display
the page corresponding to the error where you can check how to solve the problem in more detail.

Related topics

No Response from Printer

No Paper/Tray Not Detected (Bypass Tray)

No Paper/Tray Not Detected (Tray 1)

No Paper/Tray Not Detected (Tray 2)

Paper Size Mismatch (Bypass Tray)

Paper Size Mismatch (Tray 1)

Paper Size Mismatch (Tray 2)

Cover Open

Duplex Unit Not Detected

Cover Open / Print Cartridge(s) Not Detected

Paper in Bypass Tray

Cartridge End
Cartridge/Print-head Tank Empty

Out of Printable Temperature Range

When the Internal Unit is Almost Full

Printer Error
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No Response from Printer
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Troubleshooting > Printer Status Monitor Errors > No Response from Printer

No Response from Printer

Follow the procedure below to check the port settings and the connection between the printer and computer.
1. Check that the power of the printer is on.
2. Make sure that the computer and printer are properly connected using a USB cable.
3. Open the printer properties dialog box.
4. Click the [Ports] tab.
5. Check that USB is selected in the [Print to the following port:] list.

o Under Windows 98/Me, check that USB is selected in the list on the [Details] tab.

= B Feferens

e Opening from the Start Menu
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No Paper/Tray Not Detected (Bypass Tray)

If no paper is ready to be fed in the bypass tray, this message appears. Follow the procedure below to insert paper into
the bypass tray.

1. Slide the bypass tray guides into position according to the paper size.

AGKIZES

2. Insert a sheet of paper into the bypass tray with the print side face up.

AGKDRESE
Printing starts when you push in the paper.
Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when
cleaning finishes.

v o [mportarnt

o When using the bypass tray, make sure the envelope or sheet of paper is between the top and bottom of the bypass tray guides.
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No Paper/Tray Not Detected (Bypass Tray)

AGKDESS

o Paper can only be inserted one sheet at a time.
o Support the sheet with your hands to keep it from sliding out and dropping.

o Insert the sheet straight into the bypass tray.
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No Paper/Tray Not Detected (Tray 1)

No paper is loaded in tray 1 or paper is not loaded properly. Follow the procedure below to load paper properly.
1. Lift the output tray.

AGKD0S

o Pull tray 1 completely out. Take care not to drop it.

3. Squeeze the paper guides on both sides, and then adjust them according to the paper size.
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No Paper/Tray Not Detected (Tray 1)

MGG

o If paper is already loaded, remove it from the paper tray, fan it well, and tap it on a flat surface such as a desk to even the edges.

Check that the position of the paper guides and the front end guide match the paper size.

o Beforehand, make sure to squeeze the front end paper guide, and then expand the guide.

4. Load paper with the print side face down but not over the limit mark.

AGKD25

5. Squeeze the front end paper guide, and then slide it to meet the edge of the paper.

AGKI135

6. Push tray 1 gently in until it stops.
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No Paper/Tray Not Detected (Tray 1)

AGKD145
7. Lower the output tray.

AGHKDTES
8. Press the [Resume] key.

AGHD5AE

Printing starts.
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No Paper/Tray Not Detected (Tray 2)

No paper is loaded in tray 2 (optional) or paper is not loaded properly. Follow the procedure below to load paper
properly.
1. Hold the grip on tray 2 (optional), lift the tray slightly, and then pull it out.

AGEOTEE

o Pull tray 2 (optional) completely out. Take care not to drop it.

2. Lift off the cover.

ACEOTE

3. Load paper print side down, and then adjust the paper guide to the paper size.
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No Paper/Tray Not Detected (Tray 2)

o If paper is already loaded, remove it from the paper tray, fan it well, and tap it on a flat surface such as a desk to even the edges.

Check that the position of the paper guides and the front end guide match the paper size.

o To load 250 or more sheets of paper, first load about 200 sheets, and then load the remaining sheets, making sure that the paper does

not exceed the limit mark.

AGKLTSS

4. Re-attach the cover.

AGHOTES

5. Push tray 2 (optional) gently in until it stops.
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No Paper/Tray Not Detected (Tray 2)

AGHOTTS
6. Press the [Resume] key.

Printing starts.
7 | Feference

o Loading Paper Larger than A4/Letter (Tray2)
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Paper Size Mismatch (Bypass Tray)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper
size in the printer properties settings.

1. Open the printer properties dialog box from the application.
2. Click the [Page Settings] tab.

3. In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the
paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

o If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then

select the correct sizes.

o If paper of the incorrect size is loaded, proceed to the next step.

4. Slide the bypass tray guides into position according to the paper size.

AGKDRES

5. Insert a sheet of paper into the bypass tray with the print side face up.
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Paper Size Mismatch (Bypass Tray)

AGKDRESE
Printing starts when you push in the paper.
Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when
cleaning finishes.

v o [mportarnt

o When using the bypass tray, make sure the envelope or sheet of paper is between the top and bottom of the bypass tray guides.

AGHDEES

o Paper can only be inserted one sheet at a time.

o Support the sheet with your hands to keep it from sliding out and dropping.

o Insert the sheet straight into the bypass tray.

= B Feferens

e Opening from an Application

o Canceling Printing
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Paper Size Mismatch (Tray 1)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper
size in the printer properties settings.

o Ad4/Letter size paper is loaded here.

o Load A4/Letter size paper in D (portrait) orientation.

1. Open the printer properties dialog box from the application.
2. Click the [Page Settings] tab.

3. In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the
paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

o If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then
select the correct sizes.

If paper of the incorrect size is loaded, proceed to the next step.
4. Lift the output tray.

AGKDOHS
5. Pull out tray 1.
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Paper Size Mismatch (Tray 1)

AGKI0E

o Pull tray 1 completely out. Take care not to drop it.

6. Remove loaded paper.

7. Squeeze the paper guides on both sides, and then adjust them according to the paper size.

ACHE

o The front end paper guide may also need to be adjusted.

8. Load paper with the print side face down but not over the limit mark.

AGKI25

9. Squeeze the front end paper guide, and then slide it to meet the edge of the paper.
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Paper Size Mismatch (Tray 1)

AGKD3S

10. Push tray 1 gently in until it stops.

AGHDN1A5

11. Lower the output tray.

AGKDTES
12. Press the [Resume] key.
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Paper Size Mismatch (Tray 1)

Printing starts.

= N Reference

e Opening from an Application

e Canceling Printing

|| Top | 4 Previous - Next i |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/t0013.htm (4 of 4)2005/10/05 12:08:37



Paper Size Mismatch (Tray 2)

User Guide

For screen reader Standard

| # Contents | 4 Previous - Next - | I | | Settings | 2]

Troubleshooting > Printer Status Monitor Errors > Paper Size Mismatch (Tray 2)

Paper Size Mismatch (Tray 2)

Paper of the incorrect size is loaded. Follow the procedure below to load the correct size of paper or change the paper
size in the printer properties settings.

o Ad4/Letter size paper is loaded here.

o Load A4/Letter size paper in (portrait) orientation.

1. Open the printer properties dialog box from the application.
2. Click the [Page Settings] tab.

3. In the [Original size:] and [Printout paper size:] lists, check document and paper sizes. To change the
paper size, select a paper size in the [Printout paper size:] list.

To enable the [Printout paper size:] list, select the [Reduce/Enlarge] check box.

o If incorrect document and paper sizes are selected in the [Original size:] and [Printout paper size:] lists, cancel printing, and then

select the correct sizes.

If paper of the incorrect size is loaded, proceed to the next step.

4. Hold the grip on tray 2 (optional), lift the tray slightly, and then pull it out.

AGHOTEE

o When the output tray is lifted, tray 2 (optional) will pop out slightly. Pull tray 2 (optional) completely out. Take care not to drop it.

5. Lift off the cover.
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Paper Size Mismatch (Tray 2)

AGEOTAS
6. Remove loaded paper.

7. Load paper print side down, and then adjust the paper guide to the paper size.

o To load 250 or more sheets of paper, first load about 200 sheets, and then load the remaining sheets, making sure that the paper does

not exceed the limit mark.

8. Load paper with the print side face down but not over the limit mark.

AGKDTSSE

9. Re-attach the cover.
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Paper Size Mismatch (Tray 2)

AGHOTES

10. Push tray 2 (optional) gently in until it stops.

AGHOTTS
11. Press the [Resume] key.

Printing starts.

=l Reference

e Loading Paper Larger than A4/Letter (Trayl)

e Opening from an Application

o Canceling Printing
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Cover Open
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Troubleshooting > Printer Status Monitor Errors > Cover Open

Cover Open

A cover is open. Close the cover.
Close the top cover or duplex unit cover. If the cover is already closed, open and then reclose it.
Follow the procedure below to close the top cover or duplex unit cover.

1. Close the cover.

o Check that the duplex unit is correctly attached and the duplex unit cover is closed.

2. If the [Resume] key lights, press that key.
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Duplex Unit Not Detected
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Troubleshooting > Printer Status Monitor Errors > Duplex Unit Not Detected

Duplex Unit Not Detected

The duplex unit is not attached correctly. Follow the procedure below to attach the duplex unit correctly.

1. Re-attach the duplex unit.

>

AGKD41S
2. If the [Resume] key lights, press that key.
/’f
N W
- %
%
Llclisl ]

o Even if you are not duplex printing, the duplex unit must be attached. Otherwise printing will not start.
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Cover Open / Print Cartridge(s) Not Detected
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Troubleshooting > Printer Status Monitor Errors > Cover Open / Print Cartridge(s) Not Detected

Cover Open / Print Cartridge(s) Not Detected

The right front cover is open. Close the right front cover. Alternatively, the print cartridges are not installed or are
installed incorrectly. Install the print cartridges correctly.

If the cover is open:

1. Close the right front cover.

AGHI0GS

If the print cartridges are not installed or are installed incorrectly:

1. Open the right front cover.

2. Push in the cartridge using the PUSH area.
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Cover Open / Print Cartridge(s) Not Detected

o If the error persists, take the Print cartridge out once, and then install it again. The procedure above should be performed only once.
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Paper in Bypass Tray
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Troubleshooting > Printer Status Monitor Errors > Paper in Bypass Tray

Paper in Bypass Tray

This appears if paper is set before printing from the bypass tray starts. Follow the procedure below to remove the
paper in the bypass tray.

1. Remove paper.

AGKIGLS

2. Insert a sheet of paper into the bypass tray with the print side face up.

AGKDRESE
Printing starts when you push in the paper.
Printing cannot start until the machine finishes cleaning its head. Load the paper in the bypass tray when
cleaning finishes.

v o [mportarnt

o When using the bypass tray, make sure the sheet of paper is between the top and bottom of the bypass tray guides.
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Paper in Bypass Tray

AGKDESS

o Paper can only be inserted one sheet at a time.
o Support the sheet with your hands to keep it from sliding out and dropping.

o Insert the sheet straight into the bypass tray.

3. Press the [Resume] key, and then push the sheet a little way into the printer.
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Cartridge End

A Print cartridge is empty. Printing can continue using ink remaining in the printer; however, no ink is left in the Print
cartridge. Check which color of cartridge needs to be replaced, and then replace it.

Checking ink color

e Checking using the Printer Status monitor

=1c1 x|

Fie name:

Sending data:

g 2 |

Stop Printing |

o In the illustration above, the cyan Print cartridge is empty.

o Checking the cartridge replacement indicators

©oe @

0 0

AGHES

o Blinking

In the illustration above, the cyan Print cartridge is empty.

o From left to right, the cartridge replacement indicators display the status of the black (K), cyan (C), magenta (M), and

yellow (Y) Print cartridges.
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Cartridge End

o Since solid color printing on semi-gloss photo paper consumes a lot of ink of that color, printing may stop in the middle of

the printing process because ink of that color is depleted.

o Do not perform a normal head cleaning or a full head cleaning unless it is necessary. Ink may run out making printing

impossible.

o If you turn the power off and then on again, ink adjustment is performed in the printer which may result in the ink running

out.

= B Feferen=s

e Replacing a Print Cartridge

e Displaying the Printer Status
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Cartridge/Print-head Tank Empty

The ink is completely depleted. Printing cannot be performed. Replace the Print cartridge.

Checking ink colors

e Checking using the Printer Status monitor

=101 x|

Fie name:

Sending data:

Progress: |

Stop Frmting |

[ ok | Hee |

o In this illustration, the cyan Print cartridge has completely run out.

o Checking the cartridge replacement indicators

©oe @

6 0 0

o Lit
In this illustration, the cyan Print cartridge has completely run out.

o From left to right, the cartridge replacement indicators display the status of the black (K), cyan (C), magenta (M), and

yellow (Y) Print cartridges.
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Cartridge/Print-head Tank Empty

o Head cleaning cannot be performed.

= B Feferens

e Replacing a Print Cartridge

e Displaying the Printer Status
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Out of Printable Temperature Range
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Out of Printable Temperature Range

Follow the procedure below to relocate the printer when the temperature inside the printer is inappropriate, extremely
high or low, for printing.

1. Turn off the power of the printer.
2. Place the printer in a 10 to 32°C (50 to 89.6°F) environment.

3. Turn on the power of the printer.

o If humidity is more than 54%, the high end of the appropriate temperature range will be lower than usual.

o Even after the power is turned on, the printer may remain in the standby mode until it acclimates to the room temperature. If this happens,

wait until the [Power] key stops blinking and stays lit.

= Reference

o For details about what conditions the printer can be used under (ambient temperature and humidity range), see "Checking the Installation

Area", Setup Handbook.
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When the Internal Unit is Almost Full
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Troubleshooting > Printer Status Monitor Errors > When the Internal Unit is Almost Full

When the Internal Unit is Aimost Full

Depending on your settings, the internal unit may fill up sooner than normal. An "Internal unit nearly full" message
appears shortly before the internal unit is full.

Contact your service representative as soon as possible for a replacement internal unit (charge incurred).
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Printer Error
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Troubleshooting > Printer Status Monitor Errors > Printer Error

Printer Error

An error has occurred in the printer. Turn the power off once, and then turn it back on.

o If the printer is relocated from a cold area to a warm area or the printer is placed in a room where the temperature varies greatly,
condensation may form inside the printer causing errors. If this happens, an error might not clear if the power is turned off and then on. Wait

until the printer acclimates and the condensation disappears. This should take about one hour.

= N Reference

o If the error still does not clear after the printer acclimates to room temperature and the power is turned back on, contact your sales or service

representative.
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Adjusting the Printer
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Troubleshooting > Adjusting the Printer

Adjusting the Printer

Adjust the printer from the [Maintenance] tab in the printer properties dialog box.

= B Feferen=s

e Clean Print-heads (Normal)

e Clean Print-heads (Full)

e Adjust Print-head Positions

o Registration

o Adjust Paper Feed

|| Top | 4 Previous - Next i |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/0142.htm2005/10/05 12:08:49


javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();

Error Indicator Summary
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Troubleshooting > Error Indicator Summary

Error Indicator Summary

You can check the status of the printer using the lit or blinking indicators on the control panel.

1T 2 3 4

© 6 ©

9 0 0 0

AGKIMNME

1. Cartridge replacement indicators

N

. [Power] key

w

. [Resume] key

N

. [Cancel] key

Status of Indicators Status/Solutions

The printer has completely run out of the

. . . indicated ink.
A cartridge replacement indicator is lit.

(In the illustration, the printer has run out of

(The [Power] key may be lit or blinking at the cyan ink.)

same time.)
Further printing is impossible. Check the

color indicated, and replace the corresponding
print cartridge immediately.

=>Cartridge/Print-head Tank Empty.

@ ©
0 0

The print cartridges are not installed or are not
installed correctly (in the illustration, cyan is
not installed).

©

.

Install the print cartridges correctly.

ARinE =>Cover Open / Print Cartridge(s) Not
Detected.
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Error Indicator Summary

A cartridge replacement indicator is blinking.

(The [Power] key may be lit or blinking at the
same time.)

© e ©

5 8 0 o0

ALK IS

The corresponding print cartridge has run out
of ink.

(In the illustration, the cyan print cartridge has
run out of ink.)

Printing can continue with the ink remaining
in the printer, but there is no more ink in the
print cartridge. Check the color indicated, and
replace the corresponding print cartridge.

=>Cartridge End.

All the indicators are blinking.

alp e alp alp
6

AL RS

A maintenance error has occurred.
Turn the power off, and then on.
If that does not clear the error, contact your

sales or service representative.

=Where to Inquire.

The [Resume] key is lit.

(The [Power] key may be lit or blinking at the
same time.)

@ ©
0 0

©

0

AL S

There may be a problem with feeding paper.

Check the printer and paper, and then press
the [Resume] key.

=>Paper Is Not Fed or Delivered Normally.

The paper tray may be empty.

Load the paper tray, and then press the
[Resume] key.

=Loading Paper.

The [Power] key is blinking.

©® 6 ©

00 0

AGKIOTS
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The printer is either warming up or receiving
print data.

(If the blinking is slow, the printer is in
standby mode with its main power off.)

If the blinking continues, the temperature
inside the printer may be outside of the
operating temperature range.

Turn the power off, move the printer to a
location where the temperature is within the

range 10-32°C (50-89.6°F), and then turn the
power on.

=>Out of Printable Temperature Range.




Error Indicator Summary

The duplex unit may not be installed correctly.

Install the duplex unit correctly, and then
press the [Resume] key.

=>Duplex Unit Not Detected.

A cover may be open.

Close the cover, and then press the [Resume]
key.

=Cover Open.

Paper may be jammed.
Remove the jammed paper, and then press the
The [Resume] key is blinking. [Resume] key.

(The [Power] key may be lit or blinking at the

) =>Paper Jam.
same time.)

The temperature inside the printer may have
gone outside of the operating temperature
range while the power was on, or the
temperature may be outside of the operating
temperature range now.

© e ©

00 0

Turn the power off, move the printer to a
location where the temperature within the
range 10-32°C (50-89.6°F), and then turn the
power on.

AGE IS =>QOut of Printable Temperature Range.

Paper of the correct size may not be loaded.

Load paper of the correct size, or change the
printer driver settings.

=>Paper Size Mismatch (Bypass Tray),Paper

Size Mismatch (Tray 1), and Paper Size
Mismatch (Tray 2).

The right front cover is open.
Close the right front cover.

=»Cover Open / Print Cartridge(s) Not
Detected.

= Reference

o For details about what conditions the printer can be used under (ambient temperature and humidity range), see "Checking the Installation

Area", Setup Handbook.
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Checking the Remaining Ink

Follow the procedure below to check when to replace Print cartridges using the Printer Status monitor or the cartridge
replacement indicators.

Checking using the Printer Status monitor

1. Open the printer properties dialog box.
2. Click the [Maintenance] tab.
3. Click [Display Status Monitor].
The Printer Status monitor dialog box appears.
4. Check the cartridge status.

1ol %]
Fie name:
Sending data:
Frogress: |
Stop Phinting
Replace cariridge{s]. Cartridge(s]
Open the indicated cover and
replace the cartnidgeyz).
Right Front Covar.Cyan
replacing, pull out all empty ll
(e Glada, |
[ ok ] Hep |

In the illustration above, the cyan Print cartridge is empty.

If the background of the image in the top left corner of dialog box is yellow, the indicated cartridge is empty.
Replace the cartridge.
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Checking the Remaining Ink

=loix

Fie name:

Sending data:

Stop Printing

Cartiidge/Priv-head Tank Emply <

T

In this illustration, the cyan ink has completely run out.

If the background of the image in the top left corner of dialog box is red, the printer has run out of the indicated
ink. Replace the cartridge.

Checking the cartridge replacement indicators of the printer

©oe @

6 0 O

o Blinking
In the illustration above, the cyan Print cartridge is empty.
e Lit

In the illustration above, the cyan ink has completely run out.
o From left to right, the cartridge replacement indicators display the status of the black (K), cyan (C), magenta (M), and yellow (Y)

Print cartridges.

o The cartridge status can be used for determination of cartridge change. If cartridge status is not monitored, visual indication of the cartridge

may not be correct.
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Checking the Remaining Ink

e Opening the Printer Status Monitor
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Replacing a Print Cartridge
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Replacing a Print Cartridge > Replacing a Print Cartridge

Replacing a Print Cartridge

Follow the procedure below to replace an empty Print cartridge.
Clear any errors, such as when there is a paper jam or when no paper is loaded, before replacing a Print cartridge.

1. Remove the Print cartridges' packaging.

o If multiple cartridges are empty, replace all the empty cartridges. You can shorten the time for needed replacement.

2. Open the right front cover.

3. Take out the empty cartridges.

AGKD4ES
4. Check the cartridges' orientation, and then install them gently.

Install in the following order from the left: black, cyan, magenta, and yellow.

¥ o |mportant

o Take care to install the cartridges in the correct position.

5. Push in the cartridge using the PUSH area.
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Replacing a Print Cartridge

AGKDSISE

6. Close the right front cover.

AGHI0SE

= Reference

¢ Recommended Consumables
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Handling Print Cartridges

Important points about handling Print cartridges are explained.

/A CAUTION

o If ink comes into contact with your eyes, rinse immediately in running water. For other symptoms, consult a doctor.
o Ifink is ingested, induce vomiting by drinking a strong saline solution. Consult a doctor immediately.

o If your skin comes into contact with ink, immediately wash the affected area with water or soap and water.

A CAUTION

o Keep the ink or ink container out of reach of children.

About Print cartridges
o Print cartridges comply with the manufacturer's safety specifications. To ensure safety and reliability,
use genuine Print cartridges.

e When using the printer for the first time, install the Print cartridges supplied with the printer.

Using Print cartridges
o Print cartridges should be opened before their expiration date and used within six months of being
opened.
o Do not open the package of a Print cartridge until the cartridge will be installed in the printer.
e Do not touch the ink supply port of Print cartridges.
o Do not shake Print cartridges strongly. Ink may leak out.
o Do not take apart Print cartridges.

e Do not open the right front cover except when installing Print cartridges. Do not turn off the power or
unplug the power cord during the process of installing the cartridges.

o Always confirm the color of a Print cartridge before installing it.
e Do not remove a Print cartridge once it has been installed unless necessary.

e Do not remove a Print cartridge while printing is being performed. Printing will stop.

Storing Print cartridges

e Avoid storing Print cartridges in hot or freezing places.

Ink consumption

o In addition to printing, ink is consumed when the power is turned on, head cleaning is performed, or
Print cartridges are installed.
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Handling Print Cartridges
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Sharing the Printer > Setting Up a Server

Setting Up a Server

Follow the procedure below to set up a print server so that the printer can be shared by users.

s o |mportarnt

o For Windows 2000/XP, Windows Server 2003, and Windows NT 4.0, log on as an administrator (a user with an administrator right).

o Configure a computer connected to the printer as the print server.

o The print server is a computer used to manage the shared printer on the network.

On the [Start] menu, point to [Settings], and then click [Control Panel].

Double-click [Network and Dial-up Connections].

Click [Local Area Connection] to highlight it, and then, in the [File] menu, click [Properties].
Select the [Client for Microsoft Networks] check box.

Click [OK].

Install the printer driver.

NN R Wb =

On the [Start] menu, point to [Settings], and then click [Printers].

o Under Windows XP Professional, click [Printers and Faxes] on the [Start] menu.
o Under Windows XP Home Edition, click [Control Panel] on the [Start] menu. Click [Printers and Other Hardware], and then click
[Printers and Faxes].

8. Click the icon of the printer, and then click [Sharing...] on the [File] menu.
9. Click [Shared as:], and then enter a name in the [Shared as:] box.
10. Click [OK].

o Configure a computer connected to the network, where the print server is connected, as a client computer.

= B Feferens

o For details about installing the printer driver, see "Installing the Printer Driver", Setup Handbook.

e Setting Up a Client Computer
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Sharing the Printer > Setting Up a Client Computer

Setting Up a Client Computer

Follow the procedure below to configure a computer as a client computer and connect it to the shared printer. Make
this setting when installing the printer driver from the CD-ROM provided.

s o [mportarnt

o For Windows 2000/XP, Windows Server 2003, and Windows NT 4.0, log on as an administrator (a user with an administrator right).

i

o Configure a computer connected to the network where the print server is connected.

1. Start Windows, and then insert the '"'Drivers & Manual'' CD-ROM into the CD-ROM drive.

o Quit all other applications currently running.

o When starting Windows, a wizard for adding new hardware may open. If this happens, click [Cancel]. Check again that the power is

off, and then proceed to step 2..

o When the CD-ROM is inserted, the [Drivers & Manual] dialog box appears. If it does not, double-click the CD-ROM drive icon

under [My Computer] or [Explorer], and then double-click [SETUP.EXE].

Click [Printer Driver].
Read the license agreement, and then click [I accept the agreement.].
Click [Next >].
Click [Connected via LAN].
Click [Next >].
Click [Add a new printer].
Click [Next >].
Click the plus mark next to a printer name.
Click [Port:< LPT1: >] under [Printer Name:].
. Click [Add].
The [Add Port] dialog box appears.
12. Click [Network Printer].
13. Click [OK].
14. Select a shared printer.
15. Click [OK].
16. Check that [<\\servername\sharedprintername>] appears after [Port:].
17. Click [Continue].

Installation starts.

D A o

—_ =
— O

18. Select whether or not to open the Printer Status monitor automatically.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/0148.htm (1 of 2)2005/10/05 12:08:56


javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();

Setting Up a Client Computer

19. Click [Next >].
20. Check the installation result, and then click [Finish].

o If the message prompting you to restart the computer appears, restart the computer.

= B Feferen=s

o For details about installing the printer driver, see "Installing the Printer Driver", Setup Handbook.

o Setting Up a Server
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Inquiries and Consumables > Where to Inquire

Where to Inquire

For inquiries, contact your sales or service representative.
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Recommended Consumables
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Inquiries and Consumables > Recommended Consumables

Recommended Consumables

Consumables recommended for this printer are listed.
Purchase necessary consumables before your supply runs out.
For information about consumables, contact your sales or service representative.

o Print cartridges
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Option and Consumables

User Guide

For screen reader Standard

| # Contents | 4 Previous - Next - | I | | Settings | 2]

Inquiries and Consumables > Option and Consumables

Option and Consumables

The optional Paper Feed Unit Type 7500 is available. If installed, a large number of prints can be made at one time
using plain paper.

o For information about options and consumables, contact your service representative.
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Color Guide
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Color Guide
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Related topics

Color Printing Mechanism

Color Production Method of Printers

|| Top | 4 Previous - Next o |

The RGB and CMYK color models are explained.

Standard

| Settings | 2]

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/0152.htm2005/10/05 12:09:00


javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();

Color Printing Mechanism
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Color Printing Mechanism

The three primary colors of light (RGB) and the three primary colors of Pigment (CMY)

All light can be produced using a mixture of three colors known collectively as RGB. R stands for red, G for
green, and B for blue. When mixed in the same proportion, white light is created.

o The three RGB colors are called the primary colors of light. The RGB colors are also used to produce the colors displayed on the

screen of a computer.

Printed colors are produced using a mixture of the three CMY colors. C stands for cyan, M for magenta, and Y
for yellow. When mixed in the same proportion, black is created.

yoliow

e The CMY colors are called the primary colors of pigment. Printers use cyan (C), magenta (M), yellow (Y), and K (black) to print in

full color.

The primary colors of light (RGB) can be mixed to produce the secondary colors of cyan, magenta, and yellow.
Conversely, the primary colors of pigment (CMY) can be mixed to produce red, green, and blue. When two
primary colors are mixed, the resulting color is the complimentary color of the remaining primary color. Red
and cyan, green and magenta, and blue and yellow are pairs of complementary colors.

E' Top | 4 Previous - Next f |
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Color Production Method of Printers

Printers use cyan (C), magenta (M), yellow(Y), and K (black) to print in full color.

o If equal proportions of the three CMY colors are mixed, in theory, pure black should be produced. In practice, the resulting printed color is
not pure black and has an inferior feel due to the limitations of printing. In order to reproduce a distinct black color, normally black ink is

used when printing color images.
For example, a cyan image can be printed using only cyan ink without any complications; however, a full color image

can be made up of over 16 million subtlety different colors. These complicated colors are produced by translating
them into proportions of CMYK dots per unit area.

In addition, the same color in an image can have lighter and darker parts. These shades of color are produced by
varying the amount of ink dots per unit area.
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Guide to Components
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Additional Information > Guide to Components

Guide to Components

The names and functions of parts of the printer body, control panel, and options are explained.

Related topics
Printer Body

Printer Rear

Control Panel

Option
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Printer Body
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Printer Body

10.

AGKI1S

. Top cover

Keep this cover closed during printing. If you cannot locate paper jams, or jammed paper cannot be removed easily, you
can check the condition of paper from the top of the printer.

. Envelope selector

For envelopes, set the lever to the rear position E=; for everything else, set the lever to the forward position D

. Print cartridge (yellow)
. Print cartridge (magenta)
. Print cartridge (cyan)

. Print cartridge (black)

Right front cover

Keep this cover closed during printing. Open to install or replace Print cartridges.
Tray 1
Load paper here.

QOutput tray extension

Pull out when using paper larger than Letter to keep the printed paper from falling.

QOutput tray

Prints are delivered to this tray.

When using paper larger than Letter, pull out the output tray extension.
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Printer Body
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Printer Rear

1. USB slot

Connect the USB cable from the computer here.

2. Duplex unit cover button

Press to open the duplex unit cover.

3. Bypass tray

Insert paper by hand here. Insert thick paper and label paper.

4. Duplex unit locks

Use to lock or unlock the duplex unit when attaching or detaching it.

5. Duplex unit cover

Open to remove paper jammed inside the duplex unit.

6. Vent

Air is vented here to prevent the inside of the printer from getting too warm. Do not lean anything against the vent or block
it in any way. If the inside of the printer gets too warm, a breakdown could occur.

7. Guide board

Open to remove paper jammed inside the printer.
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Printer Rear

8. Paper feed wheel

Use to wind out paper jammed around the guide board.

9. Power cord

Plug the power cord into a wall outlet.

Connect the grounding wire attached to the power plug directly to a grounding terminal.

10. Bypass tray guides

Slide the left and right guides in to match the size of paper being used in the bypass tray.

11. Duplex unit

Turns the paper over when performing duplex printing.

|| Top | 4 Previous - Next f |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/0157.htm (2 of 2)2005/10/05 12:09:06



Control Panel

User Guide

For screen reader Standard

| # Contents | 4 Previous - Next - | I | | Settings |

Additional Information > Guide to Components > Control Panel

Control Panel

-

2 3 4

© 6 ©

5 0 0 0

ACKINE

1. Cartridge replacement indicators

o The indicators correspond to the positions of the Print cartridges. From left to right, the cartridge replacement
indicators display the status of the black (K), cyan (C), magenta (M), and yellow (Y) Print cartridges.

2. [Power] key

o Press to turn the power on and off.
o To turn the power on, press the key for one second until it lights.

o After the power is turned on, the [Power] key will blink until the printer is ready for printing at which point the key
will stop blinking and stay lit.

o The [Power] key will also blink when the printer is processing data.

o When the power is turned off, the key will blink slowly until the printer has completely shut down at which point
the key will be dark.

o (D' means "standby".

3. [Resume] key

o Press to resume printing after dealing with an error.

o This key lights or blinks when paper runs out or a paper jam or error occurs.

4. [Cancel] key

o Press to cancel printing.
e When the power is off, if you hold down the [Cancel], [Resume], and [Power] keys together for more than three seconds, all four cartridge
replacement indicators light. When you release the keys, the machine produces a sample print. On the sample print, you can check

“Secondary Counter”.

e When the power is off, if you hold down the [Resume] and [Power] keys together for more than three seconds, all four cartridge replacement
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Control Panel

indicators light. When you release the keys, the machine ejects a blank sheet.

o If you hold down the [Cancel] key down for more than three seconds, the [Power] key blinks. When you release the key, the machine cleans

the heads for all four inks.

o When the power is off, if you hold down the [Cancel] and [Power] keys together for more than three seconds, all four cartridge replacement

indicators light. When you release the keys, the machine prints the “Nozzle Check” test pattern.

=l Reference

e Error Indicator Summary
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Additional Information > Guide to Components > Option

Option

Paper Feed Unit Type 7500

AGRITIS

1. Tray 2

Load plain paper here.

2. Tray 2 rear cover

Open to remove paper jammed in tray 2.

3. Tray cover

This is attached to tray 2.
Take this cover off when loading paper.
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Cleaning
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Additional Information > Cleaning

Cleaning

Clean the outside of the printer regularly to maintain the condition of the printer.

AWARNING

o To avoid hazardous electric shock, do not remove any covers or screws other than those specified in this manual. When
the machine needs to be checked, adjusted, or repaired, contact your service representative.

o Do not take apart or attempt any modifications to this machine. There is a risk of fire, electric shock, explosion or loss
of sight.

To clean the exterior of the printer, wipe it with a soft, dry or damp cloth. If the dirt does not come off, wipe the
printer first with a cloth moistened with a neutral detergent, then with a damp cloth, and finally with a dry cloth.

s |mportant

o Do not use volatile chemicals like benzene or thinner, or insecticides on the printer. Using these chemicals could deform, crack, or change

the color of the printer.

e When wiping the printer with a cloth moistened with detergent, be sure to wipe only the exterior.
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Additional Information > Moving

Moving

The precautions when moving the printer a short distance or long distance are explained.

Related topics

Moving a Short Distance

Moving a Long Distance
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Moving a Short Distance
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Moving a Short Distance

The precautions when moving the printer a short distance or long distance are explained.

/A CAUTION

o The printer weighs approximately 14.2 kg (31.3 1b.).

o When moving the machine, hold the machine by the bottom below the two indentations. Lift the machine slowly in
order to avoid straining your body. Lifting the machine without sufficient strength or assistance or handling it roughly
and dropping it could cause an injury.

A CAUTION

o Unplug the power cord from the wall outlet before you move the machine. While moving the machine, you should take
care that the power cord will not be damaged under the machine.

A CAUTION

e When you disconnect the power plug from the wall outlet, always pull the plug (not the cable).

1. Turn the power off, disconnect the USB cable, and then unplug the power cord from the wall outlet.

v d |mportant

> To make sure the print heads are capped when the machine is off, always switch the machine off from the control panel. Switching

off in any other way may leave the print heads uncapped, possibly leading to printing problems.

2. Lift the printer using the indents on the printer's sides near the base, and then slowly lift and move the
printer without tilting.

AGHDSES
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Moving a Long Distance

1. Turn the power off, disconnect the USB cable, and then unplug the power cord from the wall outlet. Do
not remove the print cartridges. Remove the paper.

v o [mportarnt

o To make sure the print heads are capped when the machine is off, always switch the machine off from the control panel. Switching
off in any other way may leave the print heads uncapped, possibly leading to printing problems.

2. Pack the printer for transport when moving it a long distance such as when changing office or residence.
Disconnect all cables, place the printer in the box it was in when purchased, and transport in a level
manner.

Contact sales or service representative for details.

o The inside of the printer may become dirty if the printer is not level when transported.
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Additional Information > Disposing

Disposing

Consult with an authorized dealer to dispose of the printer.
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When Not Using for a Long Period of Time

When the printer will not be used for a long period of time, turn the power off, disconnect the USB cable, and unplug
the power cable from the wall outlet.

Be careful of the following:

o The nozzles of the print-heads may dry out and become clogged. To prevent this, periodically print something.
Even if you do not print anything, turn the printer on for a few minutes once a month.

o If you do not use the printer for a long period of time, always check if the nozzles are clogged by printing a
nozzle check test pattern. Clean the print-heads as necessary, and then begin printing.

o If you do not use the printer for a long period of time, printing may not be performed normally even if head
cleaning is performed multiple times. If this happens, turn the power off and leave the printer alone for eight
hours or longer.

o After head cleaning is performed multiple times, clogged ink will dissolve over time, and normal printing may become possible.

o If there is no improvement after performing the steps above, contact sales or service representative.

=l Reference

o Where to Inquire
e Nozzle Check

e Clean Print-heads (Normal)

e Clean Print-heads (Full)
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Related topics

Printer Body
Option (Paper Feed Unit)
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Printer Body

Print speed

Measurements according to the manufacturer's measurement system
Black draft: 20 ppm
Color draft: 20 ppm

Depending on the operating environment, printing may take longer than normal.

Print direction

Supports bidirectional, minimum distance printing

Print resolution

Max 3600 x 1200 dpi equivalent

Nozzles

Black: 384 nozzles

Cyan, magenta, and yellow: 384 nozzles per color

Paper sizes (Tray 1 : standard)

Standard paper size: A3 (Portrait), B4 (portrait), A4 (portrait), BS (portrait), AS (landscape), A6 (portrait), 11" x
17" (portrait), Legal (portrait), Letter (portrait), 5 1/," x 8 1/," (landscape), Executive (portrait) (184.2 mm x

266.7 mm (7.3 x 10.5 inches)), F (portrait) (203.2 mm X 330.2 mm (8.0 x 13.0 inches)), Foolscap (F4) (portrait)
(215.9 mm x 330.2 mm (8.5 x 13.0 inches)), Folio (portrait) (209.5 mm x 330.2 mm (8.3 x 13.0 inches)), 16K
(portrait) (195 x 267mm(7.7 x 10.6 inches)), Com10 (portrait) (104.8 mm x 241.3 mm (4.2 x 9.5 inches)),
Monarch (portrait) (98.4 mm x 190.5 mm (3.9 x 7.5 inches)), C6 (portrait)(114 mm x 162 mm (4.5 x 6.4
inches)), C5 (portrait) (162 mm x 229 mm (6.4 x 9.1 inches)), DL Env (portrait)(110 mm x 220 mm (4.4 x 8.7
inches))

Custom paper sizes: 139.7-431.8mm (length) x 90-305mm (width), (5.5-17.0 inches (Iength) x 5.5-17.0 inches
(width))

Paper sizes (Bypass tray)

Standard paper size: 12" x 18" (Portrait), A3 (Portrait), B4 (portrait), A4 (portrait), BS (portrait), AS
(landscape), A6 (portrait), 11" x 17" (portrait), Legal (portrait), Letter (portrait), 5 1/,"x8 1/," (landscape),

Executive (portrait) (184.2 mm x 266.7 mm (7.3 x 10.5 inches)), F (portrait) (203.2 mm x 330.2 mm (8.0 x
13.0 inches)), Foolscap (F4) (portrait) (215.9 mm x 330.2 mm (8.5 x 13.0 inches)), Folio (portrait) (209.5 mm X
330.2 mm (8.3 x 13.0 inches)), 16K (portrait), Com10 (portrait) (104.8 mm x 241.3 mm (4.2 x 9.5 inches)),
Monarch (portrait) (98.4 mm x 190.5 mm (3.9 x 7.5 inches)), C6 (portrait) (114 mm x 162 mm (4.5 x 6.4
inches)), C5 (portrait) (162 mm x 229 mm (6.4 x 9.1 inches)), DL Env (portrait) (110 mm x 220 mm (4.4 x 8.7
inches))

Custom paper sizes: 148-1295.4 mm (length) x 90-216 mm (width), (5.9-51.0 inches (length) x 3.6-8.5 inches
(width))

Paper sizes (Duplex unit)
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Printer Body

Standard paper size: A3 (Portrait), B4 (portrait), A4 (portrait), BS (portrait), AS (landscape), A6 (portrait), 11" x
17" (portrait), Legal (portrait), Letter (portrait), 5 1/," x 8 1/," (landscape), Executive (portrait), 16K (portrait)

Paper type
Plain paper
Recycled paper
Color paper
Inkjet plain paper
Semi-gloss photo paper
Inkjet transparency

Envelope
Paper weight
Tray 1/optional tray: 60-105 g/m?2 (114.7-198.5 Ib.)
Bypass tray: 60-163 g/m2 (114.7-297.7 1b.)
Paper capacity
Tray 1: 250 sheets
Bypass tray: 1 sheet
Maximum paper capacity

750 sheets (with the optional tray installed)

Output tray capacity
150 sheets

The capacity may be less depending on the images printed.

Power supply
120 V or more, 60Hz, 0.9 A or more (when fully equipped)

Power consumption

Average power consumption while printing: 30 W or less (not including options)
less than 39 W (when fully equipped)

Energy Saver mode: less than 6 W

When power is off: 0.2 W or less

To avoid any power consumption, disconnect the power plug from the wall outlet.

(Disconnect the power plug after turning the power off with the [Power] key.)

Operating environment

Temperature: 10 to 32°C (50 to 89.6°F))
Humidity: 15-80% RH (maximum wet-bulb temperature: 25°C (77°F) )

Printing may stop to protect the printer for conditions outside those described above.

Storage environment

Temperature: 1 to 43°C (33.8 to 109.4°F)
Humidity: 15-80% RH

External dimensions
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Printer Body

(W x D x H) 615 x 557 x 250 mm (24.3 x 22.0 x 9.9 inches) (when A4/Letter paper is loaded)
(W xD xH) 615 %692 x 250 mm (24.3 x 27.3 x 9.9 inches) (when A3/11" x 17" paper is loaded)
Weight

Approximately 14.2 kg (31.3 Ib.) (printer body with consumables)

Noise emission

Approximately 49 dB (high quality mode)

Interface

USB 2.0 high speed

Printer language

RPCS Raster

Print cartridges

Types and yields measured using A4 (Letter) 5% chart printed in standard (speed priority) mode.
Print cartridge black: approximately 3200 sheets

Print cartridge cyan: approximately 2500 sheets

Print cartridge magenta: approximately 2500 sheets

Print cartridge yellow: approximately 2500 sheets

The printing yields of Print cartridges vary depending on the number of times print-head cleaning is performed.
Also, the printing yields of the Print cartridges packaged with the printer are lower than the yields of the Print
cartridges available for purchase separately.
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Option (Paper Feed Unit)

Paper Feed Unit Type 7500

Paper sizes

A4 (portrait), B5 (portrait), Legal (portrait), Letter (portrait), Executive (portrait) (184.2 mm x 266.7 mm
(7.3 x 10.5 inches)), F (portrait) (203.2 mm x 330.2 mm (8.0 x 13.0 inches)), Foolscap (F4) (portrait)
(215.9 mm x 330.2 mm (8.5 x 13.0 inches)), Folio (portrait) (209.5 mm x 330.2 mm (8.3 x 13.0 inches)),
16K (portrait)

Paper type

Plain paper
Inkjet plain paper
Recycled paper
Color paper

Paper weight
60-105 g/m?2 (114.7-198.5 1b.)

Paper capacity

500 sheets

External dimensions

(W x D xH) 615 x 557 x 110 mm (24.3 x 22.0 x 43.3 inches)

Weight

Approximately 5 kg (11 1b.)
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Electromagnetic Interference

If another electronic device is placed next to the printer, each will influence the other negatively. In the case of a
television or radio, noise may be generated. If this happens, do the following:

e Move the television or radio as far as possible from the printer.
o Change the position of the antenna of the television or radio.

o Use a different wall outlet on a different circuit.

|| Top | 4 Previous - Next ¢ |

Copyright © 2005 All rights reserved.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/0169.htm2005/10/05 12:09:20


javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();

About NetBSD

User Guide _

For screen reader Standard

| # Contents | 4 Previous - Next - | I | | Settings |

Additional Information > About NetBSD

About NetBSD

For software installed on this printer such as a controller, the NetBSD operating system is used.
1. Copyright Notice of NetBSD
For all users to use this product:
This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not in the public domain; its
authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD source code. For exact copyright
notice applicable for each of the files/binaries, the source code tree must be consulted.

A full source code can be found at http://www.netbsd.org/.
Copyright (c) 1999, 2000 The NetBSD Foundation, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement:

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS *"AS
IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

2. Authors Name List
All product names mentioned herein are trademarks of their respective owners.

The following notices are required to satisfy the license terms of the software that we have mentioned in this
document:

This product includes software developed by Jonathan R. Stone for the NetBSD Project.

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.
This product includes software developed by Manuel Bouyer.

This product includes software developed by Charles Hannum.

This product includes software developed by Charles M. Hannum.

file:///E|/shared/pdf-work/newfiles/pp2w/Op_Guide/acc/0170.htm (1 of 2)2005/10/05 12:09:22


http://www.netbsd.org/
javascript:back_to_index()
javascript:back_to_index()
javascript:goto_preference('acc', 'preferences.htm')
javascript:goto_preference('acc', 'preferences.htm')
javascript:SetWord2_a();

About NetBSD

This product includes software developed by Christopher G. Demetriou.

This product includes software developed by TooLLs GmbH.

This product includes software developed by Terrence R. Lambert.

This product includes software developed by Adam Glass and Charles Hannum.

This product includes software developed by Theo de Raadt.

This product includes software developed by Jonathan Stone and Jason R. Thorpe for the NetBSD Project.

This product includes software developed by the University of California, Lawrence Berkeley Laboratory and
its contributors.

This product includes software developed by Christos Zoulas.

This product includes software developed by Christopher G. Demetriou for the NetBSD Project.
This product includes software developed by Paul Kranenburg.

This product includes software developed by Adam Glass.

This product includes software developed by Jonathan Stone.

This product includes software developed by Jonathan Stone for the NetBSD Project.

This product includes software developed by Winning Strategies, Inc.

This product includes software developed by Frank van der Linden for the NetBSD Project.
This product includes software developed for the NetBSD Project by Frank van der Linden
This product includes software developed for the NetBSD Project by Jason R. Thorpe.

The software was developed by the University of California, Berkeley.

This product includes software developed by Chris Provenzano, the University of California, Berkeley, and
contributors.

Copyright (¢) 1993 by Sun Microsystems, Inc. All rights reserved.
Developed at SunPro, a Sun Microsystems, Inc. business.

Permission to use, copy, modify, and distribute this software is freely granted, provided that this notice is
preserved.

Copyright (c) 1995 Carnegie-Mellon University.
All rights reserved.
Author: Chris G. Demetriou

Permission to use, copy, modify and distribute this software and its documentation is hereby granted, provided
that both the copyright notice and this permission notice appear in all copies of the software, derivative works
or modified versions, and any portions thereof, and that both notices appear in supporting documentation.

CARNEGIE MELLON ALLOWS FREE USE OF THIS SOFTWARE IN ITS "AS IS" ONDITION.
CARNEGIE MELLON DISCLAIMS ANY LIABILITY OF ANY KIND FOR ANY DAMAGES
WHATSOEVER RESULTING FROM THE USE OF THIS SOFTWARE.

Carnegie Mellon requests users of this software to return to

Software Distribution Coordinator or Software.Distribution@CS.CMU.EDU
School of Computer Science

Carnegie Mellon University

Pittsburgh PA 15213-3890

any improvements or extensions that they make and grant Carnegie the rights to redistribute these changes.
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Trademarks

Adobe and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States
and/or other countries.

Pentium is a registered trademark of Intel Corporation.
Netscape is a registered trademark of Netscape Communication Corporation in the U.S. and/or other countries.

Macromedia and Flash are either registered trademarks or trademarks of Macromedia, Inc. in the U.S. and/or other
countries.

Microsoft, Windows, Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the U.
S. and/or other countries.

Other product names used herein are for identification purposes only and might be trademarks of their respective
companies. We disclaim any and all rights to those marks.

e The product name of Windows® 95 is Microsoft® Windows® 95.
o The product name of Windows® 98 is Microsoft® Windows® 98.
e The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me).
e The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server
e The product names of Windows® XP are as follows:
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Professional
e The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition
Microsoft® Windows ServerT™ 2003 Web Edition
o The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0
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